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1.0 OBJECTIVES  

By the end of this module, you should be able to : 

1) Identify and name computer parts, other type of computers 

2) Define basic concepts used in computer 

3) Describe the functions of computer hardware 

4) Use of computer software 

5) Identify the memory and storage devices and various functions of it 

6) Identify the networks and topologies 

1.1 COMPUTER DEFINITION 

The simple meaning of a computer is a machine that can calculate. 
However, modern computers are not just a calculating device anymore. 
They can perform a variety of tasks. In simple terms, a computer is a 
programmable electronic machine used to store, retrieve, and process data. 
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"A computer is a programmable electronic device that takes data, 
performs instructed arithmetic and logical operations, and gives the 
output." 

Whatever is given to the computer as input is called 'data', while the 
output received after processing is called 'information'. 

A computer is a general purpose electronic device that can be programmed 
to carry out a set of arithmetic or logical operations. 

Computers can be categorized in several ways. For example, computers 
can be analog or digital based on their data representation. Some 
computers are designed for use by one person, some are meant to be used 
by groups of people. Computers can also be categorized by their speed at 
which they operate and types of tasks they can perform. 

The computer not only processes data, but also stores it. It uses various 
electronic means for data and information storage. This stored data can be 
modified by the computer using its instructions and can transform the data 
into information. The data stored on digital computers is in tiny units 
called bits. The stored data is measured using these units. The data is 
stored, processed and given out to the user using its different parts.  

1.2 HISTORY OF COMPUTERS 

The term 'Computer' was first introduced in 1640 and referred to as 'one 
who calculates'. It was derived from the Latin word 'computare', which 
meant 'to calculate'. In 1897, it was known as the 'calculating machine'. 
Later in 1945, the term 'computer' was introduced as 'programmable 
digital electronic computer, which is now called a 'computer'. 

When the computers were introduced, they were large and could fill an 
entire room. Some computers were operated using large-sized vacuum 
tubes. In 1833, Charles Babbage (known as the father of the computer) 
invented an early calculator, which was named as the 'difference engine'. 
Later in 1837, he introduced the first mechanical, general-purpose 
computer 'Analytical Engine'. Over time, computers became powerful in 
performance and small in size. 

1.2.1 Generations of Computer  

A generation of computers refers to the specific improvements in 
computer technology with time. In 1946, electronic pathways called 
circuits were developed to perform the counting. It replaced the gears and 
other mechanical parts used for counting in previous computing machines. 

In each new generation, the circuits became smaller and more advanced 
than the previous generation circuits. The miniaturization helped increase 
the speed, memory and power of computers.  
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There are five generations of computers which are described below : 

First Generation (1946 - 1959) : The first generation (1946-1959) 
computers were slow, huge and expensive. In these computers, vacuum 
tubes were used as the basic components of CPU and memory. These 
computers mainly depended on a batch operating system and punch cards. 
Magnetic tape and paper tape were used as output and input devices in this 
generation.  

Some popular first generation computers are :  

ENIAC (Electronic Numerical Integrator and Computer) 

EDVAC (Electronic Discrete Variable Automatic Computer) 

UNIVACI (Universal Automatic Computer) 

IBM-701 

IBM-650 

Second Generation (1959 - 1965) : The second generation (1959-1965) 
was the era of the transistor computers. These computers used transistors 
which were cheap, compact and consuming less power; it made transistor 
computers faster than the first generation computers. In this generation, 
magnetic cores were used as the primary memory and magnetic disc and 
tapes were used as the secondary storage. Assembly language and 
programming languages like COBOL and FORTRAN, and Batch 
processing and multiprogramming operating systems were used in these 
computers. 

Some of the popular second generation computers are : 

IBM 1620, IBM 7094, CDC 1604, CDC 3600, UNIVAC 1108 

Third Generation (1965 - 1971) : The third generation computers used 
integrated circuits (ICs) instead of transistors. A single IC can pack a huge 
number of transistors which increases the power of a computer and 
reduces the cost. The computers also became more reliable, efficient and 
smaller in size. These generation computers used remote processing, time-
sharing, and multi-programming as operating systems.  

Some of the popular third generation computers are :  

IBM-360 series, Honeywell-6000 series, PDP(Personal Data Processor), 
IBM-370/168, TDC-316 

Fourth Generation (1971 - 1980) : The fourth generation (1971-1980) 
computers used very large scale integrated (VLSI) circuits; a chip 
containing millions of transistors and other circuit elements. These chips 
made this generation of computers more compact, powerful, fast and 
affordable. These generation computers used real time, time sharing and 
distributed operating systems. The programming languages like C, C++, 
DBASE were also used in this generation. 
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Some of the popular fourth generation computers are :  

DEC 10, STAR 1000, PDP 11, CRAY-1(Supercomputer) 

Fifth Generation (1980 - Present) : In fifth generation (1980-till date) 
computers, the VLSI technology was replaced with ULSI (Ultra Large 
Scale Integration). It made possible the production of microprocessor 
chips with ten million electronic components. This generation of 
computers used parallel processing hardware and AI (Artificial 
Intelligence) software. The programming languages used in this 
generation were C, C++, Java, .Net, etc.  

Some of the popular fifth generation computers are :  

Desktop, Laptop, NoteBook, UltraBook, ChromeBook 

1.2.2 Type of Computers 

 

A) On the basis of size, computers can be of five types :  

1) Supercomputer  

Supercomputers are the biggest and fastest computers. They are 
designed to process huge amounts of data. A supercomputer can process 
trillions of instructions in a second.  

It has thousands of interconnected processors. Supercomputers are 
particularly used in scientific and engineering applications such as 
weather forecasting, scientific simulations and nuclear energy research.  

The first supercomputer was developed by Roger Cray in 1976. 
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Characteristics or applications of supercomputers : 

● It has the ability to decrypt passwords to enhance protection for 
security reasons. 

● It produces excellent results in animations. 

● It is used for virtual testing of nuclear weapons and critical medical 
tests. 

● It can study and understand climate patterns and forecast weather 
conditions.  

● It helps in designing the flight simulators for pilots at the beginner 
level for their training. 

● It helps in extracting useful information from data storage centres or 
cloud systems.  

● It helps in the diagnosis of various critical diseases and in producing 
accurate results in brain injuries, strokes, etc. 

● It helps in scientific research areas by accurately analysing data 
obtained from exploring the solar system, satellites, and movement 
of Earth. 

● It is also used in a smog control system where it predicts the level of 
fog and other pollutants in the atmosphere. 

2) Mainframe Computer 

Mainframe computers are designed to support hundreds or thousands of 
users simultaneously. They can support multiple programs at the same 
time. It means they can execute different processes simultaneously. These 
features of mainframe computers make them ideal for big organizations 
like banking and telecom sectors, which need to manage and process a 
high volume of data that requires integer operations such as indexing, 
comparisons, etc. 

Characteristics of Mainframe Computers : 

● It can process huge amounts of data, e.g. millions of transactions in a 
second in the banking sector. 

● It has a very long life. It can run smoothly for up to 50 years after 
proper installation. 

● It gives excellent performance with large scale memory management.  

● It has the ability to share or distribute its workload among other 
processors and input/output terminals. 
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● There are fewer chances of error or bugs during processing in 
mainframe computers. If any error occurs it can fix it quickly without 
affecting the performance.  

● It has the ability to protect the stored data and other ongoing exchange 
of information and data. 

Applications of mainframe computers : 

● In health care, it enabled hospitals to maintain a record of their 
millions of patients in order to contact them for trea2tment or related 
to their appointment, medicine updates or disease updates. 

● In the field of defence, it allows the defence departments to share a 
large amount of sensitive information with other branches of defence. 

● In the field of education, it helps big universities to store, manage and 
retrieve data related to their courses, admissions, students, teachers, 
employees and affiliated schools and colleges. 

● In the retail sector, the retail companies that have a huge customer 
base and branches use mainframe computers to handle and execute 
information related to their inventory management, customer 
management, and huge transactions in a short duration. 

3) Minicomputer 

It is a midsize multiprocessing computer. It consists of two or more 
processors and can support 4 to 200 users at one time. Miniframe 
computers are used in institutes and departments for tasks such as billing, 
accounting and inventory management. A minicomputer lies between the 
mainframe and microcomputer as it is smaller than the mainframe but 
larger than a microcomputer. 

Characteristics of miniframe or minicomputer : 

● It is light weight that makes it easy to carry and fit anywhere. 

● It is less expensive than mainframe computers. 

● It is very fast compared to its size. 

● It remains charged for a long time. 

● It does not require a controlled operational environment. 

Applications of minicomputers : 

● Process control : It was used for process control in manufacturing. It 
mainly performs two primary functions that are collecting data and 
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feedback. If any abnormality occurs in the process, it is detected by the 
minicomputer and necessary adjustments are made accordingly. 

● Data management : It is an excellent device for small organizations 
to collect, store and share data. Local hospitals and hotels can use it to 
maintain the records of their patients and customers respectively. 

● Communications Portal : It can also play the role of a 
communication device in larger systems by serving as a portal between 
a human operator and a central processor or computer. 

4) Workstation 

Workstation is a single user computer that is designed for technical or 
scientific applications. It has a faster microprocessor, a large amount of 
RAM and high speed graphic adapters. It generally performs a specific 
job with great expertise; accordingly, they are of different types such as 
graphics workstation, music workstation and engineering design 
workstation. 

Characteristics of workstation computer : 

● It is a high-performance computer system designed for a single user 
for business or professional use. 

● It has larger storage capacity, better graphics, and a more powerful 
CPU than a personal computer. 

● It can handle animation, data analysis, CAD, audio and video creation 
and editing. 

Any computer that has the following five features, can be termed as a 
workstation. 

1) Multiple Processor Cores: It has more processor cores than simple 
laptops or computers. 

2) ECC RAM: It is provided with Error-correcting code memory that can 
fix memory errors before they affect the system's performance. 

3) RAID (Redundant Array of Independent Disks): It refers to multiple 
internal hard drives to store or process data. RAID can be of different 
types, for example, there can be multiple drives to process data or 
mirrored drives where if one drive does not work then the other starts 
functioning. 

4) SSD: It is better than conventional hard-disk drives. It does not have 
moving parts, so the chances of physical failure are very less. 

5) Optimized, Higher end GPU: It reduces the load on CPU. E.g., the 
CPU has to do less work while processing the screen output. 
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5) Microcomputer 

Microcomputer is also known as a personal computer. It is a general-
purpose computer that is designed for individual use. It has a 
microprocessor as a central processing unit, memory, storage area, input 
unit and output unit. Laptops and desktop computers are examples of 
microcomputers. They are suitable for personal work that may be making 
an assignment, watching a movie, or at the office for office work. 

Characteristics of a microcomputer : 

● It is the smallest in size among all types of computers. 

●  A limited number of software can be used. 

● It is designed for personal work and applications. Only one user can 
work at a time. 

● It is less expensive and easy to use. 

● It does not require the user to have special skills or training to use it. 

● Generally, it comes with a single semiconductor chip. 

● It is capable of multitasking such as printing, scanning, browsing, 
watching videos, etc. 

B) On the basis of type of data handling capabilities, computers can 
be of three types :  

1) Analogue Computer  

It is particularly designed to process analogue data. Continuous data that 
changes continuously and cannot have discrete values is called analogue 
data. So, an analogue computer is used where we don’t need exact values 
or need approximate values such as speed, temperature, pressure etc.  

It can directly accept the data from the measuring device without first 
converting it into numbers and codes.  

It measures the continuous changes in physical quantity.  

It gives output as a reading on a dial or scale. For example speedometer, 
mercury thermometer etc. 

2) Digital Computer  

Digital computers are designed in such a way that it can easily perform 
calculations and logical operations at high speed. It takes raw data as an 
input and processes it with programs stored in its memory to produce the 
final output. It only understands the binary input 0 & 1, so the raw input 
data is converted to 0 and 1 by the computer and then it is processed by 
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the computer to produce the result or final output. For example all modern 
computers like laptops, desktops including smartphones. 

3) Hybrid Computer 

It is made by combining both analog and digital computers. They are fast 
like an analog computer and have memory and accuracy like a digital 
computer, so it has the ability to process both continuous and discrete data. 
It is widely used in specialized applications where both analog and digital 
data is required to be processed. For example, A processor which is used 
in petrol pumps that converts the measurements of fuel into quantity and 
price. 

C) On the basis of purpose, computers can be of two types :  

1. General Purpose  

General computers can do various everyday tasks such as writing a word 
processing letter, document preparation, recording, financial analysis, 
Printing documents, creating databases, and calculations with accuracy 
and consistency. 

The size, storage capacity, and cost of such computers are mainly less. 
The ability of these computers is limited in performing specialized tasks. 
Still, it is versatile and useful for serving people’s basic needs at home or 
in the workplace in the environment. 

For example, Desktops, laptops, smartphones, and tablets are used on a 
daily basis for general purposes. 

2. Special Purpose 

These computers are designed to perform a particular or specialized task. 
The size, storage capacity, and cost of such computers mainly depend on 
the nature and size of the work.  

The function of these computers is consistent with any particular task. The 
special computer needs specific input and devices as well as a compatible 
motherboard with the processor to conduct work efficiently.  

These computers are used for special purposes in weather forecasting, 
space research, agriculture, engineering, meteorology, satellite operation, 
traffic control, and research in chemical sciences. 

For example, Automatic teller machines (ATM), Washing machines, 
Surveillance equipment, Weather-forecasting simulators, Traffic-control 
computers, Defense-oriented applications, Oil-exploration systems, 
Military planes controlling computers. 

1.3 BASIC STRUCTURE OF PC  

The whole computer system is made up of different components that differ 
with respect to its functionality and form. The three major components 
comprise of the hardware, software and data. 
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Hardware is any part of the computer you can touch. It is made up of 
interconnected electronic devices. The hardware of a computer system 
consists of mechanical devices to insert data, store it, process it and give 
the output in various forms.  

Software is a set of instructions that makes the computer perform tasks. 
The software of a computer system supports the hardware devices in their 
respective activities.  

Data consists of individual facts or pieces of information. The computers’ 
primary job is to process this data into useful information. This 
information in a computer system can be in various forms like, simple 
text, graphics, videos etc. 

 

The above figure represents the structure of a simple computer system.  

Several types of input devices are used to insert the data in the computer 
system. This data is stored on memory devices in the system. To process 
the data, the central processing unit communicates with the available 
memory devices.  

To display the data to the users, various output devices are used that form 
the part of the computer system. 

1.4 PARTS OF A COMPUTERS 

There are five main computer components that are given below : 

1) Input Devices 

2) CPU 

3) Output Devices 

4) Primary Memory 

5) Secondary Memory 
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1.4.1 Operations of computer components  

1) Inputting : It is the process of entering raw data, instructions and 
information into the computer. It is performed with the help of input 
devices. 

2) Storing: The computer has primary memory and secondary storage to 
store data and instructions. It stores the data before sending it to the CPU 
for processing and also stores the processed data before displaying it as 
output. 

3) Processing: It is the process of converting the raw data into useful 
information. This process is performed by the CPU of the computer. It 
takes the raw data from storage, processes it and then sends back the 
processed data to storage. 

4) Outputting: It is the process of presenting the processed data through 
output devices like monitor, printer and speakers. 

5) Controlling: This operation is performed by the control unit that is part 
of the CPU. The control unit ensures that all basic operations are executed 
in the right manner and sequence. 

1.5 INPUT DEVICES  

These are external hardware devices of a computer system that are used to 
insert data inside the computer system. The data can be in the form of text, 
images, video or command signals.  

Some of the popular input devices are explained below : 

1.5.1 Keyboard - it is a basic input device that is used to enter data into a 
computer or any other electronic device by pressing keys. It has different 
sets of keys for letters, numbers, characters, and functions. Keyboards are 
connected to a computer through USB 

or a Bluetooth device for wireless communication.  

Types of keyboards : There can be different types of keyboards based on 
the region and language used. Some of the common types of keyboards 
are as follows : 

1) QWERTY Keyboard : 
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It is the most commonly used keyboard with computers in modern times. 
It is named after the first six letters of the top row of buttons and is even 
popular in countries that do not use Latin-based alphabet.  

2) AZERTY Keyboard : 

 

It is considered the standard French keyboard. It is developed in France as 
an alternative layout to the QWERTY layout and is mainly used in France 
and other European countries. 

Its name is derived from the first six letters that appear on the top left row 
of the keyboard. The Q and W keys in the AZERTY keyboard are 
interchanged with A and Z keys in the QWERTY keyboard.  

Furthermore, in the AZERTY keyboard the M key is located to the left of 
the L key. 

AZERTY keyboard differs from QWERTY keyboard not only in the 
placement of letters but also in many other ways, e.g., it gives emphasis on 
accents, which is required for writing European languages like French. 

3) DVORAK Keyboard : 

 

This type of keyboard layout was developed to increase the typing speed 
by reducing the finger movement while typing. The most frequently used 
letters are kept in a home row to improve typing. 
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1.5.2 Mouse - The mouse is a hand-held input device which is used to 
move cursor or pointer across the screen. It is designed to be used on a flat 
surface and generally has left and right buttons and a scroll wheel between 
them. Laptop computers come with a touchpad that works as a mouse. It 
lets you control the movement of cursor or pointer by moving your finger 
over the touchpad.  

Types of mouse :  

1) Trackball Mouse: 

 

It is a stationary input device that has a ball mechanism to move the 
pointer or cursor on the screen. The ball is half inserted in the device and 
can be easily rolled with finger, thumb or the palm to move the pointer on 
the screen. The device has a sensor to detect the rotation of the ball. It 
remains stationary; you don't need to move it on the operating surface. So, 
it is an ideal device if you have limited desk space as you don't need to 
move it like a mouse. 
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2) Mechanical Mouse: 

 

It has a system of a ball and several rollers to track its movement. It is a 
corded type of mouse. A mechanical mouse can be used for high 
performance. The drawback is that they tend to get dust into the 
mechanics and thus require regular cleaning. 

3) Optical Mouse : 

 

An optical mouse uses optical electronics to track its movement. It is more 
reliable than a mechanical mouse and also requires less maintenance. 
However, its performance is affected by the surface on which it is 
operated. Plain non-glossy mouse mat should be used for best results. The 
rough surface may cause problems for the optical recognition system, and 
the glossy surface may reflect the light wrongly and thus may cause 
tracking issues. 

4) Cordless or Wireless Mouse : 

 

As the name suggests, this type of mouse lacks cable and uses wireless 
technology such as IrDA (infrared) or radio (Bluetooth or Wi-Fi) to 
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control the movement of the cursor. It is used to improve the experience of 
using a mouse. It uses batteries for its power supply. 

1.5.3 Scanner – The scanner uses the pictures and pages of text as input. 
It scans the picture or a document. The scanned picture or document is 
then converted into a digital format or file and is displayed on the screen 
as an output. It uses optical character recognition techniques to convert 
images into digital ones.  

Types of Scanner : 

1) Flatbed Scanner : 

 

It has a glass pane and a moving optical CIS or CCD array. The light 
illuminates the pane, and then the image is placed on the glass pane. The 
light moves across the glass pane and scans the document and thus 
produces its digital copy. 

2i) Handheld Scanner : 

 

It is a small manual scanning device which is held by hand and is rolled 
over a flat image that is to be scanned. The drawback in using this device 
is that the hand should be steady while scanning; otherwise, it may distort 
the image. One of the commonly used handheld scanners is the barcode 
scanner which is seen in shopping stores. 
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3) Sheetfed Scanner : 

 

In this scanner, the document is inserted into the slot provided in the 
scanner. The main components of this scanner include the sheet-feeder, 
scanning module, and calibration sheet. The light does not move in this 
scanner. Instead, the document moves through the scanner. It is suitable 
for scanning single page documents, not for thick objects like books, 
magazines, etc. 

4) Drum Scanner : 

 

Drum scanner has a photomultiplier tube (PMT) to scan images. It does 
not have a charge-coupled device like a flatbed scanner. The 
photomultiplier tube is extremely sensitive to light. The image is placed on 
a glass tube, and the light moves across the image, which produces a 
reflection of the image which is captured by the PMT and processed. 
These scanners have high resolution and are suitable for detailed scans. 

5) Photo Scanner : 
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It is designed to scan photographs. It has high resolution and color depth, 
which are required for scanning photographs. Some photo scanners come 
with in-built software for cleaning and restoring old photographs. 

1.5.4 Light pen -  

 

A light pen is a computer input device that looks like a pen. The tip of the 
light pen contains a light-sensitive detector that enables the user to point to 
or select objects on the display screen. Its light sensitive tip detects the 
object location and sends the corresponding signals to the CPU. It is not 
compatible with LCD screens, so it is not in use today.  

1.5.5 Digital Camera –  

 

It is a digital device as it captures images and records videos digitally and 
then stores them on a memory card. It is provided with an image sensor 
chip to capture images, as opposed to film used by traditional cameras. 
Besides this, a camera that is connected to your computer can also be 
called a digital camera. 

It has photosensors to record light that enters the camera through the lens. 
When the light strikes the photosensors, each of the sensors returns the 
electrical current, which is used to create the images. 

1.5.6 Microphone – The microphone is a computer input device that is 
used to input the sound. It receives the sound vibrations and converts them 
into audio signals or sends them to a recording medium. The audio signals 
are converted into digital data and stored in the computer. The microphone 
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also enables the user to telecommunicate with others. It is also used to add 
sound to presentations and with webcams for video conferencing.  

1.5.7 Gesture recognition devices -  

 

These devices take human gestures as input. There are many such devices 
that respond to gestures. For example, Kinect is one such device that 
observes the movement of a player's body and interprets these movements 
as inputs to video games. This feature is also available in certain tablets 
and smartphones where you can perform certain tasks such as taking 
pictures using finger gestures such as swiping, pinching, etc. 

1.5.8 Touch Screen : 

 

It is the display screen of a device such as a smartphone, tablet, etc., that 
allows users to interact or provide inputs to the device by using their 
finger. Today, most electronic devices come with touchscreen as an 
alternative to a mouse for navigating a graphical user interface. For 
example, by touching, you can unlock your phone, open emails, open files, 
play videos, etc. Besides this, it is used in lots of devices such as Camera, 
Car GPS, Fitness machine, etc. 

1.5.9 Webcam -  
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Any camera which is connected to a computer is called a webcam. The in-
built camera provided on a computer can also be considered a webcam. It 
is an input device as it can take pictures, and can be used to record videos 
if required. The pictures and videos are stored in the computer memory 
and can be displayed on the screen if required. Although it works almost 
the same as the digital camera, it is different from a digital camera, as it is 
designed to take compact digital photos that can be uploaded easily on the 
webpages and shared with others through the internet. 

1.5.10 Biometric Devices - it refers to a process in which a person is 
identified through his or her biological features such as fingerprints, eye 
cornea, face structure, etc. It is done by using biometric devices, which 
can be of different types based on their scanning features and abilities such 
as face scanner, hand scanner, fingerprint scanner etc. 

1.6 OUTPUT DEVICES  

The output device displays the result of the processing of raw data that is 
entered in the computer through an input device. There are a number of 
output devices that display output in different ways such as text, images, 
hard copies, and audio or video. 

Some of popular output devices are described below : 

1.6.1 Monitor – The monitor is the display unit or screen of the computer. 
It is the main output device that displays the processed data or information 
as text, images, audio or video. 

Types of monitor  

1) CRT Monitor - 

 

CRT monitors are based on the cathode ray tubes. They are like vacuum 
tubes which produce images in the form of video signals. Cathode rays 
tube produces a beam of electrons through electron guns that strike on the 
inner phosphorescent surface of the screen to produce images on the 
screen. The monitor contains millions of phosphorus dots of red, green 
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and blue color. These dots start to glow when struck by electron beams 
and this phenomenon is called cathodoluminescence. 

The main components of a CRT monitor include the electron gun 
assembly, deflection plate assembly, fluorescent screen, glass envelope, 
and base.The front (outer surface) of the screen onto which images are 
produced is called the face plate. It is made up of fiber optics. 

There are three electron beams that strike the screen: red, green, and blue. 
So, the colors which you see on the screen are the blends of red, blue and 
green lights. The magnetic field guides the beams of electrons. Although 
LCDs have replaced the CRT monitors, the CRT monitors are still used by 
graphics professionals because of their color quality. 

2) LCD Monitor - 

 

The LCD monitor is a flat panel screen that is compact and light-weight as 
compared to CRT monitors. It is based on liquid crystal display 
technology which is used in the screens of laptops, tablets, smart phones, 
etc. An LCD screen comprises two layers of polarized glass with a liquid 
crystal solution between them. When the light passes through the first 
layer, an electric current aligns the liquid crystals. The aligned liquid 
crystals allow a varying level of light to pass through the second layer to 
create images on the screen. 

The LCD screen has a matrix of pixels that display the image on the 
screen. Old LCDs had passive-matrix screens in which individual pixels 
are controlled by sending a charge. A few electrical charges could be sent 
each second that made screens appear blurry when the images moved 
quickly on the screen. 

Modern LCDs use active-matrix technology and contain thin film 
transistors (TFTs) with capacitors. This technology allows pixels to retain 
their charge. So, they don't make the screen blurry when images move fast 
on the screen as well as are more efficient than passive-matrix displays. 

 

 

 

 

mu
no
tes
.in



 

 

Introduction to Computers 

 

21 

3) LED monitor - 

 

The LED monitor is an improved version of an LCD monitor. It also has a 
flat panel display and uses liquid crystal display technology like the LCD 
monitors. The difference between them lies in the source of light to 
backlight the display. The LED monitor has many LED panels, and each 
panel has several LEDs to backlight the display, whereas the LCD 
monitors use cold cathode fluorescent light to backlight the display.  

Modern electronic devices such as mobile phones, LED TVs, laptop and 
computer screens, etc., use a LED display as it not only produces more 
brilliance and greater light intensity but also consumes less power. 

4) Plasma Monitor - 

 

The plasma monitor is also a flat panel display that is based on plasma 
display technology. It has small tiny cells between two glass panels. These 
cells contain mixtures of noble gases and a small amount of mercury. 
When voltage is applied, the gas in the cells turns into a plasma and emits 
ultraviolet light that creates images on the screen, i.e., the screen is 
illuminated by a tiny bit of plasma, a charged gas. Plasma displays are 
brighter than liquid crystal displays (LCD) and also offer a wide viewing 
angle than an LCD. 

Plasma monitors provide high resolutions of up to 1920 X 1080, excellent 
contrast ratios, wide viewing angle, a high refresh rate and more. Thus, 
they offer a unique viewing experience while watching action movies, 
sports games, and more. 
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1.6.2 Printer - A printer produces hard copies of the processed data. It 
enables the user to print images, text or any other information onto the 
paper. 

Types of Printer : 

 1) Impact Printers - The impact printer uses a hammer or print head to 
print the character or images onto the paper. The hammer or print head 
strikes or presses an ink ribbon against the paper to print characters and 
images. 

Types of impact printer : 

A) Character Printer - Character printer prints a single character at a 
time or with a single stroke of the print head or hammer. It does not print 
one line at a time. Today, these printers are not in much use due to their 
low speed and because only the text can be printed.  

Types of character printer : 

i) Dot Matrix Printer - 

 

Dot Matrix Printer is an impact printer. The characters and images printed 
by it are the patterns of dots. These patterns are produced by striking the 
ink soaked ribbon against the paper with a print head. The print head 
contains pins that produce a pattern of dots on the paper to form the 
individual characters. To produce color output, the black ribbon can be 
changed with color stripes. The speed of Dot Matrix printers is around 
200-500 characters per second. 

ii) Daisy Wheel Printer 
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It consists of a wheel or disk that has spokes or extensions and looks like a 
daisy, so it is named Daisy Wheel printer. At the end of extensions, 
molded metal characters are mounted. To print a character the printer 
rotates the wheel, and when the desired character is on the print location 
the hammer hits the disk and the extension hits the ink ribbon against the 
paper to create the impression. It cannot be used to print graphics and is 
often noisy and slow, i.e., the speed is very low, around 25-50 characters 
per second.  

B) Line Printers - It is also a bar printer, prints one line at a time. It is a 
high-speed impact printer as it can print 500 to 3000 lines per minute.  

Types of Line Printer : 

i) Drum Printer - 

 

Drum printer is a line printer that is made of a rotating drum to print 
characters. The drum has circular bands of characters on its surface. It has 
a separate hammer for each band of characters. When you print, the drum 
rotates, and when the desired character comes under the hammer, the 
hammer strikes the ink ribbon against the paper to print characters. The 
drum rotates at a very high speed and characters are printed by activating 
the appropriate hammers. Although all the characters are not printed at a 
time, they are printed at a very high speed. These printers are known to be 
very noisy due to the use of hammering techniques. 

ii) Chain Printer - 
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Chain printer is a line printer that uses a rotating chain to print characters. 
The characters are embossed on the surface of the chain. The chain rotates 
horizontally around a set of hammers, for each print location one hammer 
is provided, i.e., the total number of hammers is equal to the total number 
of print positions. 

The chain rotates at a very high speed and when the desired character 
comes at the print location, the corresponding hammer strikes the page 
against the ribbon and character on the chain.They can type 500 to 3000 
lines per minute. They are also noisy due to the hammering action. 

2) Non-Impact Printer : They print characters and images without direct 
physical contact between the paper and the printing machinery. These 
printers can print a complete page at a time, so they are also known as 
page printers.  

Types of Non-Impact printer :  

i) Laser Printer : 

 
A laser printer is a non-impact printer that uses a laser beam to print the 
characters. The laser beam hits the drum, which is a photoreceptor and 
draws the image on the drum by altering electrical charges on the drum. 
The drum then rolls in toner, and the charged image on the drum picks the 
toner. The toner is then printed on the paper using heat and pressure. Once 
the document is printed, the drum loses the electric charge, and the 
remaining toner is collected. The laser printers use powdered toner for 
printing instead of liquid ink and produce quality print objects with a 
resolution of 600 dots per inch (dpi) or more. 

ii) Inkjet Printer : 
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The inkjet printer is a non-impact printer that prints images and characters 
by spraying fine, ionized drops of ink. The print head has tiny nozzles to 
spray the ink. The printer head moves back and forth and sprays ionized 
drops of ink on the paper, which is fed through the printer. These drops 
pass through an electric field that guides the ink onto the paper to print 
correct images and characters. 

An inkjet printer has cartridges that contain ink. Modern inkjet printers are 
color printers that have four cartridges containing different colors: Cyan, 
Magenta, Yellow, and Black. It is capable of printing high-quality images 
with different colors. It can produce print objects with a resolution of at 
least 300 dots per inch (dpi). 

1.6.3 Projector 

 
A projector is an output device that enables the user to project the output 
onto a large surface such as a big screen or wall. It can be connected to a 
computer and similar devices to project their output onto a screen. It uses 
light and lenses to produce magnified texts, images, and videos. So, it is 
an ideal output device to give presentations or to teach a large number of 
people. 

Modern projects (digital projectors) come with multiple input sources such 
as HDMI ports for newer equipment and VGA ports that support older 
devices. Some projectors are designed to support Wi-Fi and Bluetooth as 
well. They can be fixed onto the ceiling, placed on a stand, and more and 
are frequently used for classroom teaching, giving presentations, home 
cinemas, etc. 

1.6.4 Speakers  

For audio output from a computer, devices like speakers are connected to 
it. The computer processes the digital signals to analog and sends it to the 
speakers. 

1.7 CENTRAL PROCESSING UNIT (CPU) 

It is also called a processor, central processor, or microprocessor. It carries 
out all the important functions of a computer. It receives instructions from 
both the hardware and active software and produces output accordingly.  
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It stores all important programs like operating systems and application 
software.  

CPU also helps Input and output devices to communicate with each other. 
Owing to these features of the CPU, it is often referred to as the brain of 
the computer. 

The clock speed of a CPU refers to the number of instructions it can 
process in a second. It is measured in gigahertz. For example, a CPU with 
a clock speed of 4.0 GHz means it can process 4 billion instructions in a 
second. 

CPU is installed or inserted into a CPU socket located on the motherboard. 
Furthermore, it is provided with a heat sink to absorb and dissipate heat to 
keep the CPU cool and functioning smoothly. 

Generally, a CPU has three components : 

1) ALU (Arithmetic Logic Unit) - It is the arithmetic logic unit, which 
performs arithmetic and logical functions. Arithmetic functions include 
addition, subtraction, multiplication division, and comparisons. Logical 
functions mainly include selecting, comparing, and merging the data.  

2) Control Unit - It is the circuitry in the control unit, which makes use of 
electrical signals to instruct the computer system for executing already 
stored instructions. It takes instructions from memory and then decodes 
and executes these instructions. So, it controls and coordinates the 
functioning of all parts of the computer. The Control Unit's main task is to 
maintain and regulate the flow of information across the processor. It does 
not take part in processing and storing data. 

3) Memory or Storage Unit - It is called Random access memory 
(RAM). It acts as a temporary storage area that holds the data temporarily, 
which is used to run the computer. It stores the data in binary format. 
Binary format uses two symbols as 0 and 1, also known as bits. The 
computer memory and computer data size is measured in bytes.  

The following table shows a few measurement units used in the digital 
world. 

1 bit Binary digit 

8 bits 1 byte 

1024 bytes 1 Kilo Byte (KB) 

1024 KB 1 Mega Byte (MB) 

1024 MB 1 Giga Byte (GB) 

1024 GB 1 Tera Byte (TB) 
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1024 TB 1 Peta Byte (PB) 

1024 PB 1 Exa Byte (EB) 

1024 EB 1 Zetta Byte (ZB) 

1024 ZB 1 Yotta Byte (YB) 

1024 YB 1 Bronto Byte  

1024 Bronto Byte 1 Geop Byte 

* Geop Byte is the highest memory. 

1.8 COMPUTER MEMORY 

 

The computer memory holds the data and instructions needed to process 
raw data and produce output. The computer memory is divided into a large 
number of small parts known as cells. Each cell has a unique address 
which varies from 0 to memory size minus one. 

Computer memory is of two types :  

1) Volatile (Random Access Memory) - It is a volatile memory, meaning 
it does not store data or instructions permanently. When you switch on the 
computer the data and instructions from the hard disk are stored in RAM. 
CPU utilizes this data to perform the required tasks. As soon as you shut 
down the computer the RAM loses all the data. 

2) Non-volatile (Read Only Memory) - It is a non-volatile memory. It 
means it does not lose its data or programs that are written on it at the time 
of manufacture. So it is a permanent memory that contains all important 
data and instructions needed to perform important tasks like the boot 
process. 
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The secondary memory (hard disk) is referred to as storage not 
memory. 

1.8.1 RAM 

 

RAM is a volatile memory, which means it does not store data or 
instructions permanently. When you switch on the computer the data and 
instructions from the hard disk are stored in the RAM, e.g., when the 
computer is rebooted, and when you open a program, the operating system 
(OS), and the program are loaded into RAM, generally from an HDD or 
SSD. CPU utilizes this data to perform the required tasks. As soon as you 
shut down the computer, the RAM loses the data. So, the data remains in 
the RAM as long as the computer is on and lost when the computer is 
turned off. The benefit of loading data into RAM is that reading data from 
the RAM is much faster than reading from the hard drive. 

RAM comes in the form of a chip that is individually mounted on the 
motherboard or in the form of several chips on a small board connected to 
the motherboard. It is the main memory of a computer. It is faster to write 
to and read from as compared to other memories. 

A computer's performance mainly depends on the size or storage capacity 
of the RAM. If it does not have sufficient RAM to run the OS and 
software programs, it will result in slower performance. So, the more 
RAM a computer has, the faster it will work.  

Types of RAM : 

1) Static RAM (SRAM) - The word static indicates that the memory 
retains its contents as long as power is being supplied. However, data is 
lost when the power gets down due to volatile nature. SRAM chips use a 
matrix of 6-transistors and no capacitors.  

Transistors do not require power to prevent leakage, so SRAM need not be 
refreshed on a regular basis. 

There is extra space in the matrix, hence SRAM uses more chips than 
DRAM for the same amount of storage space, making the manufacturing 
costs higher.  

SRAM is thus used as cache memory and has very fast access. 
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Characteristic of Static RAM are : 
1) Long life 

2) No need to refresh 

3) Faster 

4) Used as cache memory 

2) Dynamic Ram (DRAM) - DRAM, must be continually refreshed in 
order to maintain the data. This is done by placing the memory on a 
refresh circuit that rewrites the data several hundred times per second. 
DRAM is used for most system memory as it is cheap and small. All 
DRAMs are made up of memory cells, which are composed of one 
capacitor and one transistor. 

Characteristics of Dynamic RAM : 
1) Short data lifetime  

2) Needs to be refreshed continuously 

3) Slower as compared to SRAM 

4) Used as RAM 

5) Smaller in size 

1.8.2 ROM 

 

ROM stands for Read Only Memory. The memory from which we can 
only read but cannot write on it. This type of memory is non-volatile. The 
information is stored permanently in such memories during manufacture. 
A ROM stores instructions that are required to start a computer. This 
operation is referred to as bootstrap.  

ROM chips are not only used in the computer but also in other electronic 
items like washing machines and microwave ovens. 

Types of ROM : 

1) PROM (Programmable Read only Memory) - PROM is a blank 
version of ROM. It is manufactured as blank memory and programmed 
after manufacturing. It is kept blank at the time of manufacturing. You can 
purchase and then program it once using a special tool called a 
programmer.To write data onto a PROM chip; a device called PROM 
programmer or PROM burner is used. The process or programming a 
PROM is known as burning the PROM. Once it is programmed, the data 
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cannot be modified later, so it is also called a one-time programmable 
device. 

For example, cell phones, video game consoles, medical devices etc. 

2) EPROM (Erasable and Programmable Read Only Memory) -  
EPROM is a type of ROM that can be programmed and erased many 
times. The method to erase the data is very different; it comes with a 
quartz window through which a specific frequency of ultraviolet light is 
passed for around 40 minutes to erase the data. So, it retains its content 
until it is exposed to ultraviolet light. 

It needs a special device called a PROM programmer or PROM burner to 
reprogram the EPROM. 

For example, It is used in some micro-controllers to store programs. 

3) EEPROM (Electrically Erasable and Programmable Read Only 
Memory) - ROM is a type of read only memory that can be erased and 
reprogrammed repeatedly, up to 10000 times. It is also known as Flash 
EEPROM as it is similar to flash memory. It is erased and reprogrammed 
electrically without using ultraviolet light. Access time is between 45 and 
200 nanoseconds. The data in this memory is written or erased one byte at 
a time; byte per byte, whereas, in flash memory data is written and erased 
in blocks. So, it is faster than EEPROM. It is used for storing a small 
amount of data in computer and electronic systems and devices such as 
circuit boards. 

For example, the BIOS of a computer is stored in this memory. 

1.8.3 Secondary Memory  
The secondary storage devices which are built into the computer or 
connected to the computer are known as a secondary memory of the 
computer. 

The secondary memory is accessed indirectly via input/output operations. 
It is non-volatile, so it permanently stores the data even when the 
computer is turned off or until this data is overwritten or deleted. The CPU 
can't directly access the secondary memory. First, the secondary memory 
data is transferred to primary memory then the CPU can access it. 

Some of the secondary memory devices are as follows : 

1) Hard Disk : 
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The hard disk is also known as a hard drive. It is a rigid magnetic disc that 
stores data permanently, as it is a non-volatile storage device. The hard 
disk is located within a drive unit on the computer's motherboard and 
comprises one or more platters packed in an air-sealed casing. The data is 
written on the platters by moving a magnetic head over the platters as they 
spin. The data stored on a computer's hard drive generally includes the 
operating system, installed software, and the user's files and programs, 
including pictures, music, videos, text documents, etc. 

2) Solid-state Drive : 

 

SSD (Solid State Drive) is also a non-volatile storage medium that is used 
to hold and access data. Unlike a hard drive, it does not have moving 
components, so it offers many advantages over SSD, such as faster access 
time, noiseless operation, less power consumption, and more. 

As the cost of an SSD has come down, it has become an ideal replacement 
for a standard hard drive in desktop and laptop computers. It is also 
suitable for notebooks, and tablets that don't require lots of storage. 

3) Pen drive : 

 

Pen drive is a compact secondary storage device. It is also known as a 
USB flash drive, thumb drive or a jump drive. It connects to a computer 
via a USB port. It is commonly used to store and transfer data between 
computers. For example, you can write a report using a computer and then 
copy or transfer it in the pen drive. Later, you can connect this pen drive to 
a computer to see or edit your report. You can also store your important 
documents and pictures, music, videos in the pen drive and keep it at a 
safe place. 

Pen drive does not have movable parts; it comprises an integrated circuit 
memory chip that stores the data. This chip is housed inside a plastic or 
aluminium casing. The data storage capacity of the pen drive generally 
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ranges from 2 GB to 128 GB. Furthermore, it is a plug and play device as 
you don't need additional drives, software, or hardware to use it. 

4) SD Card : 

 

SD Card stands for Secure Digital Card. It is most often used in portable 
and mobile devices such as smartphones and digital cameras. You can 
remove it from your device and see the things stored in it using a computer 
with a card reader. 

There are many memory chips inside the SD card that store the data; it 
does not have moving parts. SD cards are not created equal, so they may 
differ from each other in terms of speed, physical sizes, and capacity. For 
example, standard SD cards, mini SD cards, and micro SD cards. 

5) Compact Disk (CD) : 

 

Compact Disk is a portable secondary storage device in the shape of a 
round medium disk. It is made of polycarbonate plastic. The concept of 
CD was co-developed by Philips and Sony in 1982. The first CD was 
created on 17 August 1982 at the workshop of Philips in Germany. 

In the beginning, it was used for storing and playing sound recordings, 
later it was used for various purposes such as for storing documents, audio 
files, videos, and other data like software programs in a CD. 

6) DVD : 

 

DVD is short for digital versatile disc or digital video disc. It is a type of 
optical media used for storing optical data. Although it has the same size 
as a CD, its storage capacity is much more than a CD. So, it is widely used 
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for storing and viewing movies and to distribute software programs as 
they are too large to fit on a CD. DVD was co-developed by Sony, 
Panasonic, Philips, and Toshiba in 1995. 

Types of DVDs : 

1) DVD-ROM (Read-Only) : These types of DVDs come with media 
already recorded on them, such as movie dvds. As the name suggests, data 
on these discs cannot be erased or added, so these discs are known as a 
read-only or non-writable DVD. 

2) DVD-R (Writable) : It allows you to record or write information to the 
DVD. However, you can write information only once as it becomes a 
read-only DVD once it is full. 

3) DVD-RW (Rewritable or Erasable) : This type of discs can be erased, 
written, or recorded multiple times. 

1.8.4 Cache Memory 

Cache memory is a high-speed memory, which is small in size but faster 
than the main memory (RAM). The CPU can access it more quickly than 
the primary memory. So, it is used to synchronize with high-speed CPUs 
and to improve its performance.  

Cache memory can only be accessed by CPU. It can be a reserved part of 
the main memory or a storage device outside the CPU. It holds the data 
and programs which are frequently used by the CPU. So, it makes sure 
that the data is instantly available for the CPU whenever the CPU needs 
this data.  

In other words, if the CPU finds the required data or instructions in the 
cache memory, it doesn't need to access the primary memory (RAM). 
Thus, by acting as a buffer between RAM and CPU, it speeds up the 
system performance. 

1.9 COMPUTER SOFTWARE 

Software, which is abbreviated as SW or S/W, is a set of programs that 
enables the hardware to perform a specific task.  

All the programs that run the computer are software.  
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The software can be of two types :  

1) System Software : The system software is the main software that runs 
the computer. When you turn on the computer, it activates the hardware 
and controls and coordinates their functioning. The application programs 
are also controlled by system software.  

Examples of System Software : 

Operating System : An operating system is the system software that 
works as an interface to enable the user to communicate with the 
computer. It manages and coordinates the functioning of hardware and 
software of the computer. The commonly used operating systems are 
Microsoft Windows, Linux etc. 

Some other examples of system software include: 

BIOS : It stands for basic input output system. It is a type of system 
software, which is stored in Read Only Memory (ROM) located on the 
motherboard. However, in advanced computer systems, it is stored in flash 
memory. BIOS is the first software that gets activated when you turn on 
your computer system. It loads the drivers of the hard disk into memory as 
well as assists the operating system to load itself into the memory. 

Boot Program : Boot refers to starting up a computer. When you switch 
on the computer, the commands in the ROM are executed automatically to 
load the boot program into memory and execute its instructions. The BIOS 
program has a basic set of commands that enables the computer to perform 
the basic input/output instructions to start the computer. 

Assembler : It plays the role of a converter as it receives basic computer 
instructions and converts them into a pattern of bits. The processor uses 
these bits to perform basic operations. 

Device driver : This system software controls hardware devices 
connected to a computer. It enables the computer to use the hardware by 
providing an appropriate interface. The kernel of a Computer's CPU 
communicates with different hardware through this software. Operating 
systems generally come with most of the device drivers. 

2) Application Software - Application software is a set of programs 
designed to perform a specific task. It does not control the working of a 
computer as it is designed for end-users. A computer can run without 
application software. Application software can be easily installed or 
uninstalled as required. It can be a single program or a collection of small 
programs. Microsoft Office Suite, Adobe Photoshop, and any other 
software like payroll software or income tax software are application 
software.  
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Examples of Application Softwares : 

1. Utility Software - It assists the Operating System to manage, organize, 
maintain and optimize the functioning of the computer system. Some of 
the notable examples of utility software are anti-virus software, 
compression tools, file management tools, disk management tools, etc.  

2. Presentation Software - Presentation software is one such category of 
application program mainly used to create sequences of words and 
pictures mainly used to conduct a public presentation of information. 
Presentation software could be business presentation software and general 
multimedia authoring software, but it’s overall about tools that allow users 
to create both professional-looking business presentations and general 
multimedia presentations. 

3. Spreadsheet Software - it is capable of organizing, storing and 
analyzing data in tabular form. Often known as a spreadsheet program or 
spreadsheet application, the software has succeeded in replacing several 
paper-based systems, especially in the business world.  

4. Database Software - The next in line among the different types of 
software is the database software. Popular examples of databases include 
Oracle, MySQL, Microsoft SQL Server, PostgreSQL, MongoDB, and 
IBM Db2. 

5. Multimedia Software - It  is one consisting of Photo editing, media 
player, and video editing programs. In general multimedia software do 
come pre-installed on some operating systems, are also available free 
online, or taught in classrooms.  

6. Word Processors - Word processor software is used to create text-
based documents. These types of software are mainly used to create 
memos, faxes and letters, this software can be even considered for creating 
reports and personalized pages on the web. Some of the popular examples 
of Word Processing software are Google Docs, Microsoft Word, WordPad 
and Notepad. 

7. Web Browsers - Everyone who uses a computer, must know or know 
about web browsers. Web browsers are an essential part because these 
programmes allow you to browse the internet. They assist users in locating 
and accessing info on the internet.  

For example, Google Chrome, Internet Explorer, Microsoft Edge, Firefox, 
Opera etc. 

1.10 NETWORKING  

1.10.1 Computer Network  

Computer Network is a group of computers connected with each other 
through wires, optical fibres or optical links so that various devices can 
interact with each other through a network. 
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The aim of the computer network is the sharing of resources among 
various devices. 

In the case of computer network technology, there are several types of 
networks that vary from simple to complex level. 

1.10.2 Components Of Computer Network  

 

1) NIC(National interface card) - NIC is a device that helps the 
computer to communicate with another device. The network interface card 
contains the hardware addresses to identify the system on the network so 
that it transfers the data to the correct destination. 

Types of NIC : 

A) Wireless NIC : All the modern laptops use the wireless NIC. In 
Wireless NIC, a connection is made using the antenna that employs the 
radio wave technology. 

B) Wired NIC : Cables use the wired NIC to transfer the data over the 
medium. 

2) Hub - Hub is a central device that splits the network connection into 
multiple devices. When a computer requests for information from a 
computer, it sends the request to the Hub. Hub distributes this request to 
all the interconnected computers. 

3) Switches - Switch is a networking device that groups all the devices 
over the network to transfer the data to another device. A switch is better 
than Hub as it does not broadcast the message over the network, i.e., it 
sends the message to the device for which it belongs. Therefore, we can 
say that the switch sends the message directly from source to the 
destination. 

4) Cables and connectors - Cable is a transmission media that transmits 
the communication signals.  
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There are three types of cables : 

A) Twisted pair cable : It is a high-speed cable that transmits the data 
over 1Gbps or more. 

B) Coaxial cable : Coaxial cable resembles a TV installation cable. 
Coaxial cable is more expensive than twisted pair cable, but it provides a 
high data transmission speed. 

C) Fibre optic cable : Fibre optic cable is a high-speed cable that 
transmits the data using light beams. It provides high data transmission 
speed as compared to other cables. It is more expensive as compared to 
other cables, so it is installed at the government level. 

5) Router - Router is a device that connects the LAN to the internet. The 
router is mainly used to connect the distinct networks or connect the 
internet to multiple computers. 

6) Modem - Modem connects the computer to the internet over the 
existing telephone line. A modem is not integrated with the computer 
motherboard. A modem is a separate part on the PC slot found on the 
motherboard. 

1.10.3 Uses Of Computer Network 

1) Resource sharing : Resource sharing is the sharing of resources such 
as programs, printers, and data among the users on the network without 
the requirement of the physical location of the resource and user. 

2) Server-Client model : Computer networking is used in the server-
client model. A server is a central computer used to store the information 
and maintained by the system administrator. Clients are the machines used 
to access the information stored in the server remotely. 

3) Communication medium : Computer networks behave as a 
communication medium among the users. For example, a company 
containing more than one computer has an email system which the 
employees use for daily communication. 

4) E-commerce : Computer networks are important in businesses because 
businesses need the internet. For example, amazon.com is doing their 
business over the internet. 

1.10.4 Transmission modes 

The way in which data is transmitted from one device to another device is 
known as transmission mode. 

The transmission mode is also known as the communication mode. 

Each communication channel has a direction associated with it, and 
transmission media provide the direction. Therefore, the transmission 
mode is also known as a directional mode. 
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The Transmission mode is divided into three categories : 

 

 

A) Simplex mode : 

 

In Simplex mode, the communication is unidirectional, i.e., the data flows 
in one direction. 

A device can only send the data but cannot receive it or it can receive the 
data but cannot send the data. 

This transmission mode is not very popular as mainly communications 
require the two-way exchange of data. The simplex mode is used in the 
business field as in sales that do not require any corresponding reply. 

For example, the radio station is a simplex channel as it transmits the 
signal to the listeners but never allows them to transmit back, Keyboard 
and Monitor are the examples of the simplex mode as a keyboard can 
only accept the data from the user and monitor can only be used to display 
the data on the screen. 

B) Half-Duplex mode : 

 

In a Half-duplex channel, direction can be reversed, i.e., the station can 
transmit and receive the data as well. 

Messages flow in both directions, but not at the same time. 
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The entire bandwidth of the communication channel is utilized in one 
direction at a time. 

In half-duplex mode, it is possible to perform the error detection, and if 
any error occurs, then the receiver requests the sender to retransmit the 
data. 

For example, a Walkie-talkie is an example of the Half-duplex mode. In 
Walkie-talkie, one party speaks, and another party listens. After a pause, 
the other speaks and the first party listens. Speaking simultaneously will 
create a distorted sound which cannot be understood. 

C) Full-duplex mode : 

 

In Full duplex mode, the communication is bi-directional, i.e., the data 
flow in both the directions. 

Both the stations can send and receive the message simultaneously. 

Full-duplex mode has two simplex channels. One channel has traffic 
moving in one direction, and another channel has traffic flowing in the 
opposite direction. 

The Full-duplex mode is the fastest mode of communication between 
devices. 

For example, telephone networks are an example of full duplex mode, 
when two people are communicating with each other by a telephone line, 
both can talk and listen at the same time. 

1.10.5 Connections 

Two or more devices connected to a link are called a network. A link is a 
communication channel that transfers data from one device to another. 

Types of connections : 

A) Point-to-point - It provides a dedicated link between two devices. For 
example, a computer connected to a printer. 

B) Multi-point - More than two specific devices share a single link, also 
known as multi-drop configuration. The networks having multipoint 
configuration are called Broadcast networks. 
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1.10.6 Computer Network Architecture 

Computer Network Architecture is defined as the physical and logical 
design of the software, hardware, protocols, and media of the transmission 
of data. Simply it is how computers are organized and how tasks are 
allocated to the computer. 

Types of network architectures : 

 

1) Peer-To-Peer network 

Peer-To-Peer network is a network in which all the computers are linked 
together with equal privilege and responsibilities for processing the data. 

Peer-To-Peer network is useful for small environments, usually up to 10 
computers. 

Peer-To-Peer network has no dedicated server. 

Special permissions are assigned to each computer for sharing the 
resources, but this can lead to a problem if the computer with the resource 
is down. 

 

Advantages : 

It is less costly as it does not contain any dedicated server. 

If one computer stops working, other computers will not stop working. 

It is easy to set up and maintain as each computer manages itself. 
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Disadvantages : 

In the case of the Peer-To-Peer network, it does not contain the centralized 
system . Therefore, it cannot back up the data as the data is different in 
different locations. 

It has a security issue as the device is managed itself. 

2) Client/Server Network 

Client/Server network is a network model designed for the end users 
called clients, to access the resources such as songs, video, etc. from a 
central computer known as Server. 

The central controller is known as a server while all other computers in the 
network are called clients. A server performs all the major operations such 
as security and network management. 

A server is responsible for managing all the resources such as files, 
directories, printer, etc. 

All the clients communicate with each other through a server. For 
example, if client1 wants to send some data to client 2, then it first sends 
the request to the server for the permission. The server sends the response 
to client 1 to initiate its communication with client 2. 

 

Advantages : 

A Client/Server network contains the centralized system. Therefore we 
can back up the data easily. 

A Client/Server network has a dedicated server that improves the overall 
performance of the whole system. 

Security is better in Client/Server network as a single server administers 
the shared resources. 

It also increases the speed of sharing resources. 
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Disadvantages : 

Client/Server network is expensive as it requires the server with large 
memory. 

A server has a Network Operating System(NOS) to provide the resources 
to the clients, but the cost of NOS is very high. 

It requires a dedicated network administrator to manage all the resources. 

1.10.7 Physical Topology  

The Topology defines the structure of the network of how all the 
components are interconnected to each other. 

 

1) Bus Topology : 

 

It is a multipoint, one long cable that acts as a backbone to link all the 
devices on a network. It transmits data in only one direction and every 
device is connected to a single cable. A dropline is a connection running 
between the device and the main cable. 

Advantages :  

Low-cost cable : Nodes are directly connected to the cable without 
passing through a hub. Therefore, the initial cost of installation is low. 

Moderate data speeds : Coaxial or twisted pair cables are mainly used in 
bus-based networks that support upto 10 Mbps. 

Familiar technology : Bus topology is a familiar technology as the 
installation and troubleshooting techniques are well known, and hardware 
components are easily available. 
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Limited failure : A failure in one node will not have any effect on other 
nodes. 

Disadvantages : 

Extensive cabling : A bus topology is quite simple, but still it requires a 
lot of cabling. 

Difficult troubleshooting : It requires specialized test equipment to 
determine the cable faults. If any fault occurs in the cable, then it would 
disrupt the communication for all the nodes. 

Signal interference : If two nodes send the messages simultaneously, 
then the signals of both the nodes collide with each other. 

Reconfiguration is difficult : Adding new devices to the network would 
slow down the network. 

Attenuation : Attenuation is a loss of signal that leads to communication 
issues. Repeaters are used to regenerate the signal. 

2) Ring Topology : 

 

Each device has a dedicated point-to-point connection with only the two 
devices on either side of it. A signal is passed along a ring in one 
direction, from device to device, until it reaches its destination.  

Each device in a ring incorporates a repeater. When a device receives a 
signal intended for another device its repeater regenerates the bits and 
passes them along. 

Advantages : 

Network Management : Faulty devices can be removed from the network 
without bringing the network down.  

Product availability : Many hardware and software tools for network 
operation and monitoring are available.  

Cost : Twisted pair cabling is inexpensive and easily available. Therefore, 
the installation cost is very low. 
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Reliable : It is a more reliable network because the communication 
system is not dependent on the single host computer. 

Disadvantages : 

Difficult troubleshooting : It requires specialized test equipment to 
determine the cable faults. If any fault occurs in the cable, then it would 
disrupt the communication for all the nodes. 

Failure : The breakdown in one station leads to the failure of the overall 
network. 

Reconfiguration is difficult: Adding new devices to the network would 
slow down the network. 

Delay : Communication delay is directly proportional to the number of 
nodes. Adding new devices increases the communication delay. 

3) Star Topology : 

 

Star topology is an arrangement of the network in which every node is 
connected to the central hub, switch or a central computer. 

The central computer is known as a server, and the peripheral devices 
attached to the server are known as clients. Hubs or Switches are mainly 
used as connection devices in a physical star topology. Star topology is 
the most popular topology in network implementation. 

Advantages : 

Efficient troubleshooting : Troubleshooting is quite efficient in a star 
topology as compared to bus topology. In a bus topology, the manager has 
to inspect the kilometers of cable. In a star topology, all the stations are 
connected to the centralized network. Therefore, the network administrator 
has to go to the single station to troubleshoot the problem. 

Network control : Complex network control features can be easily 
implemented in the star topology. Any changes made in the star topology 
are automatically accommodated. 
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Limited failure : As each station is connected to the central hub with its 
own cable, therefore failure in one cable will not affect the entire network. 

Familiar technology : Star topology is a familiar technology as its tools 
are cost-effective. 

Easily expandable : It is easily expandable as new stations can be added 
to the open ports on the hub. 

Cost effective : Star topology networks are cost-effective as it uses 
inexpensive coaxial cable. 

High data speeds : It supports a bandwidth of approx 100Mbps.  

Disadvantages : 

A Central point of failure : If the central hub or switch goes down, then 
all the connected nodes will not be able to communicate with each other. 

Cable : Sometimes cable routing becomes difficult when a significant 
amount of routing is required. 

4) Tree Topology : 

 

Tree topology combines the characteristics of bus topology and star 
topology. 

A tree topology is a type of structure in which all the computers are 
connected with each other in hierarchical fashion. 

The top-most node in tree topology is known as a root node, and all other 
nodes are the descendants of the root node. There is only one path between 
two nodes for the data transmission. Thus, it forms a parent-child 
hierarchy. 

Advantages : 

Support for broadband transmission : Tree topology is mainly used to 
provide broadband transmission, i.e., signals are sent over long distances 
without being attenuated. 
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Easily expandable : We can add the new device to the existing network. 
Therefore, we can say that tree topology is easily expandable. 

Easily manageable : In tree topology, the whole network is divided into 
segments known as star networks which can be easily managed and 
maintained. 

Error detection: Error detection and error correction are very easy in a 
tree topology. 

Limited failure : The breakdown in one station does not affect the entire 
network. 

Point-to-point wiring : It has point-to-point wiring for individual 
segments. 

Disadvantages : 

Difficult troubleshooting : If any fault occurs in the node, then it 
becomes difficult to troubleshoot the problem. 

High cost : Devices required for broadband transmission are very costly. 

Failure : A tree topology mainly relies on the main bus cable and failure 
in the main bus cable will damage the overall network. 

Reconfiguration is difficult : If new devices are added, then it becomes 
difficult to reconfigure. 

5) Mesh Topology : 

 

Mesh technology is an arrangement of the network in which computers are 
interconnected with each other through various redundant connections. 

There are multiple paths from one computer to another computer, every 
device has a dedicated point-to-point link to every other device, dedicated 
means that the link carries traffic only between two devices it connects. 

It does not contain the switch, hub or any central computer which acts as a 
central point of communication. 
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For example, the Internet is an example of mesh topology, it is mainly 
used for wireless networks. 

Advantages : 

Reliable : The mesh topology networks are very reliable as if any link 
breakdown will not affect the communication between connected 
computers. 

Fast Communication : Communication is very fast between the nodes. 

Easier Reconfiguration : Adding new devices would not disrupt the 
communication between other devices. 

isadvantages : 

Cost : A mesh topology contains a large number of connected devices 
such as a router and more transmission media than other topologies. 

Management : Mesh topology networks are very large and very difficult 
to maintain and manage. If the network is not monitored carefully, then 
the communication link failure goes undetected. 

Efficiency : In this topology, redundant connections are high that reduces 
the efficiency of the network. 

Exercise Questions  

Multiple Choice Questions. 

1) _________________ is also known as a personal computer which is 
used for general purpose. 

a) Microcomputer    b) Minicomputer   c) Workstation                              
d) Mainframe  

2) One of the following is not an input device. 

a) Printer    b) Scanner   c) Biometrics  d) Microphone  

3) One of the following is not an output device. 

a) Printer    b) Speaker   c) Light pen   d) Projector  

4) RAM is a _____________ memory. 

a) non volatile    b) volatile   c) software   d) hardware 

5) __________ is a device that helps the computer to communicate with 
other devices.  

a) NIC     b) Hub   c) Switch   d) Modem 

 

mu
no
tes
.in



  

 

Information Technology 
in Accountancy - I 

48 

True or False. 

1) Router is a device that connects the LAN to the internet. 

2) In Simplex mode communication is bi-directional. 

3) Secondary memory is a non-volatile memory which stores data 
permanently. 

4) Clock speed of the CPU is measured in KB. 

5) Special purpose computers are designed to perform general tasks. 

Short answer or define. 

1) Computer 

2) Memory 

3) System software 

4) Hub 

5) Topology 

Long answer questions. 
1) Write a short note on generations of computers. 

2) What are the types of computers? 

3) Explain the basic structure of a PC. 
4) What are the types of keyboard? 

5) Explain types of scanners. 

6) Write a short note on output devices. 

7) Explain in brief types of memory. 

8) What are the types of software? 

9) Define computer networks. 

10) What are the components of a data communication system? 

11) Write a short note on : 

       a) Bus Topology 

`      b) Ring Topology 

       c) Star Topology 

       d) Mesh Topology 

12) What are transmission modes in networks? 

13) Write a short note on peer to peer architecture. 
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2 
OFFICE PRODUCTIVITY TOOLS 

Unit Structure 

2.0 Objectives  

2.1  MS Word 

2.2  MS Excel 

2.3  Power Point 

2.4 Use of Tools in Accounting 

2.0 OBJECTIVES  

By the end of this module, you should be able to : 

1) Identify and name MS word toolbar 

2) Create, save, export, format & print documents  

3) Work with mail merge 

4) Create & copy worksheets, create formulae 

5) Work with different types of charts & print worksheet 

6) Create presentations, adding animation in presentations 

7) Apply themes, insert images and effects of animations 

8) Identify & define vouchers, invoice, reports  

2.1  MS WORD 

1 Microsoft Word : 

Microsoft Word 2016 is a word processing application that allows you to 
create a variety of documents, including letters, resumes, and more.  

1.1 The Word interface : 

When we open Word for the first time, the Start Screen will appear. From 
here, we will be able to create a new document, choose a template, and 
access your recently edited documents.  

From the Start Screen, locate and select the Blank document to access 
the Word interface. 
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1.2 Working with the Word environment 

Like other recent versions, Word 2016 continues to use features like the 
Ribbon and the Quick Access Toolbar where we will find commands to 
perform common tasks in Word as well as Backstage view. 

1.2.1 The Ribbon 

Word uses a tabbed Ribbon system instead of traditional menus. The 
Ribbon contains multiple tabs, which we can find near the top of the 
Word window. 

 

Each tab contains several groups of related commands. For example, the 
Font group on the Home tab contains commands for formatting text in our 
document. 
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Some groups also have a small arrow in the bottom-right corner that we 
can click for more options. 

 

Showing and hiding the Ribbon : 

If we find that the Ribbon takes up too much screen space, we can hide it. 
To do this, click the Ribbon Display Options arrow in the upper-right 
corner of the Ribbon, then select the desired option from the drop-down 
menu: 

 

Auto-hide Ribbon : Auto-hide displays our document in full-screen mode 
and completely hides the Ribbon from view. To show the Ribbon, click 
the Expand Ribbon command at the top of the screen. 

Show Tabs : This option hides all command groups when they're not in 
use, but tabs will remain visible. To show the Ribbon, simply click a tab. 

Show Tabs and Commands : This option maximizes the Ribbon. All of 
the tabs and commands will be visible. This option is selected by default 
when you open Word for the first time. 
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1.3 Tell me feature : 

The Tell Me feature works just like a regular search bar : Type what we 
want looking for, and a list of options will appear. We can then use the 
command directly from the menu without having to find it on the Ribbon. 

 

1.4 The Quick Access Toolbar 

Located just above the Ribbon, the Quick Access Toolbar lets access 
common commands no matter which tab is selected. By default, it shows 
the Save, Undo, and Redo commands, but we can add other commands 
depending on our needs. 

To add commands to the Quick Access Toolbar : 

1) Click the drop-down arrow to the right of the Quick Access 
Toolbar. 

 

 

 

 

mu
no
tes
.in



  

 

Information Technology 
in Accountancy - I 

54 

2) Select the command we want to add from the menu. 

 

 

 

3) The command will be added to the Quick Access Toolbar. 

 

 

1.5 The Ruler 

The Ruler is located at the top and to the left of our document. It makes it 
easier to adjust our document with precision. If we want, we can hide the 
Ruler to create more screen space. 

To show or hide the Ruler: 

1) Click the View tab. 

 

 

 

mu
no
tes
.in



 

 

Office Productivity Tools 

 

55 

2) Click the checkbox next to Ruler to show or hide the Ruler. 

 

 

1.6 Backstage view 

Backstage view gives you various options for saving, opening a file, 
printing, and sharing your document. To access Backstage view, click the 
File tab on the Ribbon. 

 

Following options are available under File tab. 

 

1.7 Create a new blank document : 

When beginning a new project in Word, we will start with a new blank 
document. 
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1) Select the File tab to access Backstage view. 

 

 

2) Select New, then click Blank document. 

 

3) A new blank document will appear. 

1.8 To create a new document from a template : 

A template is a predesigned document we can use to create a new 
document quickly. Templates often include custom formatting and 
designs, so they can save a lot of time and effort when starting a new 
project. 

1) Click the File tab to access Backstage view, then select New. 

2) Several templates will appear below the Blank document option.  

We can also use the search bar to find something more specific. In our 
example, we'll search for a flyer template. 
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3) When we find something we like, select a template to preview it. 
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4) A preview of the template will appear. Click Create to use the selected 
template. 

 

5) A new document will appear with the selected template. 

1.9 Saving Document : 

When we create a new document in Word, we need to know how to save it 
so we can access and edit it later.  

A) Save and Save As : 

Word offers two ways to save a file : Save and Save As.  

These options work in similar ways, with a few important differences. 

i) Save : When we save a file, we only need to choose a file name and 
location the first time. After that, we can click the Save command to save 
it with the same name and location. 

ii) Save As : It is used to create a copy of a document while keeping the 
original. When we use Save As, we need to choose a different name 
and/or location for the copied version. 

B) AutoRecover : 

Word automatically saves our documents to a temporary folder while we 
are working on them. If we forget to save our changes or if Word crashes, 
we can restore the file using AutoRecover. 

1) Open Word. If autosaved versions of a file are found, the Document 
Recovery pane will appear on the left. 
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2) Click to open an available file. The document will be recovered. 

 

3) By default, Word autosaves every 10 minutes. If we are editing a 
document for less than 10 minutes, Word may not create an autosaved 
version. 

4) If we don't see the file we need, we can browse all autosaved files from 
Backstage view.  

5) Select the File tab, click Manage Versions, then choose Recover 
Unsaved Documents. 

 

C) Exporting documents : 

By default, Word documents are saved in the .docx file type. However, 
there may be times when we need to use another file type, such as a PDF 
or Word 97-2003 document. It's easy to export our document from Word 
to a variety of file types. 
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To export a document as a PDF file : 

Exporting our document as an Adobe Acrobat document, commonly 
known as a PDF file, can be especially useful if we are sharing a 
document with someone who does not have Word. A PDF file will make it 
possible for recipients to view but not edit the content of our document. 

1) Click the File tab to access Backstage view, choose Export, then select 
Create PDF/XPS. 

 

 

2) The Save As dialog box will appear. Select the location where we want 
to export the document, enter a filename, then click Publish. 

 

To export a document to other file types : 

It may also find it helpful to export our document to other file types, such 
as a Word 97-2003 Document if we need to share with people using an 

mu
no
tes
.in



 

 

Office Productivity Tools 

 

61 

older version of Word or as a .txt file if we need a plain-text version of 
our document. 

1) Click the File tab to access Backstage view, choose Export, then select 
Change File Type. 

 

 

2) Select a file type, then click Save As. 
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3) The Save As dialog box will appear. Select the location where we want 
to export the document, enter a filename, then click Save. 

4) We can also use the Save as type drop-down menu in the Save As 
dialog box to save documents to a variety of file types. 

 

1.10 Compatibility Mode : 

Sometimes we need to work with documents that were created in earlier 
versions of Microsoft Word, such as Word 2010 or Word 2007. When we 
open these types of documents, they will appear in Compatibility Mode. 

Compatibility Mode disables certain features, so we will only be able to 
access commands found in the program that was used to create the 
document. For example, if we open a document created in Word 2007 we 
can only use tabs and commands found in Word 2007. 

 

To exit Compatibility Mode, we need to convert the document to the 
current version type.  

To convert a document : 

If we want access to all Word 2016 features, we can convert the document 
to the 2016 file format. 
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1) Click the File tab to access Backstage view, then locate and select the 
Convert command. 

 

2) A dialog box will appear. Click OK to confirm the file upgrade. 

 

 

3) The document will be converted to the newest file type. 

1.11 Formatting documents : 

Formatting documents include basic tasks such as add, delete, move text, 
cut, copy, paste, adjusting text including font, size, color, text alignment, 
find & replace in our document. 

Using the insertion point to add text - The insertion point is the 
blinking vertical line in our document. It indicates where we can enter text 
on the page.  

Blank document : When a new blank document opens, the insertion point 
will appear in the top-left corner of the page. If we want, we can begin 
typing from this location.  
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Adding spaces: Press the spacebar to add spaces after a word or in 
between text. 

 

New paragraph line : Press Enter on our keyboard to move the insertion 
point to the next paragraph line. 

 

Manual placement : Once we begin typing, we can use the mouse to 
move the insertion point to a specific place in our document. Simply click 
the location in the text where we want to place it. 

Arrow keys : we can also use the arrow keys on our keyboard to move the 
insertion point. The left and right arrow keys will move between adjacent 
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characters on the same line, while the up and down arrows will move 
between paragraph lines. We can also press Ctrl+Left or Ctrl+Right to 
quickly move between entire words. In a new blank document, we can 
double-click the mouse to move the insertion point anywhere on the page. 

To delete text : There are several ways to delete or remove text. 

1) To delete text to the left of the insertion point, press the Backspace key 
on our keyboard. 

2) To delete text to the right of the insertion point, press the Delete key on 
our keyboard. 

3) Select the text we want to remove, then press the Delete key. 

Copying and moving text : Word allows us to copy text that's already in 
our document and paste it in other places, which can save a lot of time and 
effort. If we want to move text around in our document, we can cut and 
paste. 

1) Select the text you want to copy. 

 

2) Click the Copy command on the Home tab. Alternatively, we can press 
Ctrl+C on your keyboard. 

 

3) Place the insertion point where we want the text to appear. 

4) Click the Paste command on the Home tab. Alternatively, we can press 
Ctrl+V on your keyboard. 
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5) The text will appear. 

 

To cut and paste text : 

1) Select the text you want to cut. 

 

2) Click the Cut command on the Home tab. Alternatively, we can press 
Ctrl+X on your keyboard. 

 

3) Place your insertion point where you want the text to appear. 

4) Click the Paste command on the Home tab. Alternatively, we can press 
Ctrl+V on your keyboard. 
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5) The text will appear. 
 

Undo and Redo : If we are working on a document and accidentally 
delete some text. Word allows us to undo our most recent action when 
we make a mistake like this. 

To do this, locate and select the Undo command on the Quick Access 
Toolbar. Alternatively, we can press Ctrl+Z on our keyboard. We can 
continue using this command to undo multiple changes in a row. 

 

By contrast, the Redo command allows us to reverse the last undo. We 
can also access this command by pressing Ctrl+Y on your keyboard. 

 

Symbols : 

If we need to insert an unusual character that's not on our keyboard, such 
as a copyright (©) or trademark (™) symbol, we can usually find them 
with the Symbol command. 
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1) Place the insertion point where you want the symbol to appear. 

 

2) Click the Insert tab. 

 

3) Locate and select the Symbol command, then choose the desired 
symbol from the drop-down menu. If we don't see the one we want, select 
More Symbols. 

 

 

4) The symbol will appear in the document. 
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Change the font size : 

1) Select the text you want to modify. 

 

2) On the Home tab, click the Font size drop-down arrow. Select a font 
size from the menu. If the font size we need is not available in the menu, 
you can click the Font size box and type the desired font size, then press 
Enter. 
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3) The font size will change in the document. 

 

 

4) We can also use the Grow Font and Shrink Font commands to change 
the font size. 

 

To change the font : 

By default, the font of each new document is set to Calibri. However, 
Word provides many other fonts to customize text. 

1) Select the text you want to modify. 
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2) On the Home tab, click the drop-down arrow next to the Font box. A 
menu of font styles will appear. 

3) Select the font style we want to use. 
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4) The font will change in the document. 

 

 

When creating a professional document or a document that contains 
multiple paragraphs, we need to select a font that's easy to read. Along 
with Calibri, standard reading fonts include Cambria, Times New Roman, 
and Arial. 

To change the font color : 

1) Select the text you want to modify. 
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2) On the Home tab, click the Font Color drop-down arrow. The Font 
Color menu appears. 

 

 

3) Select the font color we want to use. The font color will change in the 
document. 

 

Our color choices aren't limited to the drop-down menu that appears. 
Select More Colors at the bottom of the menu to access the Colors dialog 
box. Choose the color we want, then click OK. 
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The Bold, Italic, and Underline commands : 

The Bold, Italic, and Underline commands can be used to help draw 
attention to important words or phrases. 

1) Select the text we want to modify. 

 

2) On the Home tab, click the Bold (B), Italic (I), or Underline (U) 
command in the Font group. In our example, we'll click Bold. 
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3) The selected text will be modified in the document. 

 

 

To change text case : 

When we need to quickly change a text case, we can use the Change Case 
command instead of deleting and retyping text. 

1) Select the text we want to modify. 
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2) On the Home tab, click the Change Case command in the Font group. 

3) A drop-down menu will appear. Select the desired case option from the 
menu. 

 

4) The text case will be changed in the document. 

 

To highlight text : 

Highlighting can be a useful tool for marking important text in your 
document. 
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1) Select the text you want to highlight. 

 

2) From the Home tab, click the Text Highlight Color drop-down arrow. 
The Highlight Color menu appears. 

 

 

3) Select the desired highlight color. The selected text will then be 
highlighted in the document. 
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To remove highlighting, select the highlighted text, then click the Text 
Highlight Color drop-down arrow, and Select No Color from the drop-
down menu. 

 

To change text alignment : 

By default, Word aligns text to the left margin in new documents. 
However, there may be times when we want to adjust text alignment to the 
center or right. 

1) Select the text you want to modify. 

 

2) On the Home tab, select one of the four alignment options from the 
Paragraph group. In our example, we've selected Center Alignment. 
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3) The text will be realigned in the document. 

 

Justify : Justified text is equal on both sides. It lines up equally to the 
right and left margins. Many newspapers and magazines use full 
justification. 

Find & Replace : When we are working with longer documents, it can be 
difficult and time consuming to locate a specific word or phrase. Word can 
automatically search our document using the Find feature, and it allows us 
to quickly change words or phrases using Replace. 

To find text :  

1) From the Home tab, click the Find command. Alternatively, you can 
press Ctrl+F on your keyboard. 
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2) The navigation pane will appear on the left side of the screen. 

3) Type the text we want to find in the field at the top of the navigation 
pane. In our example, we'll type the word we're looking for. 

 

4) If the text is found in the document, it will be highlighted in yellow and 
a preview of the results will appear in the navigation pane. Alternatively, 
you can click one of the results below the arrows to jump to it. 

 

 

5) When you are finished, click the X to close the navigation pane. The 
highlight will disappear. 
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To replace text : 

1) From the Home tab, click the Replace command. Alternatively, you can 
press Ctrl+H on your keyboard. 

 

2) The Find and Replace dialog box will appear. 

3) Type the text we want to find in the Find what: field. 

4) Type the text we want to replace it with in the Replace with: field. Then 
click Find Next. 

 

5) Word will find the first instance of the text and highlight it in gray. 

6) Review the text to make sure you want to replace it. In our example, the 
text is part of the title of the paper and does not need to be replaced. We'll 
click Find Next again to jump to the next instance. 
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7) If we want to replace it, we can click Replace to change individual 
instances of text. Alternatively, we can click Replace All to replace every 
instance of the text throughout the document. 

8) The text will be replaced. 
9) When you're done, click Close or Cancel to close the dialog box. 

Bulleted and numbered lists : It can be used in our documents to outline, 
arrange, and emphasize text.  

1) Select the text you want to format as a list. 
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2) On the Home tab, click the drop-down arrow next to the Bullets 
command. A menu of bullet styles will appear. 

 

 

3) Move the mouse over the various bullet styles. A live preview of the 
bullet style will appear in the document. Select the bullet style you want to 
use. 

 

4) The text will be formatted as a bulleted list. 

 

To create a numbered list : When we need to organize text into a 
numbered list, Word offers several numbering options. We can format 
your list with numbers, letters, or Roman numerals. 
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1) Select the text you want to format as a list. 

 

2) On the Home tab, click the drop-down arrow next to the Numbering 
command. A menu of numbering styles will appear. 

 

3) Move the mouse over the various numbering styles. A live preview of 
the numbering style will appear in the document. Select the numbering 
style you want to use. 
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4) The text will format as a numbered list. 

 

Restart a numbered list : If we want to restart the numbering of a list, 
Word has a Restart at 1 option. It can be applied to numeric and 
alphabetical lists. 

1) Right-click the list item you want to restart the numbering for, then 
select Restart at 1 from the menu that appears. 
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2) The list numbering will restart. 

 

Customizing bullets : Customizing the look of the bullets in our list can 
help us emphasize certain list items and personalize the design of our list. 
Word allows us to format bullets in a variety of ways. We can use symbols 
and different colors, or even upload a picture as a bullet. 

1) Select an existing list you want to format. 

 

2) On the Home tab, click the drop-down arrow next to the Bullets 
command. Select Define New Bullet from the drop-down menu. 
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3) The Define New Bullet dialog box will appear. Click the Symbol 
button. 

 

4) The Symbol dialog box will appear. 

5) Click the Font drop-down box and select a font. The Wingdings and 
Symbol fonts are good choices because they have many useful symbols. 
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6) Select the desired symbol, then click OK. 

 

7) The symbol will appear in the Preview section of the Define New 
Bullet dialog box. Click OK. 
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8) The symbol will appear in the list. 

 

To change the bullet color : 

1) Select an existing list you want to format. 
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2) On the Home tab, click the drop-down arrow next to the Bullets 
command. Select Define New Bullet from the drop-down menu. 

 

3) The Define New Bullet dialog box will appear. Click the Font button. 
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4) The Font dialog box will appear. Click the Font Color drop-down box. 
A menu of font colors will appear. 

5) Select the desired color, then click OK. 

 

6) The bullet color will appear in the Preview section of the Define New 
Bullet dialog box. Click OK. 
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7) The bullet color will change in the list. 

 

Adding hyperlinks : Adding hyperlinks to text can provide access to 
websites and email addresses directly from our document. There are a few 
ways to insert a hyperlink into our document. 

Hyperlinks have two basic parts : the address (URL) of the webpage and 
the display text. For example, the address could be 
http://www.popsci.com, and the display text could be Popular Science 
Magazine.  

When we create a hyperlink in Word, we would be able to choose both the 
address and the display text. 

Word often recognizes email and web addresses as we type and will 
automatically format them as hyperlinks after we press Enter or the 
spacebar.  

1) Select the text you want to format as a hyperlink. 
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2) Select the Insert tab, then click the Hyperlink command. 
(Alternatively, you can open the Insert Hyperlink dialog box by right-
clicking the selected text and selecting Hyperlink... from the menu that 
appears.) 

 

 
3) The Insert Hyperlink dialog box will appear. Using the options on the 
left side, you can choose to link to a file, webpage, email address, 
document, or a place in the current document. 

4) The selected text will appear in the Text to display : field at the top. 
We can change this text if we want. 

5) In the Address : field, type the address we want to link to, then click 
OK. 
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6) The text will then be formatted as a hyperlink. 

 

 

Editing and removing hyperlinks : Once we have inserted a hyperlink, 
we can right-click the hyperlink to edit, open, copy, or remove it. 

 

To remove a hyperlink, right-click the hyperlink and select Remove 
Hyperlink from the menu that appears. 
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1.12 Page Layout :  

Word offers a variety of page layout and formatting options that affect 
how content appears on the page. We can customize the page orientation, 
paper size, and page margins depending on how we want our document to 
appear. 

Page orientation  

Word offers two page orientation options : landscape and portrait.  

1) Landscape means the page is oriented horizontally. 
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2) Portrait means the page is oriented vertically. 

 

 

To change page orientation : 

1) Select the Layout tab. 

2) Click the Orientation command in the Page Setup group. 
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3) A drop-down menu will appear. Click either Portrait or Landscape to 
change the page orientation. 

 

 

4) The page orientation of the document will be changed. 

Page size : 

By default, the page size of a new document is 8.5 inches by 11 inches. 
Depending on our project, we may need to adjust our document's page 
size.  

Word has a variety of predefined page sizes to choose from. 

1) Select the Layout tab, then click the Size command. 

 

2) A drop-down menu will appear. The current page size is highlighted. 
Click the desired predefined page size. 

 

3) The page size of the document will be changed. 
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To use a custom page size : 

Word also allows you to customize the page size in the Page Setup dialog 
box. 

1) From the Layout tab, click Size. Select More Paper Sizes from the 
drop-down menu. 

 

2) The Page Setup dialog box will appear. 
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3) Adjust the values for Width and Height, then click OK. 

 

4) The page size of the document will be changed. 

 

Page margins : 

A margin is the space between the text and the edge of your document. 
By default, a new document's margins are set to Normal, which means it 
has a one-inch space between the text and each edge. Depending on our 
needs, Word allows us to change our document's margin size. 

Word has a variety of predefined margin sizes to choose from. 

1) Select the Layout tab, then click the Margins command 

. 
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2) A drop-down menu will appear. Click the predefined margin size you 
want. 

 

3) The margins of the document will be changed. 

To use custom margins : 

Word also allows us to customize the size of our margins in the Page 
Setup dialog box. 
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1) From the Layout tab, click Margins. Select Custom Margins from the 
drop-down menu. 

 

2) The Page Setup dialog box will appear. 

3) Adjust the values for each margin, then click OK. 
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4) The margins of the document will be changed. 

Alternatively, we can open the Page Setup dialog box by navigating to the 
Layout tab and clicking the small arrow in the bottom-right corner of the 
Page Setup group. 
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1.13 Printing documents : 

Once we have created our document, we may want to print it to view and 
share our work offline. It's easy to preview and print a document in Word 
using the Print pane. 

1) Select the File tab. Backstage view will appear. 

 

2) Select Print. The Print pane will appear. We can also access the Print 
pane by pressing Ctrl+P on your keyboard. 

 

 

 

 

mu
no
tes
.in



  

 

Information Technology 
in Accountancy - I 

104 

To print a document : 

1) Navigate to the Print pane, then select the desired printer. 

 

2) Enter the number of copies we want to print. 
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3) Select any additional settings if needed. 

 

4) Click Print. 
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Custom printing : 

Sometimes we find it unnecessary to print our entire document, in this 
case custom printing is more suitable for us. Word allows us to specify 
exactly which pages we would like to print. 

If we would like to print individual pages or page ranges, we need to 
separate each entry with a comma (1, 3, 5-7, or 10-14 for example). 

1) Navigate to the Print pane. 

2) In the Pages: field, enter the pages we want to print. 

 

3) Click Print. 

 

 

1.14 Mail merge  

Mail Merge is a useful tool that allows us to produce multiple letters, 
labels, envelopes, name tags, and more using information stored in a list, 
database, or spreadsheet. When performing a Mail Merge, we will need a 
Word document (we can start with an existing one or create a new one) 
and a recipient list, which is typically an Excel workbook. 

1) Open an existing Word document, or create a new one. 
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2) From the Mailings tab, click the Start Mail Merge command and 
select Step-by-Step Mail Merge Wizard from the drop-down menu. 

 

3) The Mail Merge pane will appear and guide us through the six main 
steps to complete a merge. The following example demonstrates how to 
create a form letter and merge the letter with a recipient list. 

Step 1 : From the Mail Merge task pane on the right side of the Word 
window, choose the type of document we want to create. In our example, 
we'll select Letters. Then click Next: Starting document to move to Step 2. 
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Step 2 : Select Use the current document, then click Next: Select 
recipients to move to Step 3 . 

 

Step 3 : Now we need an address list so Word can automatically place 
each address into the document. The list can be in an existing file, such as 
an Excel workbook, or we can type a new address list from within the 
Mail Merge Wizard. 

1) Select Use an existing list, then click Browse to select the file. 
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2) Locate your file, then click Open. 

 

3) If the address list is in an Excel workbook, select the worksheet that 
contains the list, then click OK. 

 

4) In the Mail Merge Recipients dialog box, we can check or uncheck 
each box to control which recipients are included in the merge. By default, 
all recipients should be selected. When we are done, click OK. 
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5) Click Next: Write your letter to move to Step 4. 

 

If we don't have an existing address list, we can click the Type a new list 
button and click Create, then type our address list manually. 

Step 4 : Now we are ready to write our letter. When it's printed, each copy 
of the letter will basically be the same; only the recipient data (such as the 
name and address) will be different. We will need to add placeholders for 
the recipient data so Mail Merge knows exactly where to add the data. 

To insert recipient data : 

1) Place the insertion point in the document where you want the 
information to appear. 
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2) Choose one of the placeholder options. In our example, we'll select the 
Address block. 

 

3) Depending on your selection, a dialog box may appear with various 
customization options. Select the desired options, then click OK. 
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4) A placeholder will appear in your document (for example, «Address 
Block»). 

 

 

5) Add any other placeholders we want. In our example, we'll add a 
Greeting line placeholder just above the body of the letter. 
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6) When we are done, click Next: Preview your letters to move to Step 5. 

 

Step 5 : Preview the letters to make sure the information from the 
recipient list appears correctly in the letter. We can use the left and right 
scroll arrows to view each version of the document. 

 

 

If everything looks correct, click Next: Complete the merge to move to 
Step 6. 
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Step 6 : Click Print to print the letters. 
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1) A dialog box will appear. Decide if we want to print All of the letters, 
the current document (record), or only a select group, then click OK. In 
our example, we'll print all of the letters. 

 

 

2) The Print dialog box will appear. Adjust the print settings if needed, 
then click OK. The letters will be printed. 
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2.2 MS EXCEL 

Microsoft Excel is an office use application designed by Microsoft.  

It is one of the most suitable spreadsheet programs that help us to store 
and represent the data in tabular form, manage and manipulate data, create 
optically logical charts, and more.  

Excel provides a worksheet to create a new document in it. We can save 
the Excel file with the .xls extension. 

2.1 Features of Microsoft Excel : 

1) AutoFormat : It allows the Excel users to use predefined table 
formatting options. 

2) AutoSum : AutoSum feature helps us to calculate the sum of a row or 
column automatically by inserting an additional formula for a range of 
cells. 

3) List AutoFill : It automatically develops cell formatting when a new 
component is added to the end of a list. 

4) AutoFill : This feature allows us to quickly fill cells with a repetitive or 
sequential record such as chronological dates or numbers and repeated 
documents. AutoFill can also be used to copy functions. We can also alter 
text and numbers with this feature. 

5) AutoShapes : AutoShapes toolbar will allow us to draw some 
geometrical shapes, arrows, flowchart items, stars, and more. With these 
shapes, we can draw our graphs. 

6) Wizard : It guides us to work effectively while we work by displaying 
several helpful tips and techniques based on what we are doing. Drag and 
Drop feature will help us to reposition the record and text by simply 
dragging the data with the help of the mouse. 

7) Charts : This feature will help you to present the data in graphical form 
by using Pie, Bar, Line charts, and more. 

8) PivotTable : It flips and sums data in seconds and allows us to execute 
data analysis and generate documents like periodic financial statements, 
statistical documents, etc. We can also analyze complex data relationships 
graphically. 

9) Shortcut Menus : The shortcut menu helps users to get the work done 
through shortcut commands that need a lengthy process. 
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2.2 Excel Interface : 

It is the main interface of an Excel worksheet, where we work and store 
our data. This interface contains various components. 

 

Quick Access Toolbar : It contains some common and most used 
commands of Excel, which users repeatedly need while working with 
Excel. By default, Save, Undo, and Repeat commands are added in the 
quick access toolbar.  

It provides fast access to its users by adding most-used commands in it. 
This quick access toolbar is customizable. It means you can add other 
commands, whichever you need most. 

Add commands to the Quick Access toolbar : 

1) Click on the drop-down arrow to the right of the Quick Access toolbar. 
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2) Select the command you wish to add in the quick access toolbar from 
the drop-down menu. 

 

For more commands, which are not available here, click on More 
Commands and choose from there. 
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3) Here, we have selected the command Print Preview and Print that has 
been added to the Quick Access toolbar along with other commands.  

 

Excel Ribbon : Excel 2016 utilizes a tabbed Ribbon system instead of 
traditional menus. The Ribbon includes multiple tabs, each with several 
groups of commands. We will use these tabs to perform the most common 
function in Excel. 

File, Home, Insert, Page Layout, Formula, Data, Review, View, and 
Help are the tabs consisting of the Excel ribbon. 

 

Each tab of Excel Ribbon contains its related operations list. For 
example, the formula tab contains all the mathematical, logical, text, 
string, finance, Date, and time functions. 

To minimize and maximize the Ribbon : The Ribbon is designed to 
respond to our current function, but we can choose to minimize it if we 
find that it takes up too much screen space. 
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1) To click the Ribbon Display Options arrow in the upper-right corner of 
the Ribbon. 

 

2) Select the desired minimizing options from the drop-down menu. 

Auto-hide Ribbon : Auto-hide shows our workbook in full-screen mode 
and hides the Ribbon completely. To show the Ribbon, click the Expand 
Ribbon command at the top of the screen. 

Show Tabs : This option hides all command groups when not in use, but 
tabs will remain there. To show the Ribbon, simply click on any of the 
tabs. 

Show Tabs and Commands: This option maximizes the Ribbon. All of 
the tabs and commands will always be visible to the user. This option is 
selected by default when we open Excel for the first time. 
Customize the Ribbon in Excel 2016 : 

1) Right-click the Ribbon and then choose Customize the Ribbon from 
the drop-down menu. 
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2) The Excel Options Dialog box will occur. Locate and select New Tab 
or New group, whichever you want to add. 

 

3) Now, select a command from the left panel and click the Add button to 
the new customized tab/group. You can also drag the commands directly 
into a group. 
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4) When you are done adding commands, click OK. The commands will 
be added to the Ribbon in a new tab like this. 

 

Formula Bar : In the formula bar, we can enter or edit data, a formula, or 
a function that will occur in a specific cell. It allows us to write the 
function and formulas to manipulate the data. 

In the image below, cell C1 is selected, and 2000 is entered into the 
formula bar.  

 

Name Box : The Name box presents the location or "name" of a selected 
cell. 

In the image below, cell B4 is selected. Note that cell B4 is where column 
B and row 4 intersect. 
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The Backstage View (The File Menu) : Click the File tab on the Ribbon. 
The Backstage view will emerge. 

 

It is the backstage view of MS Excel and information about the options it 
contains. 
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The Worksheet Views : Excel 2016 has a variety of displaying options 
that change how our workbook is shown. We can choose to view any 
workbook in the Normal view, Page Layout view, or Page Break view. 
These views can be useful for several tasks, especially if we're planning to 
print the spreadsheet. 

To change the worksheet views, locate and choose the desired worksheet 
view command in the bottom-right corner of the Excel window. 

 

Zoom Control : To use a Zoom control, click and drag the slider. The 
number to the right of the slider reverses the zoom percentage. It is 
presented at the bottom right corner of the Excel worksheet. 

 

2.3 Creating Worksheet  

We can choose to create a new worksheet either with a blank worksheet or 
a predesigned template or open an existing worksheet. 

Create a new workbook : 

1) Select the File tab. Backstage view will appear. 
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2) Select New, then click Blank workbook. 

 

 

3) A new blank workbook will appear. 

To open existing worksheet : 

1) Navigate to the Backstage view, then click Open. 
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2) Select Computer, then click Browse. Alternatively, you can choose 
OneDrive to open files stored on your OneDrive. 

 

3) The Open dialog box will appear. Locate and select your workbook, 
then click Open. 

 

 

4) If we have opened the desired workbook recently, we can browse your 
Recent Workbooks rather than search for the file. 
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To pin a workbook : 

If we frequently work with the same workbook, we can pin it to 
Backstage view for faster access. 

1) Navigate to the Backstage view, then click Open. Your recently 
edited workbooks will appear. 

 

2) Hover the mouse over the workbook you want to pin. A pushpin icon 
will appear next to the workbook. Click the pushpin icon. 
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3) The workbook will stay in Recent Workbooks. To unpin a workbook, 
simply click the pushpin icon again. 

 

 

Using templates : 

A template is a predesigned spreadsheet we can use to create a new 
workbook quickly. Templates often include custom formatting and 
predefined formulas, so they can save our lot of time and effort when 
starting a new project. 
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1) Click the File tab to access Backstage view. 

 

2) Select New. Several templates will appear below the Blank workbook 
option. 

3) Select a template to review it. 

 

4) A preview of the template will appear, along with additional 
information on how the template can be used. 

5) Click Create to use the selected template. 
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6) A new workbook will appear with the selected template. 

2.4 Rename a Worksheet 

To rename our worksheet with a customized and appropriate name we can 
follow below steps. 

1) Right-click on the sheet tab for which you wish to change the name. 

2) The toolbar window will appear. Choose the Rename option. 

 

3) Type your preferred name. For instance, in the below screenshot, we 
have renamed 'Sheet1' to Sales 2021. 
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2.5 Copy a Worksheet 

While working many times, the Excel users require copying and pasting 
the data of one worksheet to another and making some changes. Excel 
provides easy steps to copy the data of one worksheet to another. 

1) Right-click on the sheet tab that we want to copy. 

2) The toolbar window will appear. Click on the 'Move or Copy' option. 

 

3) The 'Move or Copy' dialog box will be displayed. In the Before Sheet 
section, select the 'move to end' option and make sure to check in the 
'create a copy'. 

 

4) Click OK. Our data will be copied to the new worksheet. 
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2.6 Creating Formulae 

One of the most powerful features in Excel is the ability to calculate 
numerical information using formulas. Just like a calculator, Excel can 
add, subtract, multiply, and divide. 

Excel uses standard operators for formulas, such as a plus sign for addition 
(+), a minus sign for subtraction (-), an asterisk for multiplication (*), a 
forward slash for division (/), and a caret (^) for exponents. 

All formulas in Excel must begin with an equals sign (=). This is because 
the cell contains, or is equal to, the formula and the value it calculates. 

While we create simple formulas in Excel using numbers (for example, 
=2+2 or =5*5), most of the time we will use cell addresses to create a 
formula. This is known as making a cell reference. Using cell references 
will ensure that our formulas are always accurate because we can change 
the value of referenced cells without having to rewrite the formula. 

For example, In the formula below, cell A3 adds the values of cells A1 
and A2 by making cell references: 

 

When you press Enter, the formula calculates and displays the answer in 
cell A3: 

 

If the values in the referenced cells change, the formula automatically 
recalculates: 

 

By combining a mathematical operator with cell references, we can create 
a variety of simple formulas in Excel. Formulas can also include a 
combination of cell references and numbers, as in the examples below: 
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To create a formula : In our example below, we'll use a simple formula 
and cell references to calculate a budget. 

1) Select the cell that will contain the formula. In our example, we'll select 
cell D12. 

 

2) Type the equals sign (=). Notice how it appears in both the cell and the 
formula bar. 
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3) Type the cell address of the cell we want to reference first in the 
formula: cell D10 in our example. A blue border will appear around the 
referenced cell. 

 

4) Type the mathematical operator we want to use. In our example, we'll 
type the addition sign (+). 

5) Type the cell address of the cell you want to reference second in the 
formula: cell D11 in our example. A red border will appear around the 
referenced cell. 
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6) Press Enter on our keyboard. The formula will be calculated, and the 
value will be displayed in the cell. If we select the cell again, the cell 
displays the result, while the formula bar displays the formula. 

 

7) If the result of a formula is too large to be displayed in a cell, it may 
appear as pound signs (#######) instead of a value. This means the 
column is not wide enough to display the cell content. Simply increase the 
column width to show the cell content. 

To create a formula using the point-and-click method : Instead of 
typing cell addresses manually, we can point and click the cells we want to 
include in our formula. This method can save a lot of time and effort when 
creating formulas. For example, we'll create a formula to calculate the cost 
of ordering several boxes of plastic silverware. 

1) Select the cell that will contain the formula. In our example, we'll select 
cell D4. 
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2) Type the equals sign (=). 

3) Select the cell you want to reference first in the formula: cell B4 in our 
example. The cell address will appear in the formula. 

 

4) Type the mathematical operator you want to use. In our example, we'll 
type the multiplication sign (*). 

5) Select the cell you want to reference second in the formula: cell C4 in 
our example. The cell address will appear in the formula. 

 

6) Press Enter on your keyboard. The formula will be calculated, and the 
value will be displayed in the cell. 
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Copying formulas with the fill handle : Formulas can also be copied to 
adjacent cells with the fill handle, which can save a lot of time and effort if 
we need to perform the same calculation multiple times in a worksheet. 
The fill handle is the small square at the bottom-right corner of the 
selected cell(s). 

1) Select the cell containing the formula you want to copy. Click and drag 
the fill handle over the cells you want to fill. 

 

2) After you release the mouse, the formula will be copied to the selected 
cells. 

 

2.7 Various Formulae/Functions used in Excel : 

1) SUM : The SUM() function, as the name suggests, gives the total of the 
selected range of cell values. It performs the mathematical operation 
which is addition.  
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2) AVERAGE : The AVERAGE() function focuses on calculating the 
average of the selected range of cell values. As seen from the below 
example, to find the avg of the total sales, you have to simply type in 
“AVERAGE(C2, C3, C4)”.  

 

3) COUNT : The function COUNT() counts the total number of cells in a 
range that contains a number. It does not include the cell, which is blank, 
and the ones that hold data in any other format apart from numeric.  

 

4) SUBTOTAL : The SUBTOTAL() function returns the subtotal in a 
database. Depending on what you want, you can select either average, 
count, sum, min, max, min, and others.  

 

In the example above, we have performed the subtotal calculation on cells 
ranging from A2 to A4. As you can see, the function used is 
“=SUBTOTAL(1, A2: A4), in the subtotal list “1” refers to average. 
Hence, the above function will give the average of A2: A4 and the answer 
to it is 11, which is stored in C5. 
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Similarly, “=SUBTOTAL(4, A2: A4)” selects the cell with the maximum 
value from A2 to A4, which is 12. Incorporating “4” in the function 
provides the maximum result. 

 

5) MODULUS : The MOD() function works on returning the remainder 
when a particular number is divided by a divisor.  

 

6) POWER : The function “Power()” returns the result of a number raised 
to a certain power.  

 

7) CEILING : Next, we have the ceiling function. The CEILING() 
function rounds a number up to its nearest multiple of significance.  

       

The nearest highest multiple of 5 for 35.316 is 40. 
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8) FLOOR : Contrary to the Ceiling function, the floor function rounds a 
number down to the nearest multiple of significance. 

 

The nearest lowest multiple of 5 for 35.316 is 35. 

9) CONCATENATE : This function merges or joins several text strings 
into one text string. In this example, we have operated with the syntax 
=CONCATENATE(A25, " ", B25) 

 

10) LEN : The function LEN() returns the total number of characters in a 
string. So, it will count the overall characters, including spaces and special 
characters. 

 

2.8 Creating Charts 

It can be difficult to interpret Excel workbooks that contain a lot of data. 
Charts allow us to illustrate our workbook data graphically, which makes 
it easy to visualize comparisons and trends. 

2.8.1 Types of charts : Excel offers many charts to represent the data in 
different manners, such as - Pie charts, Bar charts, Line charts, Stock 
charts, Surface charts, Radar charts, and many more. We can use them 
according to our data and analysis. 

Column Charts : A column chart is basically a vertical chart that is used 
to represent the data in vertical bars. It works efficiently with different 
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types of data, but it is usually used for comparing the information. Excel 
offers 2D and 3D column charts. 

 

Line Chart : Line charts are most useful for showing trends. Using this 
chart, you can easily analyze the ups and downs in your data over time. In 
this chart, data points are connected with lines. 

 

Bar chart : Bar charts are horizontal bars that work like column charts. 
Unlike column charts, Bar charts are horizontally plotted. Or we can say 
that bar charts and column charts are just opposite to each other. 
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Area chart : Area charts are just like line charts. Unlike the line charts, 
gaps are filled with color in area charts. Area charts are easy to analyze the 
growth in business as it shows ups and downs through line. 

 

Pie chart : A pie chart is a rounded shape graph that is divided into slices 
of pie. Using this chart, you can easily analyze data that is divided into 
slices. It makes the data easy to compare the proportion. Pie chart is also 
known as Doughnut chart.  

 

Surface chart : Surface chart is actually a 3D chart that helps to represent 
the data into a 3D landscape. These charts are best to use with a large 
dataset. This chart allows displaying a variety of data at the same time. A 
large dataset is not easy to represent using other charts. Surface charts 
solve this problem that allows displaying large datasets using this 3D 
chart. 
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2.8.2 Insert Chart for data :  

1) Select the cells you want to chart, including the column titles and row 
labels. These cells will be the source data for the chart. In our example, 
we'll select cells A1:F6. 

 

2) From the Insert tab, click the desired Chart command. In our example, 
we'll select Column. 
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3) Choose the desired chart type from the drop-down menu. 

 

4) The Selected chart will be inserted into the worksheet. 

 

2.8.3 Chart Layout Styles  

Excel allows you to add chart elements such as chart titles, legends, and 
data labels to make your chart easier to read.  

To add a chart element, click the Add Chart Element command on the 
Design tab, then choose the desired element from the drop-down menu. 
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To edit a chart element, like a chart title, simply double-click the 
placeholder and begin typing. 

 

 

If we don't want to add chart elements individually, we can use one of 
Excel's predefined layouts.  

Simply click the Quick Layout command, then choose the desired layout 
from the drop-down menu. 
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Excel also includes several chart styles, which allow us to quickly modify 
the look and feel of our chart.  

To change the chart style, select the desired style from the Chart styles 
group. We can also click the drop-down arrow on the right to see more 
styles. 

 

To change the chart type : If we find that our data isn't well suited to a 
certain chart, it's easy to switch to a new chart type.  

In our example, we'll change our chart from a column chart to a line chart. 

1) From the Design tab, click the Change Chart Type command. 

 

2) The Change Chart Type dialog box will appear. Select a new chart type 
and layout, then click OK. In our example, we'll choose a Line chart. 
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3) The selected chart type will appear. 
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2.9 Using Tools 

2.9.1 Flash fill : Flash fill in Excel automatically combines data. Flash 
only works when it recognizes a pattern. 

Example 1 : Use flash fill in Excel to extract the numbers in column A 
below. 

1) First, tell Excel what you want to do by entering the value 4645 into 
cell B1. 

 

2) On the Data tab, in the Data Tools group, click Flash Fill (or press 
CTRL + E). 

 

Result: 

 

Example 2 : Use flash fill in Excel to join the last names in column A 
below and the first names in column B below to create email addresses. 

1) First, tell Excel what you want to do by entering a correct email address 
in cell C1. 
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2) On the Data tab, in the Data Tools group, click Flash Fill (or press 
CTRL + E). 

 

Result: 

 

2.9.2 Sorting Data : Content can be sorted alphabetically, numerically, 
and in many other ways. 

Types of sorting : When sorting data, it's important to first decide if we 
want the sort to apply to the entire worksheet or just a cell range. 

Sort sheet organizes all of the data in our worksheet by one column. 
Related information across each row is kept together when the sort is 
applied. In the example below, the Contact Name column (column A) has 
been sorted to display the names in alphabetical order. 

 

Sort range sorts the data in a range of cells, which can be helpful when 
working with a sheet that contains several tables. Sorting a range will not 
affect other content on the worksheet. 
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To sort a sheet :  

1) Select a cell in the column you want to sort by. In our example, we'll 
select cell C2. 

 

2) Select the Data tab on the Ribbon, then click the A-Z command to sort 
A to Z, or the Z-A command to sort Z to A. In our example, we'll sort                   
A to Z. 
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3) The worksheet will be sorted by the selected column. In our example, 
the worksheet is now sorted by last name. 

 

To sort a range : 

1) Select the cell range you want to sort. In our example, we'll select cell 
range G2:H6. 

 

2) Select the Data tab on the Ribbon, then click the Sort command. 
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3) The Sort dialog box will appear. Choose the column we want to sort by. 
In our example, we want to sort the data by the number of T-shirt orders, 
so we'll select Orders. 

 

4) Decide the sorting order (either ascending or descending). In our 
example, we'll use Largest to Smallest. 

5) Once we are satisfied with your selection, click OK. 

 

6) The cell range will be sorted by the selected column. In our example, 
the Orders column will be sorted from highest to lowest. Notice that the 
other content in the worksheet was not affected by the sort. 

 

2.9.3 Filtering Data : Filters can be used to narrow down the data in your 
worksheet, allowing you to view only the information you need. 
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To filter data : 

In our example, we'll apply a filter to an equipment log worksheet to 
display only the laptops and projectors that are available for checkout. 

1) In order for filtering to work correctly, our worksheet should include a 
header row, which is used to identify the name of each column. 

 

2) Select the Data tab, then click the Filter command. 

 

 

3) A drop-down arrow will appear in the header cell for each column. 

4) Click the drop-down arrow for the column we want to filter. In our 
example, we will filter column B to view only certain types of equipment. 

 

5) The Filter menu will appear. 

6) Uncheck the box next to Select All to quickly deselect all data. 
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7) Check the boxes next to the data you want to filter, then click OK.  

In this example, we will check Laptop and Projector to view only these 
types of equipment. 
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8) The data will be filtered, temporarily hiding any content that doesn't 
match the criteria. In our example, only laptops and projectors are visible. 

 

Filters are cumulative, which means we can apply multiple filters to help 
narrow down our results. 

2.9.4 Conditional Formatting : it provides another way to visualize data 
and make worksheets easier to understand. 

It allows us to automatically apply formatting such as colors, icons, and 
data bars to one or more cells based on the cell value. To do this, we 
need to create a conditional formatting rule. 

For example, we have a worksheet containing sales data, and we'd like to 
see which salespeople are meeting their monthly sales goals. The sales 
goal is $4000 per month, so we'll create a conditional formatting rule for 
any cells containing a value higher than 4000. 

1) Select the desired cells for the conditional formatting rule. 
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2) From the Home tab, click the Conditional Formatting command. A 
drop-down menu will appear. 

3) Hover the mouse over the desired conditional formatting type, then 
select the desired rule from the menu that appears. In our example, we 
want to highlight cells that are greater than $4000. 

 

4) A dialog box will appear. Enter the desired value(s) into the blank 
field.  

In our example, we'll enter 4000 as our value. 

5) Select a formatting style from the drop-down menu. In our example, 
we'll choose Green Fill with Dark Green Text, then click OK. 

 

6) The conditional formatting will be applied to the selected cells. In our 
example, it's easy to see which salespeople reached the $4000 sales goal 
for each month. 
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2.9.5 Freeze Pane : Excel includes several tools that make it easier to 
view content from different parts of our workbook at the same time, 
including the ability to freeze panes and split our worksheet. 

We want to see certain rows or columns all the time in our worksheet, 
especially header cells. By freezing rows or columns in place, we'll be 
able to scroll through our content while continuing to view the frozen 
cells. 

1) Select the row below the row(s) we want to freeze. In our example, we 
want to freeze rows 1 and 2, so we'll select row 3. 
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2) On the View tab, select the Freeze Panes command, then choose 
Freeze Panes from the drop-down menu. 

 

3) The rows will be frozen in place, as indicated by the gray line. We can 
scroll down the worksheet while continuing to view the frozen rows at the 
top. In our example, we've scrolled down to row 18. 

 

 

2.10 Printing Review & Set up 

When we want to print a workbook to view and share our data offline, we 
will choose our page layout settings. To access the Print pane: 

1) Select the File tab. Backstage view will appear. 
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2) Select Print. The Print pane will appear. 
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3) Navigate to the Print pane, then select the desired printer. 

 

4) Enter the number of copies we want to print. 
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5) Select any additional settings if needed. 

 

6) Click Print. 

 

Choosing a print area : Before we print an Excel workbook, it's 
important to decide exactly what information we want to print.  

A) To print active sheets : Worksheets are considered active when 
selected. 

1) Select the worksheet we want to print. To print multiple worksheets, 
click the first worksheet, hold the Ctrl key on our keyboard, then click any 
other worksheets we want to select. 
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2) Navigate to the Print pane. 

3) Select Print Active Sheets from the Print Range drop-down menu. 

 

4) Click the Print button. 

 

B) To print the entire workbook : 

1) Navigate to the Print pane. 

2) Select Print Entire Workbook from the Print Range drop-down menu. 

 

3) Click the Print button. 
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C) To print a selection : In our example, we'll print the records for the 
top 40 salespeople on the Central worksheet. 

1) Select the cells we want to print. 

 

2) Navigate to the Print pane. 

3) Select Print Selection from the Print Range drop-down menu. 
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4) A preview of your selection will appear in the Preview pane. 

 

5) Click the Print button to print the selection. 
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2.3  POWER POINT 

PowerPoint, is a software program developed by Microsoft to produce 
effective presentations. It is a part of Microsoft Office suite.  

The program comprises slides and various tools like word processing, 
drawing, graphing and outlining. Thus it can display text, table, chart, 
graphics and media in the slides. 

We can save powerpoint files with the .pptx extension. 

3.1 Creating Presentation 

When beginning a new project in PowerPoint, we want to start with a new 
blank presentation. 

1) Select the File tab to go to Backstage view. 

 

 

2) Select New on the left side of the window, then click Blank 
Presentation. 

 

3) A new presentation will appear. 
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3.2 Creating Slides  

Every PowerPoint presentation is composed of a series of slides.  

When you insert a new slide, it will usually have placeholders to show us 
where content will be placed. Slides have different layouts for 
placeholders, depending on the type of information we want to include. 
Whenever we create a new slide, we’ll need to choose a slide layout that 
fits our content. 

 

Placeholders can contain different types of content, including text, images, 
and videos. Many placeholders have thumbnail icons we can click to add 
specific types of content.  

In the example below, the slide has placeholders for the title and content. 
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To insert a new slide : 

Whenever we start a new presentation, it will contain one slide with the 
Title Slide layout. We can insert as many slides as we need from a variety 
of layouts. 

1) From the Home tab, click the bottom half of the New Slide command. 

 

2) Choose the desired slide layout from the menu that appears. 

 

3) The new slide will appear. Click any placeholder and begin typing to 
add text. We can also click an icon to add other types of content, such as a 
picture or a chart. 
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Organizing Slides : The Slide Navigation pane on the left side of the 
screen makes it easy to organize our slides. From there, we can duplicate, 
rearrange, and delete slides in our presentation. 

 

Duplicate slides : If we want to copy and paste a slide quickly, we can 
duplicate it. To duplicate slides, select the slide we want to duplicate, 
right-click the mouse, and choose Duplicate Slide from the menu that 
appears. We can also duplicate multiple slides at once by selecting them 
first. 
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Move slides : It's easy to change the order of our slides. Just click and 
drag the desired slide in the Slide Navigation pane to the desired position. 

 

Delete slides : If we want to remove a slide from our presentation, we can 
delete it. Simply select the slide we want to delete, then press the Delete 
or Backspace key on our keyboard. 
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Customizing slide layouts : Sometimes we may find that a slide layout 
doesn't exactly fit our needs. PowerPoint makes it easy to adjust slide 
layouts as needed. 

Adjusting placeholders : Hover the mouse over the edge of the 
placeholder and click (you may need to click the text in the placeholder 
first to see the border). A selected placeholder will have a solid line 
instead of a dotted line. 

 

To move a placeholder : Select the placeholder, then click and drag it to 
the desired location. 

 

To resize a placeholder : Select the placeholder we want to resize. Sizing 
handles will appear. Click and drag the sizing handles until the 
placeholder is the desired size. We can use the corner sizing handles to 
change the placeholder's height and width at the same time. 

 

To delete a placeholder : Select the placeholder we want to delete, then 
press the Delete or Backspace key on our keyboard. 

To add a text box : Text can be inserted into both placeholders and text 
boxes. Inserting text boxes allows us to add to the slide layout. Unlike 
placeholders, text boxes always stay in the same place, even if you change 
the theme. 
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1) From the Insert tab, select the Text Box command. 

 

2) Click and drag to draw the text box on the slide. 

 

3) The text box will appear. To add text, simply click the text box and 
begin typing. 

 

Using blank slides : If we want even more control over our content, we 
may prefer to use a blank slide, which contains no placeholders. Blank 
slides can be customized by adding our own text boxes, pictures, charts, 
and more. 

1) To insert a blank slide, click the bottom half of the New Slide 
command, then choose Blank from the menu that appears. 
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To play the presentation : Once we have arranged our slides, we may 
want to play our presentation.  

1) Click the Start From Beginning command on the Quick Access 
Toolbar to see our presentation. 

 

 

2) The presentation will appear in full-screen mode. 

3) We can advance to the next slide by clicking your mouse or pressing 
the spacebar on our keyboard. Alternatively, we can use the arrow keys 
on our keyboard to move forward or backward through the presentation. 

4) Press the Esc key to exit presentation mode. 
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To change the slide size : By default, all slides in PowerPoint 2013 use a 
16-by-9 or widescreen aspect ratio. Widescreen slides will work best with 
widescreen monitors and projectors.  

1) Select the Design tab, then click the Slide Size command. Choose the 
desired slide size from the menu that appears, or click Custom Slide Size 
for more options. 

 

 

To format the slide background : By default, all slides in our 
presentation use a white background. Backgrounds can have a solid, 
gradient, pattern, or picture fill. 

1) Select the Design tab, then click the Format Background command. 

 

2) The Format Background pane will appear on the right. Select the 
desired fill options.  
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In our example, we'll use a Solid fill with a light gold color. 

 

3) The background style of the selected slide will update. 

4) If we want, we can click Apply to All to apply the same background 
style to all slides in our presentation. 

 

 

3.3 Themes  

Themes give us a quick and easy way to change the design of our 
presentation. They control our primary color palette, basic fonts, slide 
layout, and other important elements. All of the elements of a theme will 
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work well together, which means we won't have to spend as much time 
formatting our presentation. 

Each theme uses its own set of slide layouts. These layouts control the 
way our content is arranged, so the effect can be dramatic. Different 
themes also use different slide layouts, which can change the arrangement 
of our existing placeholders.  

1) Select the Design tab on the Ribbon, then click the More drop-down 
arrow to see all of the available themes. 

 

2) Select the desired theme. 

 

3) The theme will be applied to our entire presentation. 
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To apply Transitions : A transition can be as simple as fading to the next 
slide or as flashy as an eye-catching effect. PowerPoint makes it easy to 
apply transitions to some or all of our slides, giving our presentation a 
polished, professional look. 

There are three categories of unique transitions to choose from, all of 
which can be found on the Transitions tab. 

1) Subtle : These are the most basic types of transitions. They use simple 
animations to move between slides. 

 

 

2) Exciting : These use more complex animations to transition between 
slides. They are more visually interesting than Subtle transitions. 

 

3) Dynamic Content : If we're transitioning between two slides that use 
similar slide layouts, dynamic transitions will move only the placeholders, 
not the slides themselves. When used correctly, dynamic transitions can 
help unify our slides and add a further level of polish to our presentation. 
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To apply a transition : 

1) Select the desired slide from the Slide Navigation pane. This is the slide 
that will appear after the transition. 

 

2) Click the Transitions tab, then locate the Transition to This Slide group. 
By default, None is applied to each slide. 

3) Click the More drop-down arrow to display all transitions. 
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3) Click a transition to apply it to the selected slide. This will 
automatically preview the transition. 

 

 

5) We can use the Apply To All command in the Timing group to apply 
the same transition to all slides in our presentation.  

 

To preview a transition : We can preview the transition for a selected 
slide at any time using either of these two methods: 

1) Click the Preview command on the Transitions tab. 
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2) Click the Play Animations command in the Slide Navigation pane. 

 

To modify the transition duration : 

1) Select the slide with the transition we want to modify. 

2) In the Duration field in the Timing group, enter the desired time for the 
transition. In this example, we'll decrease the time to half a second or 
00.50 to make the transition faster. 

 

 

To add sound : 

1) Select the slide with the transition we want to modify. 

2) Click the Sound drop-down menu in the Timing group. 

3) Click a sound to apply it to the selected slide, then preview the 
transition to hear the sound. 
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Slide Views : PowerPoint includes several different slide views, which are 
all useful for various tasks. The slide view commands are located in the 
bottom-right of the PowerPoint window.  

There are four main slide views. 
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1) Normal view : This is the default view, where we create and edit slides. 
We can also move slides in the Slide Navigation pane on the left. 

 

2) Slide sorter view : In this view, we’ll see a thumbnail version of each 
slide. We can drag and drop slides to reorder them quickly. 

 

3) Reading view : This view fills the PowerPoint window with a preview 
of our presentation. It includes easily accessible navigation buttons at the 
bottom-right. 
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4) Slide show view : This command will begin the presentation from the 
current slide. We can also press F5 on our keyboard to start from the 
beginning. A menu will appear in the bottom-left corner when we move 
the mouse. These commands allow ou to navigate through the slides and 
access other features, such as the pen and highlighter. 

 

 

Outline view : Outline view shows our slide text in outline form. This 
allows us to quickly edit our slide text and view the content of multiple 
slides at once. We could use this layout to review the organization of our 
slide show and prepare to deliver our presentation. 

1) From the View tab, click the Outline View command. 

 

2) An outline of your slide text will appear in the slide navigation pane. 

3) You can type directly in the outline to make changes to your slide text. 
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3.4 Insert Image  

Adding pictures can make our presentations more interesting and 
engaging. We can insert a picture from a file on our computer onto any 
slide. PowerPoint even includes tools for finding online pictures and 
adding screenshots to our presentation. 

1) Select the Insert tab, then click the Pictures command in the Images 
group. 

 

2) A dialog box will appear. Locate and select the desired image file, then 
click Insert. 

 

3) The picture will appear on the currently selected slide. 

 

Inserting screenshots : Screenshots are basically snapshots of our 
computer screen. We can take a screenshot of almost any program, 
website, or open window. PowerPoint makes it easy to insert a screenshot 
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of an entire window or a screen clipping of part of a window in our 
presentation. 

1) Select the Insert tab, then click the Screenshot command in the Images 
group. 

2) The Available Windows from our desktop will appear. Select the 
window we want to capture as a screenshot. 

 

 

3) The screenshot will appear on the currently selected slide. 
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To insert a screen clipping : 

1) Select the Insert tab, click the Screenshot command, then select Screen 
Clipping. 

 

 

2) A view of other open windows will appear. Click and drag to select the 
area we want to capture as a screen clipping. 

 

3.5 Animation  

In PowerPoint, we can animate text and objects such as clip art, shapes, 
and pictures. Animation or movement on the slide can be used to draw the 
audience's attention to specific content or to make the slide easier to read. 

Types of Animation : 

1) Entrance : These control how the object enters the slide. For example, 
with the Bounce animation the object will "fall" onto the slide and then 
bounce several times. 
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2) Emphasis: These animations occur while the object is on the slide, 
often triggered by a mouse click. For example, we can set an object to 
spin when we click the mouse. 

 

 

3) Exit : These control how the object exits the slide. For example, with 
the Fade animation the object will simply fade away. 

 

 

4) Motion Paths : These are similar to Emphasis effects, except the 
object moves within the slide along a predetermined path, like a circle. 
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To apply an animation to an object : 

1) Select the object you want to animate. 

2) On the Animations tab, click the More drop-down arrow in the 
Animation group. 

 

3) A drop-down menu of animation effects will appear. Select the desired 
effect. 

 

 

4) The effect will apply to the object. The object will have a small 
number next to it to show that it has an animation. In the Slide pane, a 
star symbol also will appear next to the slide. 
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5) At the bottom of the menu, we can access even more effects. 

 

Effect options : Some effects will have options we can change. For 
example, with the Fly In effect we can control which direction the object 
comes from. These options can be accessed from the Effect Options 
command in the Animation group. 

 

To remove an animation : 

1) Select the small number located next to the animated object. 

 

2) Press the Delete key. The animation will be deleted. 
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To preview animations : Any animation effects we have applied will 
show up when we play the slide show. However, we can also quickly 
preview the animations for the current slide without viewing the slide 
show. 

1) Navigate to the slide we want to preview. 

2) From the Animations tab, click the Preview command. The animations 
for the current slide will play. 

 

3.6 Print Review & Set-up  

PowerPoint presentations are designed to be viewed on a computer, there 
may be times when we want to print them. We can even print custom 
versions of a presentation, which can be especially helpful when 
presenting our slide show. The Print pane makes it easy to preview and 
print your presentation. 

Print layouts : PowerPoint offers several layouts to choose from when 
printing a presentation. The layout we choose will mostly depend on why 
we are printing the slide show. Types of print layouts : 

1) Full Page Slides : This prints a full page for each slide in your 
presentation. This layout is most useful if we need to review or edit a 
printed copy of our presentation. 

 

2) Notes Pages : This prints each slide, along with any speaker notes for 
the slide. If we have included a lot of notes for each slide, we could keep a 
printed copy of the notes with us while presenting. 
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3) Outline : This prints an overall outline of the slide show. We could use 
this to review the organization of our slide show and prepare to deliver our 
presentation. 

 

4) Handouts : This prints thumbnail versions of each slide, with optional 
space for notes. This layout is especially useful if we want to give our 
audience a physical copy of the presentation. The optional space allows 
them to take notes on each slide. 
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To access the Print pane : 

1) Select the File tab. Backstage view will appear. 

 

 

2) Select Print. The Print pane will appear. 

 
3) Click the buttons in the interactive below to learn more about using the 
Print pane. 
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4) We can also access the Print pane by pressing Ctrl+P on our keyboard. 

To print a presentation : 

1) Select the File tab. Backstage view will appear. 

 

 

2) Select Print. The Print pane will appear. 

 
3) Choose the desired printer and print range. 

4) Choose the desired print layout and color settings. 
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5) When we are done modifying the settings, click Print. 

 

 

2.4  USE OF TOOLS IN ACCOUNTING 

4.1 Vouchers 

A Voucher is an internal document used for supporting the entries in 
accounting books.  

It is treated as a redeemable transaction bond, has monetary value and is 
useful for specific purposes.  

Types of Accounting Vouchers : 

1) Cash Voucher – These vouchers get prepared by a firm solely for cash 
transactions like receipts and payments.  
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It can be a Debit Voucher that a firm prepares only for cash payments to 
suppliers or vendors to purchase raw materials and semi-finished goods 
for production, purchase of assets or payments of expenses.  

It can also be a Credit Voucher that a firm prepares only for cash receipts 
from customers or vendors to sell goods to the customer, sale of assets or 
receipt of income. 

2) Non-Cash Voucher – These vouchers are also known as transfer 
vouchers, and they are prepared for credit transactions only.  

Examples of such transactions are credit purchase or sale of goods, 
purchase or sale of fixed assets on credit, etc. 

The preparation of vouchers depends on how a transaction gets recorded 
in the account books. Based on the complexity of a transaction, the 
vouchers can be classified as follows : 

A) Transaction Voucher – It is a voucher prepared by the firm when one 
account gets debited and another account gets credited for a transaction. 

B) Compound Voucher – It is a voucher prepared by the firm for two 
types of transactions. The first type is where more than one account gets 
debited, but only one account gets credited for a transaction. And the 
second type is where more than one account gets credited, but only one 
account gets debited for a transaction. 

C) Complex Voucher – It is a voucher prepared by a firm when multiple 
accounts are debited and credited for a transaction. 

4.1.1 Preparation of Vouchers  

Vouchers includes various supporting documents, which are as follows : 

1) The invoice that the supplier receives from the firm 

2) The details of the supplier like name, address and contact number 

3) The details of the payment like the amount, discounts or the due date of 
payment 

4) The details related to the initial purchase order that the company had 
made with the supplier 

5) The receipt with details of the transaction confirming that the company 
had received the goods or the services as mentioned in the invoice 

6) The details of the ledger accounts related to the particular transaction 

7) The signature of the company’s authorised signatory validating the 
purchase of goods or services along with receipt of the payment 

8) The proof of the payment that is in the documentation for the voucher 
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4.1.2 Steps involved in the preparation of vouchers  

1) The company gets in touch with the supplier to place an order for raw 
materials or semi-finished goods. If the supplier agrees with the order’s 
specifications and the amount, then the firm places the order with them. 

2) The supplier prepares and sends the order consignment to the firm. 
There is a quality control check to see if there are no defective or damaged 
items in that consignment. The person/s responsible for quality control 
also checks if the order matches the specifications. 

3) After the firm is satisfied with the order, it creates a voucher for the 
transaction with the relevant details and supporting documents. 

4) The voucher and the supporting documents get thoroughly checked by 
both parties to ensure zero errors. Post that, the company pays the supplier 
for the consignment. 

4.2 Invoices 

An invoice is a document given to the buyer by the seller to collect 
payment. It includes the cost of the products purchased or services 
rendered to the buyer. Invoices can also serve as legal records, if they 
contain the names of the seller and client, description and price of goods 
or services, and the terms of payment. 

4.2.1 Functions of invoices  

Companies need to deliver invoices in order to demand payments.  

An invoice is a legally binding agreement showing both parties' consent to 
the quoted price and payment conditions.  

Other benefits of invoices : 

1) Maintaining records : The most important benefit of an invoice is the 
ability to keep a legal record of the sale. This makes it possible to find out 
when a good was sold, who bought it, and who sold it. 

2) Payment tracking : An invoice is an invaluable tool for accounting. It 
helps both the seller and the buyer to keep track of their payments and 
amounts owed.  

3) Legal protection : A proper invoice is legal proof of an agreement 
between the buyer and seller on a set price. It protects the merchant from 
fraudulent lawsuits. 

4) Easy tax filing : Recording and maintaining all sale invoices helps the 
company report its income and ensure that it's paid the proper amount of 
taxes. 

5) Business analytics : Analyzing invoices can help businesses gather 
information from their customers' buying patterns and identify trends, 
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popular products, peak buying times, and more. This helps to develop 
effective marketing strategies. 

Example : Payment Voucher 

 

4.2.2 Creating Invoice in Excel 

1) Our invoice template is 3 columns wide. Column A: 417 pixels. 
Column B: 70 pixels. Column C: 90 pixels. Click on the right border of a 
column header to change the column width. 
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2) Enter some data. 

 

3) On the Home tab, in the Font group, we can use the different commands 
to change font sizes, font styles, add borders, change background colors, 
etc. 

4) To remove the gridlines, select all cells by clicking on the square above 
row 1 and to the left of column A and change the background color to 
white. 

5) On the Home tab, in the Alignment group, you can use the different 
commands to align text. 
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6) Select the range C13:C32 and change the number format to Accounting. 

7) Enter the TODAY function into cell C4. 

8) Enter the SUM function into cell C32. To achieve this, select cell C32, 
type =SUM(, select the range C13:C31, close with a ")" and press Enter. 
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4.3 Reports  

Reports are financial documents that are integral to the success of any 
business, large or small. Preparing accounting reports allows us to track 
our financial history, project future revenue and have accurate records for 
tax purposes. Many companies create accounting reports monthly and 
some create additional reports for specific purposes. 

4.3.1 Types of Reports 

1) Income statement : It is a report that details overall expenses and 
revenue to determine a company's overall net profit. Sometimes an income 
statement is called a profit-and-loss report.  
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To prepare an income statement, accountants use data from ledgers and 
accounting journals. The statement includes both primary and secondary 
sources of income to get an accurate number. Similarly, primary and 
secondary expenses are included in the income statement. 

2) Cash flow statement : It shows where cash is coming from (cash flow 
sources) and where cash is going (cash flow expenditures). This helps a 
business see how well they are generating cash. Executives and decision-
makers can use this report to see where cash is coming from and then 
where it is going, which could include : Business operations, Financing, 
Investments 

A cash flow statement measures the cash flow between two dates. To 
prepare a cash flow statement, an accountant looks at the cash flow in 
every account, which may include equity accounts, liability accounts, 
expense accounts, revenue accounts and asset accounts. 

3) Balance sheet : It shows an ending balance at one specific point in 
time. It often includes balances for assets, liability and equity. The balance 
sheet gives the business an opportunity to evaluate its financial reserves as 
well as liquid assets. It also helps potential investors or lenders see the 
financial state of the company. 

4.4 Calculation of interest  

Interest refers to the cost of money borrowed from a lender. Usually a 
percentage of the principal amount borrowed, interest can be either simple 
or compound. 

Simple interest = principal * rate * terms;  

 

Compound interest = FV(rate, nper, pmt, pv) 
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Explanation of FV function : FV function calculates compound interest 
and returns the future value of an investment. To configure we need the 
rate, the number of periods, the periodic payment, the present value. 

To get the rate we use annual rate/periods or C6/C8. 

To get the number of periods we use term * periods or C7 * C8. 

There is no periodic payment, so we use 0. 

The present value(pv) is input as a negative value, since $1000 ‘leaves our 
wallet’ and goes to the bank during the term. 

4.5 Calculation of Depreciation 

Depreciation is defined as the reduction of the recorded cost of a fixed 
asset in a systematic manner until the value of the asset becomes zero or 
negligible.  

Excel offers five different depreciation functions.  

We consider an asset with an initial cost of $10,000, a salvage value 
(residual value) of $1000 and a useful life of 10 periods (years). 

1) SLN : The SLN (Straight Line) function is easy. Each year the 
depreciation value is the same. 
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The SLN function performs the following calculation. Depreciation Value 
= (10,000 - 1,000) / 10 = 900.00. If we subtract this value 10 times, the 
asset depreciates from 10,000 to 1000 in 10 years  
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2) SYD : The SYD (Sum of Years' Digits) function is also easy. As we 
can see below, this function also requires the period number. 

 

The SYD function performs the following calculations. A useful life of 10 
years results in a sum of years of 10 + 9 + 8 + 7 + 6 + 5 + 4 + 3 + 2 + 1 = 
55. The asset loses 9000 in value. Depreciation value period 1 = 10/55 * 
9000 = 1,636.36. Deprecation value period 2 = 9/55 * 9000 = 1,472,73, 
etc. If we subtract these values, the asset depreciates from 10,000 to 1000 
in 10 years (figure after SLN) 

4.6 Calculation of TDS  

Tax Deducted at Source or TDS is the amount which is deducted from the 
income of an individual by an authorised deductor and deposited to the IT 
department.  

For example, ABC Pvt Ltd has to make payment of Rs 1,00,000 to Mr. 
XYZ for professional fees. TDS rate specified on professional fee is 10%. 

TDS required to be deducted = 10% on Rs 1,00,000 = Rs 10,000 

Net payment to Mr. XYZ = Gross Amount – TDS Deducted = Rs 1,00,000 
– Rs 10,000 = Rs 90,000 

TDS to be deposited to Government by ABC Pvt Ltd = Rs 10,000 

4.7 Calculation of Salary  

Basic Salary is the base part of the total salary which doesn’t include any 
other allowances. Overtime, bonus, medical allowance, etc. are not part of 
the basic salary. Adding all other allowances to the basic salary comes out 
the total salary received by an employee. So, the basic salary is a fixed 
amount for an employee of a company. 

CTC : CTC means ‘Cost To Company’ which indicates the total amount 
of expenses a company spends on an employee including the Gross Salary 
and all other benefits an employee gets during the service period. 
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Pf : PF (Provident Fund) refers to the amount which is deducted from the 
salary and put away in a PF account. It is designed to ensure enough funds 
are saved to get an employee through retirement adequately. 

Gross salary :  is aggregate of the total amount of pay that an employee 
will get in every month, it includes all the allowances including basic pay.  
The simple definition of gross salary is basic salary plus allowances like 
dearness allowances, house rent allowances, medical allowances, 
conveyance allowances, and special allowances, etc. 

Example to calculate salary from Gross Salary : 

1) Suppose, we have a data set of the Gross Salary of the employers of a 
company and the percentage of Gross Salary which will denote the Basic 
Salary of the employees. 

 

2) Enter formula for salary = gross salary * basic salary percentage or C5 
* D5. 
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3) Click ENTER and the desired output will come. 

 

4) Now we can drag the formula to every cell so that will get the basic 
salary of every employee. 

 

Similarly we can calculate salary from CTC, deducting pf etc. 

4.8 Calculation of Taxes 

In some regions, income tax is taken by the company accountant from 
your income.  

We can keep all details of our income, expenses, and expenditure in an 
Excel worksheet.  

From there we can easily calculate the income tax on the stored data. 

Income tax is a tax taken by the central government on your income 
earned during the financial year. This financial year starts from April 1 
and ends on March 31 every year. 

Income tax is a direct tax imposed on an individual or business, 
Individual's income or business's profit. 

Gross income & taxable income : Gross income is the income coming 
from all the income sources. For example, salary, house rent, FDs, and all, 
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taxable income is extracted from the gross income by excluding 
exemptions and deductions. 

Example : 

1) Open the Excel worksheet that contains the income details of someone. 
We are using the following income dataset. 

 

2) As we want to calculate the taxable income and tax. So, create two 
rows: one for the taxable value and another for the tax. 

 

3) Select a cell where you want to place the calculated result and subtract 
the expenses (exemptions and deduction) from the gross income. Write the 
formula =B2-B3-B4 inside the formula bar and press the Enter key. 
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4) Taxable income is now extracted from gross income, which is 2,19,000. 
"Taxable income is on which we apply the tax." 

 

"Tax is 5% on income below 2,50,000." As the taxable value is between 
1.5 to 2.5 lakhs so that 5% will apply to income. 

5) Now, calculate the tax on extracted taxable value. Apply the following 
formula in cell  

B7: =B6*5/100 
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6) Press the Enter key and get the income tax value calculated on the 
taxable income. See that the returned tax value is 10,950. 

 

Conclusion : Now, for this income, this user needs to pay 10950 rupees as 
the income tax. 

4.9 Calculation of Inventory  

Inventory is basically products, goods, raw material which are not utilized 
by the business and expected to be used. So basically, businesses produce 
goods to sell in the market and the products which are still lying with the 
business are part of the inventory.  

Inventory is part of a company’s balance sheet and is categorized under 
current assets. The reason is that it is expected that it will be sold in the 
coming months. 

If a company has too much inventory, it means that the company is not 
able to sell the products and it can result in cash flow problems and 
eventual losses because inventory will become obsolete.  

On the other hand if it is very less, it means that business is not able to 
cope up with the demand and it can result in loss of clients and businesses.  
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Another key point to keep in mind is that Inventory is reported at its cost 
and not at its selling price. 

Simple Example for inventory calculation  : Let say company A has an 
opening inventory balance of 50,000 for the month of July. During the 
remaining financial year, the company has made purchases amounting 
20,000 and during that time, on the company’s income statement, the cost 
of goods sold is 40,000.  

 

Ending Inventory = Beginning Inventory + Inventory Purchases – 
Cost of Goods Sold 

 

Ending inventory = 50,000 + 20,000 – 40,000 

Ending inventory = 30,000 

4.10 Calculation of Reconciliation  

A bank reconciliation statement (BRS) is a statement of the document 
which measures and compares the cash balance (respective company’s 
balance sheet) to the corresponding amount on the respective bank 
statement. The main purpose to compare those accounts, i.e., to reconcile 
those accounts is to identify whether there is any need for accounting 
changes. 

Bank reconciliation will be measured and closed at the regular interval of 
time.  
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It helps the company or an organization to make sure that all their cash 
records are correct. Thus, it is easy for a company to detect in case of any 
cash manipulation or even fraud. 

In simple words, a bank reconciliation statement (BRS) is a document that 
will be prepared for reconciling the dissimilarities between the balance as 
per the passbook given respective date and cash books bank column. 

Example : Let’s consider a company XYZ. XYZ has a balance as per the 
passbook of $2000 as of 30th April 2021. It has a balance as per the cash 
book as of 30th April 2021 of $2150. Additional details are given below. 

1) A cheque worth $500 was deposited. But it was not collected by the 
bank. 

2) Recorded – $100 as bank charge in the passbook. But it is not recorded 
in the cash book. 

3) $300 cheque worth has been processed and issued. But it is not 
presented for payment. 

4) Recorded – $150 as bank interest in a passbook. But it is not recorded 
in the cash book. 

Solution: 
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Exercise Questions  

Multiple Choice Questions. 

1) The _____________ feature in MS word works just like a regular 
search bar. 

a) Tell me    b) Show tabs    c) Rular  d) Backstage view 

2) By default, word documents are saved in the _____________ file type. 

a) .rtf     b) .docx   c) .txt  d) .pdf  

3) By default, excel documents are saved in the _____________ file type. 

a) .rtf     b) .docx   c) .xls  d) .pdf  

4) ____________ can provide access to websites and email addresses 
directly from documents. 

a) Hyperlink    b) Page size    c) mail merge   d) margin 

5) One of the following is not a type of chart. 

a) Line     b) Bar    c) Area  d) Flash fill 

True or False. 
1) Charts in MS Excel help us to present data in graphical form. 

2) The Ruler is located at the top and to the left of our document. 
3) We cannot change the bullet colors in MS Word. 

4) Widescreen slides work best with monitors & projectors. 

5) Voucher is a document given to the buyer by the seller to collect 
payment. 

Short answer or define. 
1) Mail merge 

2) AutoFill in MS excel 

3) Formulae in MS excel 

4) Conditional formatting 

5) Invoice 

Long answers. 
1) How to create a document in MS Word and save it? 

2) Explain Mail Merge. 

3) How to print documents? 

4) What are features of MS Excel? 

5) How can we create formulas in MS Excel? 
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6) Write a short note on inbuilt functions. 

7) How to create charts in MS Excel? 

8) What are the types of charts? 

9) How to sort & filter data? 

10) Write a short note on conditional formatting in MS Excel. 

11) Write a short note on : 

       a) Calculation of Salary 

`      b) TDS 

       c) Reconciliation & Inventory 

       d) Taxes 

12) Write a short note on Presentations. 

13) How to apply themes in presentations? 

14) Write a short note on transitions. 

15) What are the views of presentations? 

16) How to insert images in slides? 

17) How to apply animations in slides? 

18) Write a short note on vouchers, invoices & reports. 

References : 
1. https://edu.gcfglobal.org/en/ 

2. www.geeksforgeeks.org 

3. www.tutorialspoint.com 

4. www.javatpoint.com 

5. www.udemy.com 

6. www.computerhope.com 

7. www.wikihow.com 

8. www.techonthenet.com 

9. www.investopedia.com 

10. www.wallstreetmojo.com 

11. www.accountingtools.com 

12. www.profitbooks.net 

13. www.zoho.com 

14. www.datapine.com 
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WEB 

Unit Structure 

3.0 Objectives 

3.1 What is Internet? Definition, Uses, Working, Advantages and 
Disadvantages 

3.2 World Wide Web 

3.3 What is Web Browser? 

3.4 Information Searching Tools 

3.5 Downloading 

3.6 Create New email ID 

3.7 Sending Data through email 

3.8 Search Engine Optimisation 

3.9 Exercise Questions  

3.10  References  

3.0 OBJECTIVES 

After studying this chapter you should be able to understand. 

 The difference between Internet and WWW 
 Working and type of web browsers 
 The different searching tools 
 Steps to download data from internet 

3.1 WHAT IS INTERNET? DEFINITION, USES, 
WORKING, ADVANTAGES AND 
DISADVANTAGES 

Internet is the foremost important tool and the prominent resource that is 
being used by almost every person across the globe. It connects millions 
of computers, webpages, websites, and servers. Using the internet we can 
send emails, photos, videos, messages to our loved ones. Or in other 
words, the internet is a widespread interconnected network of computers 
and electronics devices(that support internet). It creates a communication 
medium to share and get information online. If your device is connected to 
the Internet then only you will be able to access all the applications, 
websites, social media apps, and many more services. Internet nowadays 
is considered as the fastest medium for sending and receiving information. 
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Origin Of Internet: The internet came in the year 1960 with the creation 
of the first working model called ARPANET (Advanced Research 
Projects Agency). It allowed multiple computers to work on a single 
network that was their biggest achievement at that time. ARPANET use 
packet switching to communicate multiple computer systems under a 
single network. In October 1969, using ARPANET first message was 
transferred from one computer to another. After that technology continues 
to grow. 

How is the Internet set up? 

The internet is set up with the help of physical optical fiber data 
transmission cables or copper wires and various other networking 
mediums like LAN, WAN, MAN, etc. For accessing the Internet even the 
2g, 3g, and 4g services and the wifi require these physical cable setup to 
access the Internet. There is an authority named ICANN (Internet 
Corporation for Assigned Names and Numbers) located in the USA which 
manages the Internet and protocols related to it like IP addresses. 

How does the internet works? 

The actual working of the internet takes place with the help of clients and 
servers. Here the client is a laptop that is directly connected to the internet 
and servers are the computers connected indirectly to the Internet and they 
are having all the websites stored in those large computers. These servers 
are connected to the internet with the help of ISP (Internet Service 
Providers) and will be identified with the IP address. Each website has its 
Domain name as it is difficult for any person to always remember the long 
numbers or strings. So, whenever you search any domain name in the 
search bar of the browser the request will be sent to the server and that 
server will try to find the IP address from the Domain name because it 
cannot understand the domain name. After getting the IP address the 
server will try to search the IP address of the Domain name in a Huge 
phone directory that in networking is known as a DNS server (Domain 
Name Server). For example, if we have the name of a person and you can 
easily find the Aadhaar number of him/her from the long directory as 
simple as that. 

So after getting the IP address the browser will pass on the further request 
to the respective server and now the server will process the request to 
display the content of the website which the client wants. If you are using 
a wireless medium of Internet like 3g and 4g or other mobile data then the 
data will start flowing from the optical cables and will first reach to towers 
from there the signals will reach your cell phones and Pc’s through 
electromagnetic waves. And if you are using routers then optical fiber 
connecting to your router will help in connecting those light-induced 
signals into electrical signals and with the help of ethernet cables internet 
reaches your computers and hence the required information.  

 

 

mu
no
tes
.in



 

 

Web 

 

215 

What is an IP address? 

IP address stands for internet protocol address. Every PC/Local machine is 
having an IP address and that IP address is provided by the Internet 
Service Providers (ISP’s). These are some sets of rules which govern the 
flow of data whenever a device is connected to the Internet. It 
differentiates computers, websites, and routers. Just like human 
identification cards like Aadhaar cards, Pan cards, or any other unique 
identification documents. Every laptop and desktop has its own unique IP 
address for identification. It’s an important part of internet technology. An 
IP address is displayed as a set of four-digit like 192.154.3.29. Here each 
number on the set ranges from 0 to 255. Hence, the total IP address range 
from 0.0.0.0 to 255.255.255.255.  

You can check the IP address of your Laptop or desktop by clicking on the 
windows start menu ->then right click and go to network ->in that go to 
status and then Properties their you can see the IP address. There are four 
different types of IP addresses are available: 

1. Static IP address 

2. Dynamic IP address 

3. Private IP address 

4. Public IP address 

3.2 WORLD WIDE WEB 

The worldwide web is a collection of all the web pages, web documents 
that you can see on the Internet by searching their URLs (Uniform 
Resource Locator) on the Internet. For example, www.geeksforgeeks.org 
is a URL of the GFG website and all the content of this site like webpages 
and all the web documents are stored on the worldwide web. Or in other 
words, the world wide web is an information retrieval service of the web. 
It provides users a huge array of documents that are connected to each 
other by means of hypertext or hypermedia links. Here, hyperlinks are 
known as electronic connections that link the related data so that users can 
easily access the related information and hypertext allows the user to pick 
a word or phrase from text, and using this keyword or word or phrase can 
access other documents that contain additional information related to that 
word or keyword or phrase. World wide web is a project which is created 
by Timothy Berner’s Lee in 1989, for researchers to work together 
effectively at CERN. It is an organization, named World Wide Web 
Consortium (W3C), which was developed for further development in the 
web. 
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Difference between World Wide Web and Internet 

Internet WWW 

The Internet allows you to link 
your computer to any other 
computer on the planet.  

The World Wide Web is a 
collection of information 
accessible through the Internet. 

The Internet is a worldwide 
network of interconnected 
computer networks that connect 
devices using the TCP/IP 
protocol.  

The World Wide Web refers to 
HTML-formatted online material 
that may be accessed using the 
HTTP protocol. 

The Internet can be compared 
to a large bookstore.  

The web can be considered as a 
store with a collection of books. 

Internet is superset of WWW. The World Wide Web is a subset 
of the Internet. 

It first appeared in the late 
1960s. 

Tim Berners-Lee, an English 
scientist, created the World Wide 
Web in 1989. 

The Internet is mostly based on 
hardware. 

In comparison to the Internet, the 
WWW is more software-oriented. 

 

Uses of the Internet 

Some of the important usages of the internet are: 

1. Online Businesses (E-commerce): Online shopping websites have 
made our life easier, e-commerce sites like Amazon, Flipkart, Myntra are 
providing very spectacular services with just one click and this is a great 
use of the Internet. 

2. Cashless transactions: All the merchandising companies are 
offering services to their customers to pay the bills of the products online 
via various digital payment apps like Paytm, Google pay, etc. UPI 
payment gateway is also increasing day by day. Digital payment industries 
are growing at a rate of 50% every year too because of the INTERNET. 

3. Education: It is the internet facility that provides a whole bunch of 
educational material to everyone through any server across the web. Those 
who are unable to attend physical classes can choose any course from the 
internet and can have the point-to-point knowledge of it just by sitting at 
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home. High-class faculties are teaching online on digital platforms and 
providing quality education to students with the help of the Internet. 

4. Social Networking: The purpose of social networking sites and 
apps is to connect people all over the world. With the help of social 
networking sites, we can talk, share videos, images with our loved ones 
when they are far away from us. Also, we can create groups for discussion 
or for meetings. 

5. Entertainment: The Internet is also used for entertainment. There 
are numerous entertainment options available on the internet like watching 
movies, playing games, listening to music, etc. You can also download 
movies, games, songs, TV Serial, etc., easily from the internet. 

 Advantages of the Internet 

1. Online Banking and Transaction: The Internet allows us to 
transfer money online by the net banking system. Money can be credited 
or Debited from one account to the other. 

2. Education, online jobs, freelancing: Through the Internet, we are 
able to get more jobs via online platforms like Linkedin and to reach more 
job providers. Freelancing on the other hand has helped the youth to earn a 
side income and the best part is all this can be done via INTERNET. 

3. Entertainment: There are numerous options of entertainment online 
we can listen to music, play games can watch movies, web series, listening 
to podcasts, youtube itself is a hub of knowledge as well as entertainment. 

4. New Job roles: The Internet has given us access to social media, 
and digital products so we are having numerous new job opportunities like 
digital marketing and social media marketing online businesses are 
earning huge amounts of money just because the internet being the 
medium to help us to do so. 

5. Best Communication Medium: The communication barrier has 
been removed from the Internet. You can send messages via email, 
Whatsapp, and Facebook. Voice chatting and video conferencing are also 
available to help you to do important meetings online. 

6. Comfort to humans: Without putting any physical effort you can 
do so many things like shopping online it can be anything from 
stationeries to clothes, books to personal items, etc. You can books train 
and plane tickets online. 

7. GPS Tracking and google maps: Yet another advantage of the 
internet is that you are able to find any road in any direction, areas with 
less traffic with the help of GPS in your mobile. 

Disadvantages of the Internet 

1. Time wastage: Wasting too much time on the internet surfing on 
social media apps and doing nothing decreases your productivity rather 
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than wasting time on scrolling social media apps one should utilize that 
time in doing something skillful and even more productive. 

2. Bad impacts on health: Spending too much time on the internet 
causes bad impacts on your health physical body needs some outdoor 
games exercise and many more things. Looking at the screen for a longer 
duration causes serious impacts on the eyes. 

3. Cyber Crimes: Cyberbullying, spam, viruses, hacking, and stealing 
data are some of the crimes which are on the verge these days. Your 
system which contains all the confidential data can be easily hacked by 
cybercriminals. 

4. Effects on children: Small children are heavily addicted to the 
Internet watching movies, games all the time is not good for their overall 
personality as well as social development. 

5. Bullying and spreading negativity: The Internet has given a free 
tool in the form of social media apps to all those people who always try to 
spread negativity with very revolting and shameful messages and try to 
bully each other which is wrong. 

Can You Use the Web Without the Internet? 

It's not really possible to browse the web without using the internet. To 
access a web resource (like a website) that's on another server, you have to 
use the internet to connect to it. Otherwise, your device has no connection 
to the network that the other device is on. 

The Web is distinguished from other systems by its use of HTTP 
(Hypertext Transfer Protocol), which in turn is just a system for 
standardizing the use of HTML (HyperText Markup Language). HTML is 
the language of the Web, and HTTP is the grammar rules for using it. In 
the same way that English is the language of business or French the 
language of love, HTML is the language of the Web. 

Accessing the Web requires a Web browser (like Internet Explorer, 
Chrome,  Safari or Firefox) to make sense of HTML and allow Web pages 
to display properly. 

3.3 WHAT IS WEB BROWSER? 

Web Browsers are software installed on your PC. To access the Web, you 
need a web browser, such as Netscape Navigator, Microsoft Internet 
Explorer or Mozilla Firefox. 

On the Web, when you navigate through pages of information, this is 
commonly known as web browsing or web surfing. 

There are some leading web browsers − Edge, Chrome, Firefox, and 
Safari, but there are many others browsers available. 
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Internet Explorer 

Internet Explorer (IE) is a product from software giant Microsoft. This is 
the most commonly used browser in the universe. This was introduced in 
1995 along with Windows 95 launch and it has passed Netscape 
popularity in 1998. 

Google Chrome 

This web browser is developed by Google and its beta version was first 
released on September 2, 2008 for Microsoft Windows. Today, chrome is 
known to be one of the most popular web browsers with its global share of 
more than 50%. 

Mozilla Firefox 

Firefox is a new browser derived from Mozilla. It was released in 2004 
and has grown to be the second most popular browser on the Internet. 

Safari 

Safari is a web browser developed by Apple Inc. and included in Mac OS 
X. It was first released as a public beta in January 2003. Safari has very 
good support for latest technologies like XHTML, CSS2 etc. 

Opera 

Opera is smaller and faster than most other browsers, yet it is full- 
featured. Fast, user-friendly, with keyboard interface, multiple windows, 
zoom functions, and more. Java and non Java-enabled versions available. 
Ideal for newcomers to the Internet, school children, handicap and as a 
front-end for CD-Rom and kiosks. 

Konqueror 

Konqueror is an Open Source web browser with HTML 4.01 compliance, 
supporting Java applets, JavaScript, CSS 1, CSS 2.1, as well as Netscape 
plugins. This works as a file manager as well as it supports basic file 
management on local UNIX filesystems, from simple cut/copy and paste 
operations to advanced remote and local network file browsing 

What is a Web browser? [Definition] 

A web browser is basically a client program that connects with 
the webserver for any information as per the request of the user. After the 
request is received the webserver circulates the data back to the browser 
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and later it displays the results on the screen of the user. In the 
background, the browser sends a request to the Web servers all across the 
internet by using HTTP - Hypertext Transfer Protocol. 

Features of Web Browser 

These are most common features of web browsers.  

1. Home button: The home button helps you to go to the predefined 
homepage of any website. 

2. Refresh button: You can reload the web pages of any website by 
using the refresh button. At times due to the caching mechanism, you are 
unable to know the updated information. In such cases, when you hit the 
refresh button, you are able to see that particular information. 

3. Stop button: if you wish to disconnect the connection between 
the web browser and the server you can use the stop button. For instance, 
if there is any outside attack of malicious content on the browser, you can 
protect yourself with the help of this button. 

4. Web address bar: the space where you enter any web address is 
known as the web address bar. 

5. Bookmarks: bookmarks help you to save a particular website on 
your device for later use.  

6. Tabbed browsing: you can access multiple websites in a single 
window with the help of tabbed browsing. For instance, whenever you 
search for a topic on your browser, you get a list of options in front of you. 
You can open several tabs by clicking right on every link. This is tabbed 
browsing. 

What is URL? 

Every website has a unique address that is known as a uniform resource 
locator or URL. It is like the address of your house, but instead of land, it 
is on the internet. Whenever you type any URL in the address bar of the 
browser and hit enter, the browser redirects you to the page tagged along 
with that URL. For instance, www.abc.com. 

A URL consists of the following: 

● To access any resource, it uses the HTTP protocol. 

● A fragment identifier is used. 

● It defines the location of any server with the help of IP addresses. 

History of Web Browsers 

The first-ever web browser was WORLD WIDE WEB, developed by Tim 
Berners-Lee in the year 1990. After two years, a text-based browser 
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named the Lynx browser was launched. It had several limitations, for 
instance, it was unable to display the graphical content. 

Moving forward, in the year 1993, the first popular browser in the world 
was introduced known as Mosaic. After improvising a few aspects, 
Netscape Navigator came into the picture, in the year 1994. Then came the 
Internet Explorer, launched by the tech giant Microsoft, in the year 1995. 

A few years later in 2003, Apple launched its own browser known as 
Safari, specially built for Mac computers. Later in 2004, Mozilla launched 
Firefox. In 2008, the most popular browser of today, Google Chrome was 
invented. After that, Opera Mini, a mobile-based browser, was released in 
2011. In 2015, the Microsoft Edge browser entered the market. 

Different types of web browser 

There is an ample list of web browsers available for your use, but the most 
common ones are here with an elaborated explanation. For instance, 
Internet Explorer, Mozilla Firefox, Google Chrome, Safari, and Microsoft 
Edge. 

1. Internet Explorer 

The software giant Microsoft launched this product back in 1995. Internet 
Explorer ruled the market at one time. It was one of the most popularly 
used web browsers. 

Features :  

i. Smart search suggestion 

ii. Enhanced performance 

iii. 33 language support 

iv. Reader mood to view a webpage 

Microsoft has currently discontinued Internet Explorer. 

2. Mozilla Firefox 

Mozilla Firefox has managed to be on the list of most popular browsers 
over the internet. It was launched in 2004. You can avail of this web 
browser on Windows, Mac, as well as Linux operating systems.  

Features : 

i. High security and performance 

ii. Fast page loading 

iii. 75 language support 

iv. Inbuilt download manager 

v. Backed by a gecko engine 
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3. Google Chrome 

Google Chrome is a web browser that has brought a tremendous 
revolution in the history of web browsers. At present, it is the most widely 
used browser. It is known for its strong browser performance. 

Features : 

i. Theme support 

ii. Extremely fast and secure 

iii. Fast page loading 

iv. 50 language support 

v. Incognito mode and new tabs 

4. Safari 

Apple Inc. invented this web browser. By default, this web browser is 
present on all Apple devices. Safari supports the latest technologies like 
XHTML, CSS2, etc.  

Features : 

i. Smart address bar 

ii. Full-screen video and geolocation 

iii. Extended support for HTML5 

iv. Tabbed browsing  

v. Private browsing 

5. Microsoft Edge 

Microsoft Edge was invented by the tech giant Microsoft in 2015. It 
replaced internet explorer as the default web browser on all its devices. 
Features : 

1) Implementation of Cortana 

2) Reading view 

3) Doodle on a web page 

4) Integrated share panel 

5) Newsfeed on the startup page 

6. Opera 

Opera is a powerfully packed full-featured web browser. It is smaller than 
other competitors. This browser is designed majorly for mobile phones or 

mu
no
tes
.in



 

 

Web 

 

223 

smartphones. It uses the Java ME platform which is ideal for everyone as 
it is user-friendly and fast. 

7. Netscape Navigator 

Netscape Navigator was released in 1994 by Netscape. Once internet 
explorer hit the market, the usage of Netscape sharply decreased. 

8. Tor browser 

Tor works on the concept of onion routing. Onion routing has nested 
layers that are responsible to encrypt data multiple times.  

Features : 

i. Cross-platform availability 

ii. Anonymous usage of servers 

iii. You can visit locked websites 

iv. Does not reveal the IP of the source 

v. Portable 

3.4 Information Searching Tools 

Internet has in offer a variety of search tools such as search engines, 
search directories to locate the information on web. 

A search on web is a simple process and can be conducted by simply 
issuing a query to the search tool. The search tool in return will look for 
the information in its web based information databases and retrieves those, 
which are relevant to the query. Searching is an iterative process i.e. one 
needs to keep working on their query unless the exact information is 
located. 

The very first tool used for searching on the Internet was Archie. The 
name stands for “archive” without the “v.” It was created in 1990 by Alan 
Emtage, a student at McGill University in Montreal. Veronica (Very Easy 
Rodent-Oriented Net-wide Index to Computerised Archives) and Jughead 
(Jonsy’s Universal Gopher Hierarchy Excavation And Display) were two 
other popular search programs. 

There are three basic types of search tools that most people use to find 
what they are looking for on the Web: Search Engines, Subject Directories 
and Meta Search Tools. 

SEARCH ENGINES 

Search engine is a tool for locating information from a collection. Search 
engines uses information about the information (such as metadata, 
catalogue) stored in the database to locate information. Sometimes they 
perform full text search within the document from first character to last 
character. 
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The search is done on pattern matching algorithm whether it is a database 
or full text. 

TYPES OF SEARCH TOOLS 

� Search Directory 

Search directories are classified collections of documents. They are good 
for searching with a context. These directories are good for browsing. In 
subject directories, documents are pre classified by a person. Librarians’ 
Internet Index; Google Directory; Yahoo!; dmoz are some of the examples 
of subject directories. 

There are two basic types of directories: 

❖ Academic and Professional Directories: These are often created and 
maintained by subject experts to support the needs of researchers. 
INFOMINE, from the University of California, is a good example of an 
academic directory. 

❖ Commercial Directories: These cater to the needs of general public. 
Directories of Yahoo! and Google are examples of commercial directories. 

� Search Engines 

World Wide Web is a network of several information databases. In recent 
years, an exponential growth in these databases has made it difficult to 
locate a particular piece of information. Internet offers a powerful tool 
known as search engine to manage, filter and retrieve the information for 
their users. 

Search engines are automated tools for searching information from a 
collection using metadata stored in the database of search engine. In other 
words, it is an information retrieval system and assists in locating 
information on web. 

Google and Yahoo! are most popular search engines. 

� Meta-search Engines 

Meta Search engines are online tools (search engines) which performs 
simultaneous search on more than one search engine at a time. These 
search engines aggregates the results into a single list and displays them 
according to their source. e.g. Dogpile is a metasearch engine and gets its 
results from Google, Yahoo, MSN Search, Ask , About, MIVA, 
LookSmart, and more. 

Example: Dogpile, WebCrawler, Browsys 

FEATURES OF SEARCH TOOLS 

The searching tools follows pattern matching algorithm. There are many 
types of searches can be done using search tools. Some searching types 
given below. 
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� Keyword Search 

When searching is done using a keyword it is known as Keyword 
searching. Keyword may occur at any place in the document or in the 
metadata field. This kind of search has higher recall value. 

� Boolean Search 

Logical AND, OR and NOT are known as Boolean operators. When 
Boolean operators are used for searching it is known as Boolean search. 
The operators are used for combining more than one word with certain 
conditions. These kind of searching also known as Combinatorial search. 

❖ AND 

This operator will retrieve all the documents which contains all the 
keywords occurring at both ends of the AND operator. 

Syntax: <Search Term A> AND <Search Term B> 

Example: Library AND Information 

Output: 

1) The above query will retrieve only those documents which contains 
both the terms 

Library and Documentation 

2) The precision in search is more. The number of documents retrieved 
will be less hence less is the recall value. 

❖ OR 

This operator will retrieve all the documents which contains all the 
keywords occurring at both ends of the OR operator. 

Syntax: <Search Term A> OR <Search Term B> 

Example: Library OR Information 

Output: 

1) The above query will retrieve all documents which contains both the 
terms Library and Documentation 

2) The recall in search is more. The number of documents retrieved will be 
more but the precision in retrieved documents will be less. 

❖ NOT or AND NOT 

These operators increase the precision of the search result. The query can 
be made more specific by using these operators. Using the capitalised 
AND NOT operator preceding a search term eliminates documents that 
contain that term. 
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Syntax 

<Words to be searched> AND NOT <Words not to be searched> 

Example: 

If user is looking for information on Drivers and do not want documents 
that include information relating to the Screw Drivers the query could be 
“Driver” AND NOT Screw. 

Search Engine Components  

Generally there are three basic components of a search engine as listed 
below:  

� Web Crawler  

� Database  

� Search Interfaces  

� Web crawler  

It is also known as spider or bots. It is a software component that traverses 
the web to gather information.  

� Database  

All the information on the web is stored in database. It consists of huge 
web resources. 

� Search Interfaces  

This component is an interface between user and the database. It helps the 
user to search through the database.  

Search Engine Working  

Web crawler, database and the search interface are the major component 
of a search engine that actually makes search engine to work. Search 
engines make use of Boolean expression AND, OR, NOT to restrict and 
widen the results of a search. Following are the steps that are performed 
by the search engine:  

● The search engine looks for the keyword in the index for predefined 
database instead of going directly to the web to search for the keyword.  

● It then uses software to search for the information in the database. 
This software component is known as web crawler.  

● Once web crawler finds the pages, the search engine then shows the 
relevant web pages as a result. These retrieved web pages generally 
include title of page, size of text portion, first several sentences etc. 

● User can click on any of the search results to open it. 
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Architecture and Main components of Standard Search Engine Model 

 

Following are the several search engines available today: 

Search Engine Description 

Google It was originally called BackRub. It is the most popular 
search engine globally. 

Bing It was launched in 2009 by Microsoft. It is the latest web-
based search engine that also delivers Yahoo’s results. 

Ask It was launched in 1996 and was originally known as Ask 
Jeeves. It includes support for match, dictionary, and 
conversation question. 

AltaVista It was launched by Digital Equipment Corporation in 
1995. Since 2003, it is powered by Yahoo technology. 

AOL.Search It is powered by Google. 

LYCOS It is top 5 internet portal and 13th largest online property 
according to Media Matrix. 

Alexa It is subsidiary of Amazon and used for providing website 
traffic information. 
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3.5 DOWNLOADING 

What is downloading? 

Downloading is the transmission of a file or data from one computer to 
another over a network, usually from a larger server to a user device. 
Download can refer to the general transfer of data or to transferring a 
specific file. It can also be called to download, DL or D/L. 

All internet use requires downloading data. While browsing websites or 
using apps, the computer or mobile device is downloading data. This data 
could be the text, images or videos used on the pages or apps that users 
visit. Most of this data is only kept for long enough for it to be used once 
and then removed from the device. 

When users want to keep the data on their device, they download the data 
to it. This could be a file, document or app that they want to keep 
permanently. When they download it, users make a copy of the data from 
what is on the central computer, called the server. 

In general use, the word download is used for both the process of copying 
the data and for the resulting file. Download is also mostly used in the 
context of copying data from a larger central server. While not a hard-and-
fast rule, if the data is moving between two peer client devices or between 
two pieces of local data storage, such as from a compact disc to a hard 
disk drive, it would be called transferring data and not downloading. 

Taking data or a file from a client device and copying it to a server is 
called an upload. 

What is download speed? 

Download speed is a measure of how much data can be transferred from 
an arbitrary internet location to a user's device in a second. It is typically 
measured in megabits per second (Mbps). The higher the number, the 
faster the connection. The maximum capacity to transfer data of a wired or 
wireless network in a certain amount of time is referred to as bandwidth. 

For most home or personal internet connections, the upload speed is lower 
than the download. This is because, for most people, they need to 
download far more data than they need to upload, so downloads are 
prioritized by the internet service provider (ISP). Businesses may benefit 
from having the same upload speed as their download; this is called 
having a symmetrical internet connection. 

An ISP will advertise the fastest possible theoretical download speed, but 
many factors can affect real-world download speed. Older home 
networking or Wi-Fi routers may not be able to provide fast enough 
connections to support modern internet connections. Poor cellphone or 
Wi-Fi signal strength also results in slow downloads. In addition, the 
speed of the server that users are downloading from may not be especially 
fast. 
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For example, large companies have many servers with exceptionally fast 
internet connections that can support many devices downloading at high 
speed simultaneously. But smaller companies may only have one server 
that is easily overwhelmed by many people trying to download something, 
and the resulting download is slow. 

What is the difference between download, cache and stream? 

When transferring a file to a device, such as for music or a video, users 
may have the option to download, cache or stream it. While there is not a 
hard-and-fast rule for how different companies use these terms, in general, 
a download is a permanent copy, a cache is a temporary copy and a stream 
is only copied as it is used. 

To download the data means to have a permanent copy. The full data is 
kept on a local device. Usually, end users manage the copy and have 
access to use it as much as they want. They may be able to copy it to 
another device. An example download would be to save a copy of a 
document to a device so it is always available. 

A cached copy is generally a whole copy that is on the device, but it is 
managed by the program and not the user. It may not be complete and may 
require that the service be contacted before it can be used again. The 
program decides how long the cache copy will exist and may delete it as 
needed. Having cached data is beneficial because less data needs to be 
transferred and it makes the content available faster. Usually, the user will 
not be able to use the data outside the program. An example of a cache 
would be a music service having a cache so the songs don't need to 
transfer data each time they are played or so that they can be available for 
offline playback. 

A streamed copy is when the data is only sent to the device just before it 
is needed and is not kept after it has been used. This is most often used for 
music and movies. Often, only a few moments ahead of what is being 
viewed is sent to the end-user device. The data is kept in a temporary 
buffer before it is shown. Once the content is finished, the data is deleted. 
If the person wants to view it again, another copy needs to be streamed 
from the server. An example of a stream is when an online video service 
sends the video data as it is needed, but if the internet is removed, the 
stream ends. 

Ways to download 

There are a variety of ways to download data, including the following. 

1. Hypertext Transfer Protocol (HTTP) downloads use the same 
protocol as browsing websites to send the file data. It is the most popular 
way to download files from the internet. All web browsers use this to 
download files directly. HTTP does not support pausing or resuming 
failed downloads natively. 

mu
no
tes
.in



  

 

Information Technology 
in Accountancy - I 

230 

2. File Transfer Protocol (FTP) is one of the oldest protocols for 
downloading files. It is used by a dedicated program to log on to an FTP 
server to browse and download. It can be used with passwords and be 
encrypted by using FTP Secure. 

3. Peer-to-peer (P2P) downloads use special clients and protocols to send 
and receive files without a central host. A popular P2P protocol is 
BitTorrent. 

Download an app, file, or program from the Internet 

How to download on a computer using different browsers ? 

1) To initiate a download from a website, you must first click a 
download link. A link is usually denoted by different-colored text with an 
underline, but it may also be an icon or button. 

2) After clicking a file link, the browser starts the download or asks 
what to do, depending on the browser you're using. 

Below is additional information on how each modern browser handles 
downloads. 

✔ Google Chrome 

1) After the download is completed, a prompt appears in the lower-left 
corner of the browser window. 

 

2) Click the downloaded file to open it. 

✔ Mozilla Firefox 

1) After the download has completed, a prompt appears in the center of 
the browser window. Click Save File and select where to save the file on 
your computer. 
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2) After the file is saved, click the downloads progress   icon in the 
upper-right corner of the browser window, and then click the downloaded 
file to open it. 

 

Alternatively, press Ctrl+J to open the Downloads section of the Library. 

3) In the Library window, double-click the downloaded file to open it. 

 

✔ Internet Explorer 

1) After the download is completed, a prompt appears at the bottom of 
the browser window in the middle. Choose Run or Save to open the 
downloaded media. 
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2) Press Ctrl+J to view your downloads. 

 

3) Click Run to open any of the downloaded files. 

✔ Microsoft Edge 

1) After the download has completed, press Ctrl+J to view your recent 
downloads. 

 

2) Click the downloaded file to open it. 

✔ Opera 

1) After clicking a download link, you are prompted to choose a 
location where the file should be saved. Select a location and click Save. 
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2) When the download completes, press Ctrl+J to view your recent 
downloads. 

3) In the window that appears, locate your downloaded file and click 
the Run button to open it. 

 

✔ Safari 

1) Upon clicking a download link, you may be asked if you want to 
allow downloads from the website. Click Allow. 

 

2) After the download has completed, click the Downloads app in the 
Dock, usually located next to the Trash app, to view your downloads. 

 

3) Double-click the downloaded file to open it. 

How to download on a smartphone or tablet ? 
Depending on the type of phone or tablet follow the instructions given 
below. 

✔ Android phone or tablet 
1) Open the Chrome browser. 

2) Navigate to a web page containing a file you want to download. 
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3) Tap and hold your finger on the file's download link until a menu of 
options appears, then release your finger. 

4) Tap the Download link or Download image option in the menu. 

5) If necessary, tap the Download option again, which may be required 
for some files to complete the download. 

6) Open the Downloads or My Files app on your Android phone to 
view the downloaded files. 

✔ iPhone or iPad 
1) Open the Safari browser. 

2) Navigate to a web page containing a file you want to download. 

3) Tap and hold your finger on the file's download link until a menu of 
options appears, then release your finger. 

4) Tap the Download Linked File option in the menu. 

5) If a small window appears asking if you want to download the file, 
tap Download. 

6) To view the downloaded files, click the blue circle icon with a down-
pointing arrow inside, located to the right of the address bar. 

7) A list of downloaded files is displayed. If compatible with the 
iPhone, you can tap a file name to view it or execute the file. 

3.6 CREATE NEW EMAIL ID 

What is an Email Address? 

An email address is the identification of an electronic mailbox. It has two 
parts, namely, a local part and the domain. The local part usually contains 
the username of the user while the domain name depends on what email 
service provider you are using. The local part can contain words, numbers, 
or periods while the domain name depends on what kind of service 
provider you are using. 
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 The topmost popular email providers are: 

● G-mail 

● Yahoo Mail 

● Microsoft Outlook 

● GMX Mail 

● Zoho Mail 

● iCloud 

● AOL Mail 

● ProtonMail 

Here we will be talking about Gmail which is the most used email service. 
It provides 15 GB of free storage. Each email sent can be of max 25 MB 
size, including attachments. Attachment includes documents, photos, and 
videos. If the total attachment size is more than 25 MB then they get 
uploaded to Google drive then their link is generated and gets written in 
the message.  

How to create your Email Address? 

Step 1: Open Google Chrome on your desktop. Click on Gmail at the top 
right corner under the bookmarks bar. 

Step 2: Click on “Create Account“. 

Step 3: Fill in the credentials and click “Next“. 

Step 4: Provide your mobile number and click on “Next“. 

Step 5: Enter the verification code sent on the number provided. Click on 
“Verify“. 

Step 6: Fill in the details. Click on “Next“. 

Step 7: Click on “Yes, I’m in“. 

Step 8: Your email ID is now ready to use. 

3.7 Sending Data through email. 

Taking Gmail for reference : 

On Desktop / Laptop 

1.Open Gmail. Go to https://www.gmail.com/ in your computer's web 
browser. This will open your Gmail inbox if you're logged in. 

● If you aren't logged into your Gmail account, enter your email 
address and password when prompted. 
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2. Click  “Compose”. It's in the upper-left side of your Gmail inbox. 
Doing so opens a "New Message" window in the lower-right corner of the 
page. 

● If you're using the old version of Gmail, you'll click  COMPOSE 
 here instead. 

 

3. Enter the other person's email address. Click the "To" or 
"Recipients" text box at the top of the New Message window, then type in 
the email address of the person to whom you want to send your email. 

● To add multiple email addresses, type in the first email address, 
press Tab ↹, and repeat with the other email addresses. 

● If you want to CC or BCC someone on the email, click either the Cc 
link or the Bcc link in the far-right side of the "To" text field, then type the 
email address you want to CC or BCC into the "Cc" or "Bcc" text field, 
respectively. 
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4. Add a subject. Click the "Subject" text field, then type in whatever 
you want the subject of the email to be. 

● Typically speaking, an email subject describes the gist of the email's 
message in a few words. 
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5. Enter your email message. In the large text box below the 
"Subject" text box, type in whatever you want for your email message. 

 

6. Format your email's text if needed. If you want to apply 
formatting to your text (e.g., bolding, italics, or bullet points), highlight 
the text to which you want to apply the formatting, then click one of the 
formatting options at the bottom of the email window. 

● For example, to bold a section of text, you would highlight the text 
and then click B at the bottom of the email. 

 

7. Attach a file if you like. To add a file from your computer, click the 
"Attachments" pin icon at the bottom of the window, then select the file(s) 
you want to upload and click Open (or Choose on a Mac). 
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● You can add photos in this way, or you can upload photos directly to 
the email's body by clicking the "Photos" icon at the bottom of the 
window, clicking Upload, clicking Choose photos to upload, and 
selecting photos as needed. 

 

 

8. Click Send. It's a blue button in the bottom-left corner of the email 
window. Doing so will send your email to the specified email address(es). 
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On Mobile 

1. Open Gmail. Tap the Gmail app icon, which resembles a red "M" 
on a white background. This will open your Gmail inbox if you're logged 
in. 

● If you aren't logged in, select your account and/or enter your email 
address and password to log in. 

 

2. Tap the "Compose" icon. It's in the bottom-right corner of the 
screen. Doing so brings up a new message window. 

 

 
3. Enter an email address. Tap the "To" text box, then type in the email 
address of the person to whom you want to send an email. 
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● If you want to CC or BCC anyone on the email, tap  on the far-
right side of the "To" text box, tap either Cc or Bcc, and type in the email 
address you want to use. 

 

 
4. Enter a subject. Tap the "Subject" text box, then enter the subject you 
want to use. 

● Generally, a subject summarizes the email in a few words. 
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5. Enter your email's message. Tap the "Compose email" text box, then 
type in whatever you want to use for your email. 

 

6.Add files or photos if necessary. If you want to place a file or photo in 
your email, do the following: 

● Tap  at the top of the screen. 

● Tap Camera roll (iPhone) or Attach file (Android). 

● Select the photo or file you want to use. 
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7. Tap the "Send"   icon. It's a paper plane-shaped icon in the top-
right corner of the screen. Your email will be sent. 

 

3.8 SEARCH ENGINE OPTIMISATION. 

Search engine optimization (SEO) is the process of improving the ranking 
(visibility) of a website in search engines. The higher (or more frequently) 
a website is displayed in a search engine list (like Google), the more 
visitors it is expected to receive. 

SEO considers how search engines work, what people search for, and 
which search terms (words) are typed. Optimizing a website may involve 
editing the content to increase its relevance to specific keywords. 
Promoting a site to increase the number of links, is another SEO tactic. 

Effective search engine optimization may require changes to the HTML 
source code of a site and to the site content. SEO tactics should be 
incorporated into the website development and especially into the menus 
and navigation structure. 

Why is SEO important? 

1. To help gain more visitors: majority of users click on only the top 
4-5 web pages appearing in search results, so it’s very important for a 
website to appear in the top results of a search engine. 

2. Important for social promotion of a website: if a website appears 
in top results of a search engine such as Google, Bing, etc. then it gains 
instant popularity and to some extent trust of a user. 

3. It plays an important role in improving the business of a 
commercial site: if two websites are selling the same product, for 
example, both Myntra and Koovs focus on selling fashion clothing, then 
the site having a better position in the search result of a search engine has 
chances of getting more users as compared to the other. 
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4. Improving user experience: SEO doesn’t focus only on improving 
search results but also on improving the user experience and usability of a 
website so that a website is more appealing to a user. 

Basic principles in the working of a Search Engine 

Following are majority steps involved in the working of a search engine: 

1. Crawling: Process of fetching all the web pages linked to a website. 
This task is performed by a software, called a crawler or a spider (or 
Googlebot, in the case of Google). 

2. Indexing: Process of creating index for all the fetched web pages 
and keeping them into a giant database from where it can later be 
retrieved. Essentially, the process of indexing is identifying the words and 
expressions that best describe the page and assigning the page to particular 
keywords. 

3. Processing: When a search request comes, the search engine 
processes it, i.e. it compares the search string in the search request with the 
indexed pages in the database. 

4. Calculating Relevancy: It is likely that more than one page 
contains the search string, so the search engine starts calculating the 
relevancy of each of the pages in its index to the search string. 

5. Retrieving Results: The last step in search engine activities is 
retrieving the best matched results. Basically, it is nothing more than 
simply displaying them in the browser. 

3.9 EXERCISE QUESTIONS  

Multiple Choice Questions. 

1) The ______________ is a collection of all the web pages, web 
documents that you can see on the Internet by searching their URLs on the 
Internet.  

a) worldwide web b) IP address c) Internet  d) SEO 

2) The Internet cannot be used for one of the following. 

a) social networking b) transactions c) education d) raining 

3) Chrome is a web browser developed by ____________. 

a) Google  b) Mozilla  c) Apple  d) Microsoft 

4) All the information on the web is stored in ______________. 

a) database  b) hard disk  c) pendrive  d) SSD 

5) Download speed is measured in _________. 

a) mbps  b) gbps  c) kbps  d) tbps 

mu
no
tes
.in



 

 

Web 

 

245 

True or False. 

1) IP address is provided by the Internet Service Providers. 

2) The Internet is a subset of WWW. 

3) Safari is a web browser developed by google. 

4) Downloading is the transmission of a file or data from one computer to 
another over a network. 

5) FTP is a protocol for browsing the data. 

Define or short answer. 

1) IP address 

2) Web browser 

3) URL 

4) Search Engine 

5) Web crawler 

Long answer. 

1) What are the advantages & disadvantages of the internet? 

2) What is meant by email address and how to create it? 

3) Write a short note on Search engine optimization. 

4) Explain basic principles in search engines. 

5) What are different types of web browsers? 
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4 
INTRODUCTION TO INTERNET AND 
OTHER EMERGING TECHNOLOGIES 
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4.7 Electronic Payment Systems 
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4.9 Legal Issues 

4.10 Other emerging technologies 

4.11 Multiple Choice Questions. 

4.12 References  

4.0 OBJECTIVES 

After studying this chapter you should be able to understand 

● The basic of internet and its components 

● The use of ecommerce and security and risk associated with it 

● The importance of Electronic Data Interchange 

● The working of Electronic Payment System 

4.1 INTRODUCTION 

The Internet is at once a world-wide broadcasting capability, a mechanism 
for information dissemination, and a medium for collaboration and 
interaction between individuals through computers irrespective of 
geographic locations. 
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The Internet is a global network of computers that allows people to send 
email, view web sites, download files such as mp3 and images, chat, post 
messages on newsgroups and forums and much more. 

The Internet was created by the Advanced Research Projects Agency 
(ARPA) of the U.S. government in 1960's and was first known as the 
ARPANet. At this stage the Internet's first computers were at academic 
and government institutions and were mainly used for accessing files and 
to send emails. From 1983 onwards the Internet as we know it today 
started to form with the introduction of the communication protocol 
TCP/IP to ARPANet. Since 1983 the Internet has accommodated a lot of 
changes and continues to keep developing. The last two decades has seen 
the Internet accommodate such things as network LANs and ATM and 
frame switched services. The Internet continues to evolve with it 
becoming available on mobile phones and pagers and possibly on 
televisions in the future. 

4.2 INTERNET COMPONENTS 

There are three basic components of the internet. 

1. Client : The data interaction primarily occurs between the client and 
the server. The client requests data from the server. The client and server 
may be situated very far from each other but are linked via a network. 

2. Server : The main job of a server is to respond to the request of the 
client. The device or programme is set up in the way that they provide the 
appropriate information to the client. This functionality of client and 
server works on a model called – call and response. The server performs 
several tasks in order to deliver the right information for each request. 
From investigating the client’s permission of data access to formatting 
numerous responses in order to fetch the most accurate information, the 
server performs so many functions within seconds. 

3. Protocols : In the language of networking, protocols can be defined 
as a set of rules that guide data transmission between computing devices. 
These rules make sure that the data request is sent and received by the 
client without any problem. The most important internet protocols are – 
Transmission Control Protocol (TCP) and Internet Protocol (IP). 

Every single commuting device has its own unique IP address. These 
unique addresses make it easier for computers to recognize each other. 
The TCP/IP protocols make the data request and receiving possible 
between two computers via server. 

4.3 ELECTRONIC COMMERCE 

Electronic commerce or e-commerce has been defined as the ability to 
perform transactions involving the exchange of goods or services between 
two or more parties using electronic tools and technique. Consumers can 
easily buy products or services like magazines and airlines tickets via 
Internet. 
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E-commerce uses key standards and technologies including Electronic 
Data Interchange (EDI), Technical Data Interchange (TDI), Hypertext 
Markup Language (HTML), Extensible Mark-up Language (XML), and 
the Standard for Exchange of Product model data (STEP). E-commerce is 
made possible through the expanded technologies of the Internet, the 
World Wide Web, and Value-Added Networks. 

E-commerce transaction model can be in terms of business to business 
(B2B), business to customer (B2C) or customer to customer (C2C). 

4.4 E-COMMERCE APPLICATIONS 

Most Common Applications of Ecommerce: 

1.  Retail and Wholesale 

Ecommerce has numerous applications in this sector. E-retailing is 
basically a B2C, and in some cases, a B2B sale of goods and services 
through online stores designed using virtual shopping carts and electronic 
catalogs. A subset of retail ecommerce is m-commerce, or mobile 
commerce, wherein a consumer purchases goods and services using their 
mobile device through the mobile optimized site of the retailer. These 
retailers use the E-payment method: they accept payment through credit or 
debit cards, online wallets or internet banking, without printing paper 
invoices or receipts. 

2. Online Marketing 

This refers to the gathering of data about consumer behaviors, preferences, 
needs, buying patterns and so on. It helps marketing activities like fixing 
price, negotiating, enhancing product features, and building strong 
customer relationships as this data can be leveraged to provide customers 
a tailored and enhanced purchase experience. 

3. Finance 

Banks and other financial institutions are using e-commerce to a 
significant extent. Customers can check account balances, transfer money 
to other accounts held by them or others, pay bills through internet 
banking, pay insurance premiums, and so on. Individuals can also carry 
out trading in stocks online, and get information about stocks to trade in 
from websites that display news, charts, performance reports and analyst 
ratings of companies. 

4. Manufacturing 

Supply chain operations also use ecommerce; usually, a few companies 
form a group and create an electronic exchange and facilitate purchase and 
sale of goods, exchange of market information, back office information 
like inventory control, and so on. This enables the smooth flow of raw 
materials and finished products among the member companies and also 
with other businesses. 
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5. Online Booking 

This is something almost every one of us has done at some time – book 
hotels, holidays, airline tickets, travel insurance, etc. These bookings and 
reservations are made possible through an internet booking engine or IBE. 
It is used the maximum by aviation, tour operations and hotel industry. 

6. Online Publishing 

This refers to the digital publication of books, magazines, catalogues, and 
developing digital libraries. 

7. Digital Advertising 

Online advertising uses the internet to deliver promotional material to 
consumers; it involves a publisher, and an advertiser. The advertiser 
provides the ads, and the publisher integrates ads into online content. 
Often there are creative agencies which create the ad and even help in the 
placement. Different types of ads include banner ads, social media ads, 
search engine marketing, retargeting, pop-up ads, and so on. 

8. Auctions 

Online auctions bring together numerous people from various 
geographical locations and enable trading of items at negotiated prices, 
implemented with e-commerce technologies. It enables more people to 
participate in auctions. Another example of auction is bidding for seats on 
an airline website – window seats, and those at the front with more leg 
room generally get sold at a premium, depending on how much a flyer is 
willing to pay. 

4.5 ELECTRONIC DATA EXCHANGE 
(INTERCHANGE) - EDI 

Electronic Data Exchange is the direct exchange of data and important 
business documents through the Internet and in a very professional 
manner. Two different companies sitting at the extreme corners of the 
world can very easily interchange information or documents (like sales 
orders, shipping notices, invoices, etc) with the help of EDI. 

EDI Documents: 
The most common documents exchanged via EDI are: 

Invoices 

Purchase Orders 

Financial Information letters 

Transaction Bills 

Shipping requests and notifications 

Acknowledgment and feedback 

Transcripts 

mu
no
tes
.in



  

 

Information Technology 
in Accountancy - I 

250 

Claims 

Business Correspondence letters 

EDI Users: 
Central and state government agencies 

Industry 

Banking 

Retailing 

Manufacturing 

Insurance 

Healthcare 

Automotive 

Electronics 

Grocery 

Transportation 

How EDI works? 

The data or the information that one company sends the other first gets 
prepared to be sent, then the information/document is translated into EDI 
format. The document is then connected and transmitted to the other 
business, the connection is direct and point to point. 
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Advantages of EDI: 

There are several advantages to Electronic Data Interchange: 

1. The paper usage reduced: The expense of storing, printing, recycling, 
reduces up to the maximum amount due to the EDI. 

2. Improved quality of Data: The data entry errors are reduced due to 
EDI. 

3. Speed Increases: The best advantage is the increase in the speed of the 
data interchange. With everything going online, the speed of the 
information transfer increases exponentially. 

4. Security: By following the Protocols and the standard rules, the 
security of all the important documents is always secure and safe. 

5. Information accuracy: Since the information exchanged is based on 
standards agreed by the sender and receiver both, the correct 
information is always transferred regardless of where they belong to. 

6. Less Cost: With very less errors, fast response time, every thing 
becoming automated, and no use of paper, the cost automatically 
reduces. 

Disadvantages of EDI: 
1. The initial setup of the EDI is very Time-consuming. 

2. EDI standards keep on changing after some amount of time. 

3. A very systematic and proper back up is required as the entire data 
relies on EDI. 

4. The setup and maintenance of the EDI is very Expensive. 

4.6 EXTRANET 

An extranet is a private network that enterprises use to provide trusted 
third parties -- such as suppliers, vendors, partners, customers and other 
businesses -- secure, controlled access to business information or 
operations. 

Some use cases for extranets include the following examples: 

● exchanging large volumes of data using electronic data interchange; 

● sharing product catalogs exclusively with wholesalers; 

● collaborating with other companies on joint development projects; 

● jointly developing and using training programs with other companies; 

● providing services to a group of other companies, such as an online 
banking application managed by one company on behalf of affiliated 
banks; and 

● sharing news of common interest exclusively with partner companies. 
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What are the advantages of using an extranet? 

Extranets offer significant benefits for enterprises, employees and external 
partners: 

● Enhanced engagement and communication. Extranets provide a 
platform for communicating important updates, making announcements or 
sharing important news relevant to all stakeholders. This approach can 
lead to increased participation and engagement from employees and 
external partners. 

● Enhanced efficiency. Businesses of all sizes, including startups, 
often work with multiple partners and external vendors to develop 
products and complete tasks. An extranet helps manage these workflows. 

● Enhanced collaboration and knowledge sharing. Before the 
emergence of popular team collaboration tools, like Asana, Trello and Jira, 
companies mostly depended on extranets and intranets to improve 
collaboration. This approach ensured seamless document sharing and real-
time updates, while providing a secure environment to work with sensitive 
company data or project data. 

What are the disadvantages of using an extranet? 

Extranets also come with some drawbacks: 

● Capital expenditure. Setting up and maintaining an extranet can be 
resource-intensive. The price includes the cost of on-premises hardware 
and software, as well as the costs associated with hiring information 
technology staff who must build it and maintain it. As a result, an extranet 
may not the best option for companies that do not have the financial 
resources to set up and manage it. Alternatively, managed or cloud-hosted 
extranets, such as Microsoft SharePoint, can help mitigate some of these 
upfront expenses. 

● Data security. Using an extranet requires steps to mitigate risk. If 
security measures are lax, unauthorized users can potentially get in and 
access sensitive data. This may lead to the loss of proprietary or 
confidential data and competitive advantage. As such, extranets are best 
managed by in-house professionals who can help mitigate the risk of data 
leaks. 

4.7 ELECTRONIC PAYMENT SYSTEMS 

Type 1: Payment Through an Intermediary - Payment Clearing 
Services  

In order to be used as a substitute for face-to-face payments, online 
payment systems must incorporate all or some of these stages within their 
payment functions. The lack of face-to-face interaction also leads to more 
secure methods of payment being developed for electronic commerce, to 
deal with the security problems for sensitive information and uncertainty 
about identity. Consequently, electronic commerce transactions require 
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intermediaries to provide security, identification, and authentication as 
well as payment support. 

Figure 4.7.1 shows a stylized transaction for online commerce using an 
intermediary. In this model, the intermediary not only settles payments, it 
also takes care of such needs as confirming seller and buyer identities, 
authenticating and verifying ordering and payment information and other 
transactional requirements lacking in virtual interactions. In the figure, 
two boxes delineate online purchasing and secure or off-line payment 
clearing processes. Payment settlement in this figure follows the example 
of the traditional electronic funds transfer model which uses secured 
private value networks. The intermediary contributes to market efficiency 
by resolving uncertainties about security and identity and relieving 
vendors of the need to set up duplicative hardware and software to handle 
the online payment clearing process. The payment information transmitted 
by the buyer may be one of three types. First, it may contain only 
customer order information such as the identity of the buyer and seller, 
name of the product, amount of payment, and other sale conditions but no 
payment information such as credit card numbers or checking account 
numbers. In this case, the intermediary acts as a centralized commerce 
enabler maintaining membership and payment information for both sellers 
and buyers. A buyer need only send the seller his identification number 
assigned by the intermediary. Upon receiving the purchase order, the 
intermediary verifies it with both the buyer and seller and handles all 
sensitive payment information on behalf of both. 

 

Figure 4.7.1: Transactions with an intermediary 

The key benefit of this payment clearing system is that it separates 
sensitive and nonsensitive information and only non-sensitive information 
is exchanged online. This alleviates the concern with security that is often 
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seen as a serious barrier to online commerce. In fact, First Virtual does not 
even rely on encryption for messages between buyers and sellers. A 
critical requisite for this system to work is the users' trust in the 
intermediaries. 

Type 2: Payment Based on EFT - Notational Funds Transfer   

The second type of payment systems does not depend on a central 
processing intermediary. Instead, sensitive payment information (such as 
credit card or bank account number) is transmitted along with orders, 
which is in effect an open Internet implementation of financial electronic 
data interchange (EDI) (see Figure 4.7.2). An electronic funds transfer 
(EFT) is a financial application of EDI, which sends credit card numbers 
or electronic checks via secured private networks between banks and 
major corporations. To use EFTs to clear payments and settle accounts, an 
online payment service will need to add capabilities to process orders, 
accounts and receipts. In its simplest form, payment systems may use 
digital checks —simply an image of a check— and rely on existing 
payment clearing networks. The Secure Electronic Transaction (SET) 
protocol - a credit card based system supported by Visa and MasterCard - 
uses digital certificates, which are digital credit cards. We call this type of 
payment system as notational funds transfer system since it resembles 
traditional electronic fund transfers and wire transfers which settle 
notational accounts of buyers and sellers.   

 

Figure 4.7.2: Notational funds transfer system 

Notational funds transfer systems differ from payment clearing services in 
that the 'payment information' transferred online contains sensitive 
financial information. Thus, if it is intercepted by a third party, it may be 
abused like stolen credit cards or debit cards. A majority of proposed 
electronic payment systems fall into this second type of payment systems. 
The objective of these systems is to extend the benefit and convenience of 
EFT to consumers and small businesses. However, unlike EFTs, the 
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Internet is open and not as secure as private value added networks 
(VANs). The challenge to these systems is how to secure the integrity of 
the payment messages being transmitted and to ensure the interoperability 
between different sets of payment protocols. 

Type 3: Payment Based on Electronic Currency   

The third type of payment systems transmit not payment information but a 
digital product representing values: electronic currency. The nature of 
digital currency mirrors that of paper money as a means of payment. As 
such, digital currency payment systems have the same advantages as paper 
currency payment, namely anonymity and convenience. As in other 
electronic payment systems, here too security during transmission and 
storage is a concern, although from a different perspective, for digital 
currency systems doubles pending, counterfeiting, and storage become 
critical issues whereas eavesdropping and the issue of liability (when 
charges are made without authorization) are important for notational funds 
transfers. Figure 4.7.3 shows a digital currency payment scheme. 

 

Figure 4.7.3: Digital Currency Payment Scheme 

The only difference from Figure is that the intermediary in Figure 4.7.3 
acts as an electronic bank which converts outside money, into inside 
money (e.g. tokens or e-cash) which is circulated within online markets. 
However, as a private monetary system, digital currency will have wide 
ranging impact on money and monetary system with implications 
extending far beyond mere transactional efficiency. Already digital 
currency has spawned many types of new businesses: software vendors for 
currency server systems; hardware vendors for smart card readers and 
other interface devices; technology firms for security, encryption and 
authentication; and new banking services interfacing accounts in digital 
currency and conventional currency.   
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4.8 RISKS AND SECURITY CONSIDERATIONS 

Common Security Threats to Ecommerce 

1. Financial frauds 

There are two common frauds that are used to target the e-commerce 
industry: credit card frauds and fake returns. 

● Credit card fraud happens when a criminal uses stolen credit card 
data to purchase goods or services on an e-commerce store. When 
payment authorisation based solely on passwords and security questions 
does not verify a person’s identification. If someone else obtains our 
credentials, this might result in a fraud prosecution. This allows the third 
party to effortlessly take money. 

● Fake returns are unauthorized transactions made to false requests for 
returns. Businesses reimburse unlawfully obtained merchandise or 
damaged goods in refund fraud, which is a typical financial scam. 

2. Phishing 

Phishing is a cybercrime that aims at stealing user’s confidential data — 
login and passwords. This is achieved via mass email campaigns run on 
behalf of popular brands, as well as personal messages inside of the 
various services like social networks. 

Messages often contain a direct link on a fake website that looks exactly 
like the real one, or on a website that redirects the user somewhere else. 
When the user lands on a fake page, cybercriminals try to make the user 
enter his login and password that he uses to access a specific website, 
which allows villains to get access to bank accounts. 

3. Spam 

Emails are recognized for being a powerful medium for increasing sales, 
but they are also one of the most often utilized channels for spamming. 
Nonetheless, leaving infected URLs in comments on your blog or contact 
forms is an open invitation for internet spammers to damage you. They 
frequently send them through your social media inbox and wait for you to 
click on them. Furthermore, spamming not only compromises the security 
of your website, but it also slows it down. 

4. Bots 

Bots are automated software applications programmed to perform specific 
tasks. Web crawlers, probably the most known type of bots, are those that 
define websites’ rankings by systematically browsing all the exiting pages 
on the internet. 

However, there are bots specifically created to crawl websites for their 
pricing and inventory information. Cybercriminals use this technique to 
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change the pricing of your online store, or to garner the best-selling 
inventory in shopping carts, resulting in a decline in sales and revenue. 

5. DDoS Attacks 

DDoS (distributed denial of service) assaults have evolved from a small 
annoyance that may have caused modest harm to a huge security risk that 
is easily damaging and shutting down the business continuity of the 
world’s largest and most powerful corporations. 

A DDoS assault aims to prevent a company from operating until the attack 
is effectively prevented or the attacker ceases. This attacks can harm your 
website or app by generating a large number of requests which eventually 
can crash the whole system and make it unavailable for the end-user. This 
eventually disrupts your site and affects sales. 

6. Brute Force Attacks 

The brute force attack is one of the most common password-cracking 
techniques. This approach presupposes that a hacker tries to use as many 
character combinations as possible in order to figure out the correct 
password. 

7. SQL Injections 

SQL injection is a cyber-attack aimed to entry your website’s database by 
targeting your query submission forms. Hackers inject malicious code into 
your database to read, delete, change, collect or add data. 

8. Cross-Site Scripting (XSS) 

Cross-site scripting is an attack that comes in the form of a piece of 
browser code script (HTML). When the attacked user opens the browser 
and the website, the malicious script starts running and receives access to 
the various types of user’s sensitive data that must be protected. 

9. Trojan horses 

Malware, a program usually downloaded by customers as legitimate 
software, is called a trojan horse. To this category belong programs that 
can gather data about credit or debit cards, transfer this information to the 
hacker, as well as crash users’ computers or use PC resources for hacker’s 
goals without permission of the user. These programs get any sensitive 
data with ease and may also infect your website. 

10. Man in the middle 

A cybercriminal may eavesdrop on the communication between a store 
consultant and a customer. If the client is connected to a vulnerable Wi-Fi 
or network, hackers can take advantage of that to steal sensitive data. 
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E-commerce security solutions  

1. HTTPS and SSL certificates 

SSL certificate is one of the ways to protect user’s personal data on the 
internet. 

You may have seen that there are two types of browser addresses — 
HTTP and HTTPS. Both abbreviations stand for communication protocol. 
The protocol is a set of rules that defines data exchange between browser 
and server, what kind of information should exist there and what to do 
with that data. 

HTTPS is a protected version of HTTP. It’s an SSL protocol, that gets 
activated after SSL-certificate is set and encrypts personal data before the 
information is transferred to the e-commerce website or app owner. 

This kind of protection is really useful when you have transactions to be 
done on your website. Whenever customers enter their credit card 
information it can be stolen by hackers and used by them later on. Thus, 
using an SSL certificate will make payments on your website secure and 
clients won’t be afraid of scams. 

2. Anti-malware 

Anti-malware is software that detects and deletes computer viruses, as 
well as other undesirable or harmful programs. Anti-malware also 
reestablishes files that have already been harmed by viruses and prevent 
further file or software modification that can be done by malicious code. 

Anti-malware is used against worms, viruses, and Trojan horses. 

3. Secure server and the admin panel 

Using passwords that contain different characters and are hard to guess is 
a key. You should also change them frequently. Another good practice is 
restricting user access and defining user roles. Let everyone perform only 
what they have to on the admin panel. Making the panel notify you if a 
foreign IP tries to access it is an extra step for your security. 

4. Secure payment gateway 

Don’t store clients’ credit card information on your database. 
Alternatively, use Stripe and PayPal as a third party to manage the 
payment transactions away from your website. 

5. Deploy firewall 

A firewall is a network security system that controls and filters network 
traffic (incoming and outgoing) according to defined rules and eliminates 
e-commerce security threats. 

Efficient firewalls protect your website against XSS, SQL injection, and 
other cyber-attacks. 

mu
no
tes
.in



 

 

Introduction to Internet 
and other emerging 

technologies 

259 

6. Additional e-commerce security measures 

● Tell your clients to use resources that are familiar to them, click on 
saved links, use the official internet banking app and check out where 
they get their messages from. 

● Make scanning your website from malware your constant routine. 

● Increase your data protection by using multi-layer security and 
backing up your data. 

● Use efficient plugins for e-commerce security and update your systems 
often. 

4.9 LEGAL ISSUES 

Legal Issues Associated with E-commerce 

1. Contracts 

The ability for parties to make genuine and legally enforceable contracts 
online is at the heart of e-commerce. As parties replace paper documents 
with electronic equivalents, basic problems arise about how e-contracts 
may be made, performed, and enforced. The Information Technology Act 
of 2000 governs contractual elements of electronic record use, including 
attribution, acknowledgment, dispatch time and location, and reception. 
The IT Act, however, should be read in connection with the Indian 
Contracts Act, 1872, because it is just an enabling Act. The Contract Act 
requires three key factors for the formation of every contract. There must 
be an offer, which must be accepted without alteration, and there must be 
some kind of remuneration for the contract. E-contracts would benefit 
from these elements. 

Additionally, this will require certain types of contracts and the 
impossibility of determining the true consumer’s age, with the standard 
age to enter into contracts set at 18. As a result, it’s critical that an online 
business portal considers this possibility and includes a form on its 
website saying that the person with whom it’s dealing or entering into an 
e-contract has reached the age of majority. 

2. Privacy and Data Protection 

The privacy of its users is a vital factor for every e-commerce company. 
Individuals and organisations can easily get personal and sensitive 
information thanks to breakthrough technology and a lack of safe 
processes. When it comes to internet enterprises, privacy is a big concern 
that may lead to issues for both the company and its consumers. 
Consumers exchange personal information with companies via the internet 
and expect the sellers to keep it private. When an e-commerce firm caters 
to customers in other countries, those countries may have laws that render 
the e-commerce corporation accountable for infringing the privacy rights 
of the foreign customer. For example, if Company A in India collects 
personal data from a European Union customer and distributes it to firms 
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in the United States, it may be accountable for infringing on the 
customer’s privacy rights. When it comes to internet enterprises, privacy is 
a big concern that may lead to issues for both the company and its 
consumers. Consumers exchange personal information with companies via 
the internet and expect the sellers to keep it private. 

3. Intellectual Property Rights 

All trademarks and copyrights for the items, words, and symbols to be 
utilised must be protected. India, on the other hand, has a well-defined 
legal and regulatory framework for the protection of intellectual property 
rights. Furthermore, the regulations have yet to be entirely updated for 
total efficiency in the virtual world. For example, there is no law against 
the misrepresentation and abuse of domain names. 

Using content from another firm while creating material for your e-
commerce website might be a serious legal issue. This might mark an end 
to your e-business. There are several royalty-free websites that allow you 
to access their information and photos. You may utilise those websites to 
generate online content for your company’s website. 

E-commerce websites are often built and administered by third companies 
that are experts in the sector. A third party is frequently in charge of the 
material. Thus, unless the parties agreement expressly states that IP rights 
are protected, there is a risk of trademark, copyright, or patent 
infringement on an online platform. 

4. Jurisdictional Issues 

In India, there is a scarcity of jurisprudence on questions of jurisdiction in 
the e-commerce sector. Due to the occurrence of several transactions, 
resolving disputes in the B2C sector is particularly difficult. Aside from 
the design of the corporate structure, judgments must be made on the 
jurisdiction in which the corporate structure should be located since this 
will decide the scope of any responsibility that may emerge against the 
website. Apart from the form of the corporate structure, decisions must be 
taken on the jurisdiction in which it should be based since this will 
determine the scope of any liability that may arise against the website. 

This means that you can be sued in a foreign court even if you are not 
physically present in that nation, as long as your website has just a 
minimum connection to that nation. As a result, a business should include 
an applicable choice of law and forum provisions in its online contract, 
identifying the jurisdiction to which the contractual parties would be 
subject. In general, much local legislation allows for a long-arm 
jurisdiction, which means that the execution of such local laws has 
extraterritorial applicability if an act or omission has resulted in some 
illegal or adverse consequence inside the country’s territory. 
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4.10 OTHER EMERGING TECHNOLOGIES 

1. AI (Artificial Intelligence) for a personalized shopping experience 

With this tech trend, when a visitor comes online, then AI bot vets out the 
customer’s profile and information, and quickly finds out the relevant 
insights to shape up the users’ shopping journey. 

It goes through transaction history, previous interaction, product 
preference, and location to suggest the ideal products. but it doesn’t stop 
here and creates and delivers product recommendations through widgets, 
pop-ups, and ads. This enables visitors to get a personalized feel and set 
their foot forward in the right direction. 

2. Blockchain for fraud detection 

To start with, Blockchain technology was developed and designed 
primarily for bitcoin transactions, and other cryptocurrency-related affairs. 
But over the period of time, its capabilities found an extension, and have 
now become purposeful for the eCommerce sector as well. 

Since blockchain works, sans any centralized authority, it enables 
everyone to access all the information within while being unable to alter 
any details. And this very characteristic of this tech-trend is used primarily 
in the eCommerce sector to enhance the process of product traceability. 
Further, it also supports offering a shield against online fraud, and protects 
and prevents cyberattack on users’ account or card details. 

3. Internet of Things for improved tracking 

The very concept of IoT- the Internet of Things has let different devices 
communicate with each other. And this technology has opened a floodgate 
of opportunity to share information and relay commands for offering 
better coordination for tracking. 

IoT for eCommerce helps in improving inventory management. Further, 
the inclusion of RFIDs and sensors enable customers to closely monitor 
to-be delivered products in real-time and let not the quality get 
compromised. 

On the other hand, the warehouse staff can keep a check on the available 
stock, and keep the space for upcoming products. It also streamlines the 
coordination between sellers and customers, by offering accurate location 
and real-time information of the package. 

4. Chatbots for an enhanced user experience 

The intelligent AI-powered chatbots have gradually turned out to be a 
never-stopping support system. These bots are trained to handle customer 
requests on simple product queries and issues that are either repetitive or 
easy to be resolved. 
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With the constant advancement made in artificial intelligence and NLP, 
the ecosystem that runs behind the chatbots has also turned smarter, and 
capable of handling complex customer interactions. 

They mimic human emotions and empathize with the customers to give 
them a most human-like experience while chatting. These bots are the 
most incredible piece of technology, that has the potential to engage 
visitors to influence and enhance their shopping experience. 

5. VR for a futuristic shopping 

The digital kiosk and digital driving are some of the most prominent use 
cases of VR in the eCommerce industry. Today, shopping through the 
futuristic mode of VR is the need of the hour, and addressing the demand 
of millennials effortlessly. 

4.11 EXERCISE QUESTIONS  

Multiple Choice Questions. 

1) __________________ technology was developed and designed 
primarily for bitcoin transactions, and other cryptocurrency-related 
affairs.  

a) Blockchain  b) AI  c) IoT  d) SEO 

2) The ability for parties to make genuine and legally 
enforceable contracts online is at the heart of ________________. 

a) software  b) e-commerce c) hardware  d) computer 

3) Malware, a program usually downloaded by customers as legitimate 
software, is called a ____________________. 

a) Google  b) avast  c) trojan horse  d) Microsoft 

4) ____________ are automated software applications programmed to 
perform specific tasks. 

a) DDoS  b) spam  c) extranet  d) Bots 

5) __________ certificates are one of the ways to protect user’s personal 
data on the internet. 

a) SSL   b) FTP  c) SMTP  d) HTTP 

True or False. 

1) Anti-malware is software that detects and deletes computer viruses, as 
well as other undesirable or harmful programs. 

2) An extranet is a private network that enterprises use to provide trusted 
third parties. 
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3) Online Publishing refers to the digital publication of books, magazines, 
catalogues, and developing digital libraries. 

4) Online Marketing refers to the gathering of data about consumer 
behaviors, preferences, needs, buying patterns and so on. 

5) TheDDoS attack is one of the most common password-cracking 
techniques. 

Define or short answer. 

1) E-commerce 

2) Electronic data exchange 

3) Phishing 

4) Contracts 

5) Blockchain 

Long answer. 

1) Write a short note on extranet. 

2) What are common security threats to e-commerce? 

3) Explain electronic payment systems. 

4) Explain security solutions for e-commerce. 

5) What are applications of e-commerce? 
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5 
E-COMMERCE 

Unit Structure 

5.0 Learning Objectives 

5.1 Meaning of Ecommerce 

5.2 The Benefits of E-Commerce  (Advantages) 

5.3 The Limitations of E-Commerce   

5.4 Role of Strategy in Ecommerce - Technology and Marketing Strategy  

5.5 Value Chain in E-Commerce 

5.6 Infrastructure for Ecommerce - Requirements 

5.7 Web Based Tools for Ecommerce 

5.8 Ecommerce Software  

5.9 Security Threats to Ecommerce 

5.10 Implementing Security for ECommerce  

5.11 Electronic Payment System 

5.12 Strategies for Marketing 

5.13 Electronic Market 

5.14 Business Plan for implementing Electronic Commerce 

5.15 Exercise Questions  

5.16 References  

5.0 OBJECTIVES 

After studying this chapter you should be able to understand 

 E-commerce and E-business 
 Infrastructure requirements of Ecommerce 
 Threats to Ecommerce 
 Plan to implement Ecommerce  
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5.1 MEANING OF ECOMMERCE 

5.1.1 What is Ecommerce ? 

Electronic commerce or e-commerce has been defined as the ability to 
perform transactions involving the exchange of goods or services between 
two or more parties using electronic tools and technique. Consumers can 
easily buy products or services like magazines and airlines tickets via 
Internet. 

DEFINITION 

The word commerce is the basic concept for electronic commerce, 
pertaining to buying and selling of goods while ‘commercial’ denotes 
business practice and activities intended to make profits. Electronic 
commerce, like any other business, deals with the exchange of money for 
soft or hard goods and services.  

Electronic Commerce (e-commerce) is electronic business. It’s using the 
power of computers, the Internet and shared software to send and receive 
product specifications and drawings; bids, purchase orders and invoices; 
and any other type of data that needs to be communicated to customers, 
suppliers, employees or the public. 

E-commerce is the new, profitable way to conduct business which goes 
beyond the simple movement of information and expands electronic 
transactions from point-of-sale requirements, determination and 
production scheduling, right through to invoicing, payment and receipt.  

E-commerce uses key standards and technologies including Electronic 
Data Interchange (EDI), Technical Data Interchange (TDI), Hypertext 
Markup Language (HTML), Extensible Mark-up Language (XML), and 
the Standard for Exchange of Product model data (STEP). E-commerce is 
made possible through the expanded technologies of the Internet, the 
World Wide Web, and Value-Added Networks.  

E-commerce includes purchases of goods, services and other financial 
transactions in which the interactive process is mediated by information or 
digital technology at both locationally separate, ends of the interchange. 

E-commerce transaction model can be in terms of business to business 
(B2B), business to customer (B2C) or customer to customer (C2C). 
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5.1.2 FEATURES OF E-COMMERCE TECHNOLOGY 

SEVEN UNIQUE FEATURES OF E-COMMERCE TECHNOLOGY 

Dimension of E-commerce 
Technology  

Significance in Business  

Ubiquity  
Internet/Web technology is 
available every where: at work, at 
home, and elsewhere via mobile 
devices, anytime.   
 

The marketplace is extended beyond 
traditional boundaries and is 
removed from a temporal and 
geographic location.  
“Marketspace” is created; shopping 
can take place anywhere. Customer 
convenience is enhanced, and 
shopping costs are reduced.   

Global Reach  
 
The technology reaches across 
national boundaries, around the 
earth.   
 

Commerce is enabled across cultural 
and national boundaries seamlessly 
and without modification. 
“Marketspace” includes potentially 
billions of consumers and millions of 
businesses worldwide.   

Universal Standards  
There is one set of technology 
standards, namely internet 
standards.  

There is one set of technical media 
standards across the globe.   

Richness  
Video, audio, and text messages 
are possible. 

Video, audio, and text marketing 
messages are integrated into a single 
marketing message and consuming 
experience.  

Interactivity  
 
The technology works through 
interaction with the users. 

Consumers are engaged in a dialog 
that dynamically adjusts the 
experience to the individual, and 
makes the consumer a coparticipant 
in the process of delivering goods to 
the market.   

Information Density   
 
The technology reduces 
information costs  

Information processing, storage, and 
communication costs drop 
dramatically, while currency, 
accuracy, and timeliness  

and raises quality.  improve greatly. Information 
becomes plentiful, cheap, and 
accurate.   
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Personalization / Customization   
The technology allows 
personalized messages to be 
delivered to individuals as well as 
groups. 

Personalization of marketing 
messages and customization of 
products and services are based on 
individual characteristics.  

 

5.1.3 NEED FOR E-COMMERCE   

The global business environment is moving faster than ever before. 
Increased competition at home and abroad means quality as well as 
profitability must be preserved by corporate houses. This pressure has led 
to a reappraisal of the accepted existing business practice in the search for 
greater efficiently.   

Traditionally, the response in the face of competitive threat has been to 
reduce costs by L rationalizing production, shedding labour and 
restructuring business, coupled with investments in .technology to 
improve productivity and generate profit.   

Whether business to business (B2B) or business to customer (B2C) there 
are benefits to all parties, customers or suppliers. A reduction in 
acquisition times and costs, lower prices for goods and services, an 
expanded number and quality of suppliers, an increase in buyer 
productivity. Better management information and better inventory control 
is possible. A Reduction time to market is also achievable giving 
improved operating efficiencies and improved product quality at reduced 
cost. The payment process can also be improved and finally and most 
importantly a greatly expanded customers base.  B2B e-commerce was 
born out of an attempt to solve an administrative problem. It developed a 
new computer standard to handle these needs, which became known as 
EDI, Electronic Data Interchange. Today its descendant, XML, a lighter, 
simpler data interchange standard is used by B2B sites. Simple e-
commerce sites first appeared in 1992. The early e-commerce sites were 
virtual catalogues, simply listing products for sale. Ordering was off-line, 
through e-mail, phone or fax. By 1996 the technology had advanced 
greatly to produce virtual stores with shopping carts, client accounts and, 
with the development of protocols such as Secure Socket Layer (SSL), 
enabled customers to order and  pay  for  their  purchase on-line  directly 
 by credit card.   

E-commerce quickly became popular with consumers and suppliers. For 
customers, it was fast, easy and efficient, allowing them to compare 
products, price and service before purchase. For suppliers, it allowed them 
to reach an unlimited international audience, 24 hours a day, 7 days a 
week at reduced costs. Today e-commerce is widely used and growing 
fast. B2B is the largest, fastest growing and most profitable market. 
According to IDC, this year, it is expected to account for two thirds of 
world wide e-commerce. B2C is also expected to grow, boosted by 
Broadband (high-speed) Internet access to more online households. Future 
advances include digital money and e-wallets, and 'personal agents' that 
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help users find what they are looking for. Sites can work with fulfilment 
centres providing customers with excellent service and suppliers with 
information, and can support the newest trend for human interaction in E-
commerce customer service.  The Internet is creating unprecedented and 
seeming infinite opportunities for both customers and businesses. Yet it 
one of its major problems is that it is changing so fast that both parties are 
overwhelmed by the speed of change and the sheer number of choices 
available to them. In addition web businesses win by following rules quite 
different than those which traditional businesses may follow.   

E-commerce appears to be exempt from the kinds of constraints that have 
limited companies historically. An e-commerce environment handled in a 
proper manner, with the right customisation of products and services, in 
innovative ways, can lead to win-win situations. The customers can get the 
right product at the right time and for the right price, companies can set 
new standards in efficiency and profitability.  

5.1.4 LEVELS OF E-COMMERCE   

There are five major segments under the broader category of e-business. 
However, the following are some popular e-commerce models used by 
companies engaged in ecommerce:- 

• Business to business e-commerce (B2B)   

• Business to consumers e-commerce (B2C)   

• Consumers to consumers e-commerce (C2C}   

• Business to employees e-commerce (B2E) and   

• Consumer to business e-commerce (C2B)   

5.1.4.1 Business to Business E-commerce (B2B) 

E-business is the process of conducting business on the Internet. In a B2B 
transaction, the interaction is between businesses. For example, a website 
that is catching for the steel industry might have a facility for buyers and 
sellers to list their requirements and post their products. It helps them in 
quickly closing the transactions and the buyer can get quality, material and 
can choose from different suppliers.   

Business to Business e-commerce provides small and medium enterprises 
(SMES) with an excellent opportunity to access new markets, improve 
customer service and reduce costs. 

In this form of e-commerce, a business firm places orders for supplies with 
another business firms directly over the Internet. Paperwork and time 
required for processing the order and delivery of the goods are thus 
reduced to a great extent. 
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5.1.4.2 Business to Consumers E-commerce (B2C)  

B2C e-commerce involves selling of goods and services to consumers or 
end users. It allows them to browse the product catalogue, select products 
or services and complete the order online.   

For example, the most popular site is amazon.com, which is the first 
online bookseller which has proved a potential competitor to the 
traditional bricks and mortar booksellers such as Barrens and Noble. 

In this category of e-commerce, businesses use the internet to offer to 
consumers sales and services around the world 24 hours a day, seven days 
a week and 365 days a year, The sites Amazon, Rediff and Uphar are 
among those belonging to this category. These websites are meant for 
selling goods directly to consumers through the internet. The twoway 
accessibility of the internet enables operating companies to directly 
ascertain customer preference and buying trends. Businesses are using 
these consumer insights to formulate marketing strategies and offer to the 
customers what they want and when they want. E-business in this mode 
significantly reduces the costs associated with intermediaries, service 
centres and mass marketing campaigns. Since e-commerce makes just in 
time delivery possible, the supplier does not have to store the goods. He 
can procure them from the suppliers as and when he gets the order from 
the buyer through the internet.  

5.1.4.3 Consumer to Consumer E-commerce (C2C)  

Here interaction is between consumer to consumer. For example, in sites 
like e-Buy Bid or Buy.com, Baazi.com which are auction sites, one can 
virtually sell and buy any goods (either used or new ones).   

This form of e-commerce is nothing but the cyber version of the good old 
auction houses. If anyone wants to sell anything, all one has to do is post a 
message on the site, giving details of the product and the expected price 
and wait for an interested customer to turn up and buy it. The buyer gets in 
touch with the seller through the Internet and the deal is crossed once the 
amount is finalised. Online message boards and barters are also examples 
of C2C e-commerce.  

5.1.4.4 Consumer-to-Business E-commerce (C2B)  

E-commerce, by empowering the customer, has been strategically 
redefining business. An example of C2B model of e-commerce is the site 
Price line.Com, which allows prospective airline travellers, tourists in 
need of hotel reservations etc. to visit its websites and indicate their 
preferred price for travel between any two cities. If an airline is willing to 
issue a ticket on the customers offered price, the consumer can then travel 
to the mentioned destination at his terms.   
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5.1.4.5 Business to Employees E-commerce (B2E)  

This is concerned more with marketing a corporation's internal processes 
more efficiently. Customer care and support activities also hold ground. 
The requirement is that are all self-service with applications on the web 
that the employees can use themselves.   

5.2 THE BENEFITS OF E-COMMERCE  (Advantages) 

The global nature of the technology, low cost, opportunity to reach 
hundreds of millions of people, interactive nature, variety of possibilities, 
and resourcefulness and growth of the supporting infrastructure (especially 
the web) result in many potential benefits to organisations, individuals, 
and society.   

5.2.1 Benefits to Organizations   

The benefits to organizations are as follows:   

• Electronic commerce expands the market lace to national and 
international market with minimal capital outlay, a company can easily 
and quickly locate more customers, the best suppliers, and the most 
suitable business partners worldwide.   

• Electronic commerce decreases the cost of creating, processing, 
distributing, storing, and retrieving paper-based information. For 
example, by introducing an electronic procurement system, companies 
can cut the purchasing administrative costs by as much as 85 percent.   

• Ability for creating highly specialized businesses. For example, dog 
toys which can be purchased only in pet shops or department and 
discounts stores in the physical world are sold now in a specialized 
www.dogtoys.com (also see www.cattoys.com).   

• Electronic commerce allows reduced inventories and overhead by 
facilitating “pull” type supply chain management. In a pull-type 
system the process starts from customer orders and uses just-in-time 
manufacturing.   

• The pull-type processing enables expensive customization of products 
and services which provides competitive advantage to its 
implementers.   

• Electronic commerce reduces the time between the outlay of capital 
and the receipt of products and services.   

• Electronic commerce initiates business processes reengineering 
projects By changing processes, productivity of salespeople, 
knowledge workers, and administrators can increase by 100 percent or 
more.   

• Electronic commerce lowers telecommunication cost the internet is 
much cheaper than value added networks.   
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• Other benefits include improved image, improved customer service, 
new found business partners, simplified processes, compressed cycle 
and delivery time, increased productivity, eliminating paper, 
expediting access to information, reduced transportation costs, and 
increased flexibility.  

5.2.2 Benefits to Consumers   

The benefits of E-Commerce to consumers are as follows:   

• Electronic commerce enables customers to shop or do other 
transactions 24 hours a day, all year round, from almost any location.  

• Electronic commerce provides customers with more choices; they can 
select from many vendors and from many more products.  

• Electronic commerce frequently provides customers with less 
expensive products and services by allowing them to shop in many 
places and conduct quick comparisons.  

• In some cases, especially with digitized products, E-Commerce allows 
quick delivery.  

• Customers can receive relevant and detailed information in seconds, 
rather than days or weeks.  

• Electronic commerce makes it possible to participate ate in virtual 
auctions.  

• Electronic commerce allow customers to interact with other customers 
in  electronic communities and exchange ideas as well as compare 
experiences.  

• E-commerce facilitates competition, which results in substantial 
discounts.. 

.  5.2.3 Benefits to Society   

The benefits of E-Commerce to society are as follows:   

• Electronic commerce enables more individuals to work at home and to 
do less traveling for shopping, resulting in less traffic on the roads and 
lower air pollution.   

• Electronic commerce allows some merchandise to be sold at lowest 
prices, so less affluent people can buy more and increase their standard 
of living.  

• Electronic commerce enables people in third world countries and rural 
areas to enjoy products and services that otherwise are not available to 
them.   

• Electronic commerce facilitates delivery of public services, such as 
health care, education, and distribution of government social services 
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at a reduced cost and/or improved quality. Health care services, e.g., 
can reach patients in rural areas.  

5.3 THE LIMITATIONS OF E-COMMERCE   

The limitations of E-Commerce can be grouped into two categories which 
are:  

• Technical limitations and   

• Non-technical limitations  

5.3.1 Technical Limitations of E-COMMERCE  

The technical limitations of E-Commerce are as follows:   

• There is a lack of s stem security, reliability, standards and 
communication protocols.  

• There is insufficient telecommunication bandwidth.  

• The software e development tools are still evolving and changing 
rapidly.  

• It is difficult to integrate the Internet and E-Commerce software with 
some existing applications and databases.  

• Vendors may need special Web servers and other infrastructures in 
addition to the network servers.  

• Some E-Commerce software might not fit with some hardware or may 
be incompatible with some operating systems or other components.   

• As time passes, these limitations will lessen or be overcome; 
appropriate planning can minimize their impact.   

5.3.2 Non-technical Limitations   

Of the many non-technical limitations that slow the spread of E-
Commerce, the following are the major ones:  

1) Lack of Awareness  

The single most important challenge today pertains to increasing 
awareness of the benefits of e-commerce to potential customers, educate 
the market and the customers will themselves opt for these services. So, 
the e-commerce fraternity should accept the fact that the customers are 
extremely demanding and that they should be geared up towards this end 
and surpass the expectations of customers. . 

2) Lack of Infrastructure  

The lack of infrastructure, if made available as required, will ensure that 
the investment in e- commerce starts flowing in because the business is 
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happening and infrastructure will grow. The high cost of infrastructure 
development for e-business is also including the cost of leased lines.   

3) Lack of Confidence  

The people in India still show hesitancy in buying through the Net. Lack 
of quality products, timely delivery of products as some of them tend to go 
out of stock, lack of solutions security are the potential reasons for not 
developing e-commerce. People do not understand this new way of buying 
and selling products, i.e. the services in a digital environment which are 
available online.   

4) Skeptic Attitude  

Though the Internet is continuing to grow at a rapid rate, along with e- 
commerce transactions, the shoppers are still skeptical about safety and 
have not been quick to trust sending personal information such as credit 
card numbers or address over the Net. The risk adverse attitude of the 
people is conspicuous and waiting for others to lead is also another 
attitude.   

5) Credit Cards Frauds  

The bigger problem is that of security. All credit cards related transactions 
are approved offline and given the high incidence of frauds, the banks are 
extremely wary of approving them. In-fact, there are some unconfirmed 
reports of a multi-national bank refusing to approve credit card 
transactions carried out by a large Indian portal.   

6) Absence of Tax Laws  

E-commerce over the Net has effectively eliminated national borders. This 
has posed an important question as to tax on the transactions over the 
internet. Net business posed many peculiar technological and legal 
problems making it difficult to impose tax and formulate a sound taxation 
policy. The following are the various tax implications of ecommerce:   

• There is no fixed physical location for the internet.   

• It is difficult to monitor or prevent transmissions of information or 
electronic cash across the Net.   

• Neither the users, administrators nor intermediaries have any control 
on the type of information, either transactions or cybercash and 
traveling through their networks.   

• There is no emphasis on national boundaries, and messages travel 
across the boundaries of several countries globally. So, it means no 
difference, whether the information or electronic money sought to be 
transmitted are within one jurisdiction or between several.   

• A person's location and identity is necessary for tax purposes. Since 
these two are difficult, the anonymity on the Net would pose a big 
problem for taxations.  
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• Electronic commerce eliminates intermediaries or middlemen. Though 
it is an advantageous feature, it also has negative effects because they 
could have served as leverage points for collection of tax also as 
information sources for transactions entered by the customers.   

• In addition to technology problems, certain legal hurdles may also be 
encountered with reference to international taxation laws.   

• The difficulties in defining service incomes as distinguished from sale 
of products, income or royalties cannot be ignored.   

So, it is desirable that the Net be turned as a potential free trade zone.   

7) Cyber Laws  

Another important problem is lack of comprehensive cyber laws so as to 
ensure safety and protection. There should not be any legal regulations, or 
barriers to faster and increased development of e-commerce. The crying 
need of the hour is urgent action to be taken by the Government to enact 
cyber laws including electronic fund transfer, and amendments of official 
Secrets Act.    

In addition to them, the fear regarding the security aspects of online 
transactions without proper government directives and the existing policy 
machinery contribute to cyber criminality. Adding to them, separate cyber 
laws and amendments are also required to many existing laws like 
Companies Act, Evidence Act, Copyright Act, Bankers Book Evidence 
Act, Indian Penal Code, Contract Act etc. The country entered into a cyber 
space and documents through the computers should be made acceptable in 
a court of law.  

8) Stock Dilemma  

A key source of dissatisfaction is the out of stock dilemma. In most cases, 
advertised products or services are not available. The options of feedback 
and not receiving suggestions are also reasons for annoyance.   

9) Internet Outrage  

Failures in networks and the Net itself can play havoc. We read of 
frequent press reports of internet outrages. The IT industry is not yet 
attempting to improve network reliability to prevent these outrages. 
Reliability is a major issue in net business that needs to be attended.   

10) Inadequate Government Role  

The government is not taking a serious view of e- commerce related 
information technology in terms of its promotion. Spreading awareness, 
imparting education, of the benefits of e-commerce, enacting new cyber 
laws, amendments to existing commercial laws, developing strong, 
communication infrastructure are the key domestic roles for the 
government to play.   
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11) Inactive Indian Software Houses  

Software houses particularly in India are not devoted to ensuring strong 
expertise in the supply chain and distribution management solutions. 
Efforts are lacking to ensure strategic working on development of systems 
which will provide a comprehensive open e-business solutions 
environment, comprising of enterprise applications, internet applications 
and service and a special technology to enable companies to participate in 
the emerging online economy.   

12) Difficulty of Reengineering  

The web business structure will have to undergo a drastic change and be 
reengineered. It is not just about having a website or about sticking a web 
address on conventional advertising or transferring a few people to a new 
division and designation. It is about breaking free and creating new web 
services to satisfy the existing customers.   

13) Blocking and Censorship  

People worldwide are under virtual slavery. It has been ISS reported in 
some media that many countries are blocking their citizens from accessing 
the Net, either partially or wholly. Censorship is enforced by some 
countries by stopping either a total ban on the Net or controlling the access 
traffic or installing filters blocking access to websites. Indian citizens 
enjoy unprecedented degree of freedom of speech and therefore may 
constitute a threat to the government. Development in any field may prove 
detrimental if it does not appreciate the code of ethics.   

E-commerce has yet to take off in India, because Indian consumers are 
wary of leaving their credit card numbers on the Net. They eye the 
neighbourhood shopkeeper with suspicion and drive a hard bargain. So, e-
commerce websites are losing thousands of customers.   

5.4 ROLE OF STRATEGY IN ECOMMERCE - 
TECHNOLOGY AND MARKETING STRATEGY  

In today’s information-intensive environment, where complex marketing 
processes are generating new distribution and communication channels, 
multiple pricing options, and customized products and services, the 
traditional marketing mix strategies using product, price, place and 
promotion are not sufficient. Organizations have to use the technology to 
be enabled to dynamically allocate marketing resources to those activities 
that generate the best return and have to consider the following issues:   

1. How marketing challenges such as global competition can be faced 
through technology?  

2. What should be the technology infrastructure and technology 
applications for marketing management?  
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3. How information can affect the decision making and marketing 
strategies?  

4. How can technology help to reduce the complexity and to lower the 
cost while the firm expands into new market?  

5. What cost effective strategies can be used to market and advertise 
effectively?  

For developing marketing strategy in reference to above mentioned issues 
with the application of technology, organizations can look at the 
following:  

1) Marketing Decision Support Systems  

The increased competition and changing market structure have led the 
shortening of a product life cycle and for the survival and profitability, 
organizations require new product innovations. For this, detailed, accurate 
and timely information relevant to the product is needed.   

• Data Mining and Decision Support: Data mining is an 
emerging solution for marketing decision support in 
organizations to get optimum performance by knowledge 
workers. It enables to access and manipulate data easily, and 
knowledge workers can use the data creatively.   

• In general, data in the data warehouse has certain characteristics that 
Customer Order – Planning, Forecasting and Fulfillment: To 
know what, when, and where the customer demand the products to be 
delivered, order processing system is examined. It helps in managing 
all parts of the supply chain. Improved inventory control by 
understanding this customer order processing system helps the 
organizations to meet customers’ needs. So, the business firms can 
reduce the inventory costs through improved stock control by 
understanding customer ordering and can result in effective planning, 
forecasting and fulfillment of customer order.  

• Customer Relationship Management (CRM): CRM is a marketing 
function and has a strong impact on marketing strategies. To know the 
wants and preferences of customers in a well defined manner, and the 
level of reliability of information, management can use technology. 
Business firms also use this technology to analyze the global trends 
and for understanding why breaking down of sales cycle has 
happened.  

• Trend Analysis: With the use of data mining technology 
organizations can precisely be able to know the classification of sales 
which would help in predicting some items experiencing low turn and 
others high. This classification trend analysis also help in sales and 
profit mix planning and inventories can be adjusted accordingly.  

• Channel Management: Technology allowing business organization to 
interact directly with customers and react to changes in demand, 
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ultimately affect the supply chain. Better customer values can only be 
provided through a marketing mix strategy that contributes to lower 
system costs or improved differentiation for the entire supply chain. So 
channel management provides a new impetus for integrating marketing 
processes, distribution, and manufacturing.  

differentiate data mining from the conventional operational systems.  

These include:   

o Data is not organized for a specific process or application, but as per 
the managers desire to view it. So the data is subject oriented. oData 
from many sources where it is usually inconsistent is transferred to 
the data warehouse and integrated through a consistent naming 
convention.  

o Data should be collected and organized over time for identifying 
trends and forecasting. So the data must be time variant.  

o Data in the data warehouse is nonvolatile and neither updated nor 
changed, but only accessed and reloaded.  

2) Marketing Decision Support Applications  

The applications can be classified as follows:  

5.5 VALUE CHAIN IN E-COMMERCE 

A business model that outlines the entire process of creating new products 
or services is known as a value chain. The stages involved in moving a 
product from conceptualization to distribution, and just about everything 
in between, like obtaining raw materials, manufacturing operations, and 
marketing activities make up a value chain for an organisation. The 
purpose of a value chain is to increase the value of a product at each stage 
before it is supplied to customers. 

5.5.1 There are 5 aspects to primary activities 

● Inbound logistics: Receiving, storage, and inventory management are 
all part of inbound logistics. 

● Operations:  Procedures for transforming raw materials into a final 
product are included in operations.  

● Outbound logistics:  It refers to the activities involved in getting a 
finished product to a customer.  

● Marketing and Sales: Advertising, promotion, and pricing are all 
strategies used in marketing and sales to increase visibility and target 
the right customers.  

● Services: Customer service, servicing, restoration, refund, and 
exchange are examples of service programmers that keep products 
running smoothly and improve the customer experience. 

mu
no
tes
.in



  

 

Information Technology 
in Accountancy - I 

278 

5.5.2 Primary activity explained using Example 

1) Inbound Logistics 

Products supplied through Amazon's own fulfillment services, as well as 
data center resources that power Amazon Web Services (AWS), are the 
company's key inputs. Amazon can make use of its size as a major 
company to cut the cost per unit of items by outsourcing. 

2) Operations 

Amazon can go beyond in-house distribution capabilities thanks to co-
sourcing and outsourcing from various local companies. Robotics is used 
at Amazon's 109 fulfillmentcenters to provide quick and cost-effective 
warehousing labor.  

3) Outbound Logistics 

This is the point at which Amazon converts its inputs into outputs. 
Amazon's fundamental product, its ecommerce marketplace, provides a 
secure venue for both users and merchants to conduct e-commerce 
transactions. Their two-day delivery is a significant advantage over 
competitors. 

4) Marketing And Sales 

Amazon spent billions on advertising and marketing in the last decade or 
so, demonstrating the economic power of a large corporation to preserve 
its position among the most recognized brands in the world. Amazon is 
noted for its straightforward and easy return process, including its client 
satisfaction scores for AWS cloud services. 

5.6 INFRASTRUCTURE FOR ECOMMERCE - 
REQUIREMENTS 

1. Marketing. Of all the infrastructure elements, marketing may be the 
most important. To succeed, your website must be found. Once visitors are 
on your site, you need to keep them there and compel them to buy from 
you. That’s the job of your marketing team. Whether it’s website design, 
social media, search marketing, merchandising, email, or other forms of 
advertising, it’s all about marketing. 

2. Facilities. A key competitive advantage that ecommerce businesses 
have over brick-and-mortar stores is not having to invest in physical 
facilities. In many cases, you can run your business out of a home office, 
basement, or garage. If you drop ship or outsource fulfillment, you may be 
able to do that for a long period of time. Even with many employees, you 
can set up your offices in class B or C space, as you have no need for a 
fancy store in a high-traffic location. 

3. Customer service. There are many choices today for delivering high-
quality customer service. You can manage those activities in-house or 
outsource to a third party. Basic customer service for sales and post-sales 
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activities can be handled using email and, for more extensive needs, phone 
support. A customer-management system will make those activities easier, 
but for smaller companies, it is not a requirement. 

4. Information technology. Choosing an ecommerce platform is one of 
the most important decisions you will make in your business. Do you want 
to build and host your own system, outsource the development and then 
manage the system going forward, or use a hosted, software-as-a-service 
platform that is turn-key and externally managed? 

If you build and host your own system, you may need more cash upfront 
and skilled administrators and developers on your staff. By using a SaaS 
platform, you will not need to host or manage the system in-house, but 
you may still need web developers on staff. Choosing to outsource the 
development and hosting will reduce your staffing costs, but you will 
incur higher costs for any future enhancements or changes to your 
websites. 

5. Fulfillment. Another key decision is whether you will manage your 
own inventory or outsource those activities to a fulfillment house or 
through drop shipping arrangements with your suppliers. 

Managing your own inventory will provide a high level of control, but you 
will tie up cash in warehouse space and fulfillment staff. In some 
industries — such as the jewelry supply industry that my previous 
business was in — managing your own inventory was the most logical 
choice. We had no alternative for drop shipping, and most items were 
purchased in bulk and were very small. We did not trust preparation and 
fulfillment to an outside service. 

6. Finance and administration. You can manage your finance and 
administration activities in-house, outsource them, or use a hybrid of the 
two. If your ecommerce platform is tightly integrated into your accounting 
system, you may have very little need for an in-house bookkeeper. If you 
use separate systems for your website, order management, and accounting, 
you may need more help for data entry and making sure that the 
information is properly managed. 

7. Human Resources. Many small-business owners avoid the human 
resources function. Recruiting, setting up compensation, maintaining 
compliance, and other HR activities are specialized and time-consuming. 
You may choose to bring the resources in-house. But, should you 
outsource, there are many individuals and agencies well equipped to do 
the job. 

5.7 WEB BASED TOOLS FOR ECOMMERCE 

1. An e-commerce platform 

The first and most important tool for a successful e-commerce enterprise is 
the platform itself. Platforms such as Shopify and WooCommerce were 
designed specifically for e-commerce storefronts. These platforms come 
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preloaded with a slew of tools and services to help you manage your 
business. Each platform has its own themes and included services. 

2. Digital payment processing systems 

You can convert more business by making your products or services 
purchasable on your website. Thankfully, several third-party payment 
providers make online transactions trouble-free and easy to 
manage. PayPal and Stripe are two of the most popular solutions available 
today. Nearly all e-commerce platforms can integrate these payment 
solutions into their website infrastructure. 

3. Email marketing platforms and print marketing 

To let new and existing customers know about products, you can turn to 
email marketing. This is a great way to get the word out about your brand. 

Another effective way to spread the word about your brand is through 
direct mail. With direct mail, you can break through the constant digital 
noise and land in your target customers’ hands. 

4. Advanced analytics and tracking 

Once your e-commerce site is up and running, you need to track and 
analyze all pertinent sales information for your company. 

5. Shipping service integrations 

All online businesses need to have a solid understanding of how to handle 
their logistics efforts. 

6. Social media management solutions 

Every successful company needs to maintain its social media presence. 
That being said, keeping social media profiles updated regularly is 
extremely time-consuming, especially for smaller teams. With the 
integration of social media management solutions for your e-commerce 
storefront, you can keep customers engaged while automating the legwork 
required to do so. 

7. Customer relationship management software 

Regardless of all the tools and services you use to benefit your e-
commerce setup, nothing is more important than your customers’ 
satisfaction.  

5.8 ECOMMERCE SOFTWARE  

5.8.1 Types 

There are two general classifications of ecommerce software and they 
pertain to the type of deployment: 
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1. On-Premise. Installed on a local server or computer and managed 
on-site by a team that handles manual updates, fix problems, and do 
general troubleshooting. Online sellers early on initially went with 
on-premise solutions because they allowed greater hands-on 
management compared to hosted solutions. 

2. Software as a Service. SaaS or hosted solutions are technically the 
hands-off option since all updates, patches, and newly-released 
features are done automatically or with one-click integrations. Hosted 
ecommerce software has evolved dramatically to allow wide 
customization and flexibility, previously exclusive to on-premise, 
making it now a sufficient solution for most online retailers. 
Furthermore, SaaS software can be launched quickly and comes in 
affordable packages. 

5.8.2 What does ecommerce software do? 

1. Manage customers and orders. Managing a customer’s order from 
product selection to payment, to checkout and delivery is vital. 
eCommerce software takes care of managing orders, check order 
status, and making quick changes if needed. It can handle payment 
processing, keep transaction records, manage customer information, 
create billing and invoicing, undertake accurate accounting, provide 
analytics and reporting, among others. 

2. Manage products and inventory. You get product specifics and 
variations (size, color, quantity) to names and images, allowing you to 
organize and catalog items. You’re also notified and made aware if 
stocks are low and what particular items are fast-moving and need 
replenishing. 

3. Simplify marketing. Built-in SEO(Search Engine Optimization) 
allows online stores to rank higher in organic search engines for 
increased online discovery and presence as well as lower customer 
acquisition costs. 

4. Automates shipping and taxation. Printing shipping labels, 
calculating sales taxes based on customer location, and sending 
notification emails to customers can be done automatically and more 
accurately. 

5. Enhance customer experience. ecommerce software is meant to 
enable customers quickly and efficiently find what they need in your 
store. Hosted solutions offer service-level agreements to guarantee 
100% uptime and simple but robust website management, allowing 
you to provide your customers with the best online shopping 
experience. 

5.8.3 How does ecommerce software work? 

1. A shopper visits your website which displays products and categories 
that are loaded/stored in the website database. 
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2. The customer uses a shopping cart to add items and creates an account 
with all information saved in the database. 

3. Once the customer is in the checkout stage, the website normally goes 
into secure mode displaying a lock symbol and using an SSL 
certificate. 

4. While in checkout the website may utilize third-party software or 
services to provide the customer with delivery options, shipping rates, 
and expected delivery date. 

5. When the customer enters the credit card number, the information is 
sent to a payment processor or payment gateway such as PayPal. 

6. The customer order is now completed and all sensitive information is 
stored with the payment processor (not with the ecommerce website). 

7. You can have the payment deposited in your merchant account (a 
service usually provided by a payment gateway) or transferred to your 
bank account. 

5.9 SECURITY THREATS TO ECOMMERCE 

NOTE : Already discussed in Module / Unit 4. Refer to 4.8 

5.10 IMPLEMENTING SECURITY FOR ECOMMERCE  

NOTE : Already discussed in Module / Unit 4. Refer to 4.8 

5.11 ELECTRONIC PAYMENT SYSTEM 

NOTE : Already discussed in Module / Unit 4. Refer to 4.7 

5.12 STRATEGIES FOR MARKETING 

NOTE : Already discussed in Module / Unit 5. Refer to 5.4 

5.13 ELECTRONIC MARKET 

An electronic market is an inter-organizational information system they 
allow the participating buyers and sellers to exchange information about 
prices and product offerings. The firm operating the system is referred to 
as the intermediary, which may be a market participant- a buyer or seller, 
an independent third party, or a multi-firm consortium. 

Electronic markets are the foundation or of electronic commerce. They 
potentially integrate advertising, product ordering, delivery of products, 
and payment systems. Many electronic markets also offer additional 
services, such as payment or logistics services that help members 
complete a transaction. They may also support community activities like 
distributing industry news, sponsoring online discussions, and providing 
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research on customer demand or industry forecasts for components and 
raw materials. 

5.13.1 Functions of E-Markets:- 

E-markets serve three particular functions: 

1. They act as an exchange for business transactions-not only purchasing 
but also for checking price and stock availability, invoicing and order 
chasing. 

2. They manage catalog content, converting product information into a 
common format understood by all parties. 

3. They provide additional services to support the trading process such as 
shipping, payment, tendering and determining a company’s financial 
status. 

Other functions performed by the e-markets:- 

● E-markets provide an electronic or online method to facilitate 
transactions between buyers and sellers. They present ideal structures 
for commercial exchange, because of market efficiency attained by 
tightening and automating the relations between sellers and buyers of 
products and services. 

● Electronic markets bring together their member companies into trading 
communities united by common business interest, thus improving 
speed and efficiency. They offer both buyers and sellers forums to 
reduce transaction costs, to enhance sales, to streamline distribution 
processes, to deliver and consume value-added services, and to 
streamline customer management. 

● Electronic markets minimize the inefficiency by tightening the 
relationships between supplier and buyer, promoting price 
transparency, reducing supply chain costs, and increasing the reach of 
suppliers. 

● By bringing buyers and sellers together online, electronic markets play 
the role of digital intermediaries. For example, demand and supply 
information can be aggregated and disseminated, and buyers and 
sellers can be matched in electronic markets. 

● E-markets also provide the possibility of forwarding and reverse 
auctions. The forward auction brings together many buyers and on a 
seller. By this model, the price can only increase. It is most beneficial 
for companies that are looking to unload surplus inventory. The 
reverse auction model brings together many sellers and few buyers. 
The buyer drives the price, so in this model, prices are driven 
downwards. 

● E-markets provide an efficient and cost-effective means of conducting 
trade. They automate and streamline multiple steps in the buying 
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process and thus have evolved as new channels for corporate 
purchasing. For example, buyers can save a significant amount of time 
and money on simplified product searches through online catalogs. 
They can create online requests for proposals to solicit service 
providers and these providers can respond to potential buyers at a low 
cost. 

● E-markets provide open transaction networked when a large number of 
potential buyers and sellers are able to participate without the 
restrictions of time and space. Automated transactions save on 
communication and people cost and result in fewer ordering errors. 

● E-markets also assist order tracking, payments, and collections as well 
as easy reordering and product replenishment. 

5.14 BUSINESS PLAN FOR IMPLEMENTING 
ELECTRONIC COMMERCE 

1. Strategic business planning and roadmaps – Strategy is about 
making the right choices that will help reach the stated business 
objectives. 

There should to be a clear cut vision, mission and objective about what 
will be achieved, in how much time, within what budget, identification of 
the right resources for and constraints in the face of execution of the 
strategy mentioned in the business plan, and what elements will be 
considered for roadmap. 

Knowledge and deep understanding of the digital marketing tools and 
techniques that will help in reaching and acquiring customers is required. 
Your business must reach out to customers who are online across multiple 
dimensions and devices. 

2. Customer acquisition – Online or popular digital marketing 
encompasses multiple tools for reaching out to the new generation of 
customers, who are actively engaged in using multiple devices, through 
search engine optimization, search engine marketing (paid advertisement 
that includes both cost per click and cost per thousand impressions), social 
media marketing (that includes both cost per click and cost per thousand 
impressions), email campaigns, display advertisements using various ad 
networks, referral programs and re-targeting campaigns. 

3. Customer engagement – Customers these days are actively seeking to 
engage with brands to understand the core benefits and unique value 
proposition that the brand offers, discount and offers during special 
seasons, a robust support mechanism for queries/clarifications regarding 
the products displayed and interaction with customer support executives to 
know more about policies on returns and exchange, etc. 

4. Customer retention –With the advent of sophisticated e-commerce 
technologies, new age retailers will be able to leverage an almost one-to-
one customer experience and that’s the best a customer can really expect. 
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5. Optimization based on key metrics – Some of the key metrics to 
measure the health of an ecommerce venture are the total revenue 
generated, cost of customer acquisition, % of customers converted, and % 
of customers entering the website through various channels. 

5.15 EXERCISE QUESTIONS  

Multiple Choice Questions. 

1) In a __________ transaction, the interaction is between businesses.  

a) B2B  b) B2C  c) C2B  d) SEO 

2) _________ is a marketing function and has a strong impact on 
marketing strategies. 

a) CRM  b) e-commerce c) hardware  d) computer 

3) A business model that outlines the entire process of creating new 
products or services is known as a _____________ chain. 

a) value  b) block  c) net  d) tech 

4) __________________ is an inter-organizational information system 
that allows the participating buyers and sellers to exchange information 
about prices and product offerings. 

a) DDoS  b) CRM  c) electronic market  d) Bots 

5) ____________ refers to the activities involved in getting a finished 
product to a customer.  

a) Services b) Operations c) Outbound logistics d) Inbound logistics 

True or False. 

1) E-business is the process of conducting business on the Internet. 

2) In C2C, interaction is between consumer and business.  

3) Electronic commerce decreases the cost of creating, processing, 
distributing, storing, and retrieving paper-based information. 

4) E-markets provide an electronic or online method to facilitate 
transactions between buyers and sellers. 

5) The purpose of a value chain is to increase the quality of a product at 
each stage before it is supplied to customers. 

Define or short answer. 

1) E-commerce 

2) B2B e-commerce 
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3) Strategic business planning and roadmaps for e-commerce 

4) E-market 

5) E-commerce softwares 

Long answer. 

1) Discuss functions performed by e-markets.. 

2) What are web based tools for e-commerce? 

3) Explain levels of e-commerce. 

4) How can e-commerce softwares be used? 

5) What are requirements for e-commerce? 

5.16 REFERENCES : 

1) www.clickpost.ai 

2) www.practicalecommerce.com 

3) www.mimeo.com 

4) www.financesonline.com 

5) www.solutionweb.in 

6) www.embitel.com 

 



mu
no
tes
.in


